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Contact Information

Our Web site is a good source of information about products, sales, support, and the latest news. Visit the Web site at
www.renlearn.com (United States)
www.alphasmart.co.uk (United Kingdom)
www.alphasmart.com/international (all other countries)

If you can’t find the information you're looking for on the Web site, use this contact information:

United States

Renaissance Learning
PO Box 8036
Wisconsin Rapids, WI 54495-8036

Technical questions or problems:
Phone: (800) 338-4204

Email: support@renlearn.com

Web: www.renlearn.com/support

Purchase NEO products, general information, or sales questions:
Web: www.renlearn.com

Phone: (800) 338-4204

Email: answers@renlearn.com

United Kingdom

Technical questions or problems:
Phone: 0870 120 0718
Email: UK-help@alphasmart.com

Latest support information:
Web: www.alphasmart.co.uk/support

Purchase NEO products:
Web: www.alphasmart.co.uk/ordering

Europe, Middle East, and Africa

Technical questions or problems:
Phone: +44 870 120 0718
Email: UK-help@alphasmart.com

Latest support information:
Web: www.alphasmart.eu/support
Select your country or region.

Purchase NEO products:
Web: www.alphasmart.com/international
(This Web site also provides a list of resellers and contacts for NEO products.)
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Asia/Pacific, Canada, and Latin America

Technical questions or problems:
Contact your local reseller. If you do not have a local reseller, email Technical Support at support@renlearn.com.

Latest support information:
Web: www.alphasmart.com/international
Select your country or region.

Purchase NEO products:
Web: www.alphasmart.com/international
(This Web site also provides a list of resellers and contacts for NEO products.)
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ABOUT SMARTAPPLETS

About This Manual

This manual explains what SmartApplets are and how you can install them on
NEO 1 or NEO 2 laptops or remove them from your NEOs. It also explains
how to use the SmartApplets that are installed when you receive your NEO(s).

NEO 1 and NEO 2 in This Manual

This manual describes SmartApplets for both NEO 1 and NEO 2 models.
When it refers to NEO, the manual is referring to both models. When it refers
to NEO 1 or NEO 2, the manual is referring to that specific model.

What Are SmartApplets?

SmartApplets are programs that are installed on your NEOs. These programs
allow you to write on the NEO, practice keyboarding skills, do calculations,
change settings, administer quizzes to your students, or “beam” files from one
NEO to another. NEO 2 also has SmartApplets that allow students to
complete work for some Renaissance Place programs, AccelTest, and the
2Know! Toolbar.

D
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Which Sm

ABOUT SMARTAPPLETS
Which SmartApplets Are Installed?

artApplets Are Installed?

These SmartApplets are installed on your NEO when you receive it.
SmartApplets are listed in the order in which they appear on the NEO.

Where to Find More

SmartApplet What It Does Information
Responder Use this SmartApplet to use your NEO 2 as you would use a | See Chapter 2.
(NEO 2 only) Renaissance Responder. You can use it with the 2Know!

Toolbar, AccelTest software, and Accelerated Math RP. You

must have a Renaissance Receiver to use NEO 2 as you

would use a Responder.
AlphaWord Plus Use this SmartApplet to write on your NEO. This See Chapter 3.

SmartApplet opens automatically when you start the NEO

unless you have used AlphaSmart Manager to change the

startup SmartApplet.
Accelerated If you 1) have an active subscription to Accelerated Reader See Chapter 4.
Reader (NEO 2 RP, 2) have installed AlphaSmart Manager on teacher
only) computers, and 3) have connected a Renaissance Receiver to

teacher computers, students can use this SmartApplet on a

NEO 2 to complete Reading Practice Quizzes, Vocabulary

Practice Quizzes, and Other Reading Quizzes.
MathFacts in a If you 1) have an active subscription to MathFacts in a Flash | See Chapter 5.
Flash (NEO 2 RP 3.1 or higher, 2) have installed AlphaSmart Manager on
only; available teacher computers, and 3) have connected Renaissance
spring 2009) Receivers to teacher computers, students can use this

SmartApplet on NEO 2 laptops to complete MathFacts in a

Flash work.
KeyWords (US) or | Use this to learn keyboarding or to teach it to your students. | See Chapter 6 for
KAZ (UK) KeyWords. For KAZ, refer

to the manual available on
www.alphasmart.co.uk.

Control Panel

Use this to change settings for the NEO itself or for
individual SmartApplets.

See Chapter 7.

Beamer

Use this to use the infrared (IR) port to send (or beam) files
to another NEO or to receive files from another NEO. You

can disable this functionality if you wish on the AlphaSmart
Manager Settings tab or in the Beamer settings on the NEO.

See Chapter 8.

AlphaQuiz

Use this SmartApplet to administer quizzes to students on
the NEO. On your computer, you’ll need to download and
install QuizDesigner and QuizManager. QuizDesigner allows
you to create the quizzes, and QuizManager allows you to
send the quizzes to NEOs and retrieve student responses.

See Chapter 9.
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ABOUT SMARTAPPLETS
Installing SmartApplets

Where to Find More
SmartApplet What It Does Information
Calculator Use this to perform mathematical calculations. (It can be See Chapter 10.
disabled using the Control Panel settings.)

Installing SmartApplets

By following the steps below, you can install new SmartApplets, update
SmartApplets, or reinstall SmartApplets that you’ve removed. To do this, you
install a SmartApplet on your computer, then select it and send it to your
NEO(s) using AlphaSmart Manager. (If AlphaSmart Manager isn’t installed
on your computer yet, see the AlphaSmart Manager 2 User Manual for
instructions.)

1.

v1s_ If you don’t see the

P ). SmartApplet you
installed in the

SmartApplet List in

AlphaSmart Manager, click
the File menu, choose Add to
Applet List, and navigate to
the location of the .OS3KApp

file.

N
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If you have received a new SmartApplet, close AlphaSmart Manager if it
is already running.

If you have a single NEO, use the USB cable that came with your NEO to
connect it to your computer.

If you have a SmartOption Mobile Lab with several NEOs, connect the
NEOs to the appropriate cables in your cart. Connect your computer to
the cart.

If you have received a new SmartApplet, on your computer, use Windows
Explorer or Macintosh Finder to browse to the location where you
unzipped or unstuffed the SmartApplet files. Double-click the file that ends
with .OS3KApp (such as KeyWords.OS3KApp). AlphaSmart Manager
will start and display the SmartApplets tab.

If you want to install a SmartApplet that you already have, start
AlphaSmart Manager and click the SmartApplets tab.

If the SmartApplet that you want to install is not already in the Install List,
click it in the SmartApplet List (@) on the next page) and click Add => to

add it to the Install List @). (You can also drag the SmartApplets between
lists.) To select more than one SmartApplet to add, hold down the Ctrl or
3 key as you click the SmartApplets. To select a group, click the first item
in the group, hold down the Shift key, and click the last item in the group.

Make sure the Memory column @@ shows that there is enough space on
the NEO(s) to install this SmartApplet. Note: Since NEO 1 laptops don’t
have as much space as NEO 2 laptops, if you have both NEO 1 and NEO
2 laptops connected to a SmartOption Mobile lab, the Memory column
shows the space left on your NEO 1 laptops, not your NEO 2 laptops.
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Installing SmartApplets
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Name Wersion | A Name Wersion 38 % uged
Accelerated Reader 1.0 Keywords 34

Alphatiuiz 31 Accelerated Reader 1.0

Alphaword Plus 3.8
Beamer 1.0

Calculator ° a0z o 0
Control Panel a4

Kepwords 34
MathFacts ina Flash 381

Meo Font - Large (.. 1.0

Meo Fort - Mediu.. 1.0 b
< >

Remave I = Needed by Install List
M = Currently Used

[based aon fullest device]

AlphaSmart devices connected: 1 [ Direct USE |
bl

5. Click the Send List tab and make sure the SmartApplet that you're
installing is listed in the SmartApplets section of the list.

=% Untitled - AlphaSmart Manager 2
File Edit Setup Help
D=E & i
Get/Print Alphatord Files] Alphaiord Files to Send] Keywords | Smarthpplets | Settings  Send List ]

Send List Display

Current System Applet: Spstem 3.54 [Latest system)
AlphaSmart devices with a lower version of System Applet will be updated ta the Current System
Applet.

Feywords 3.4
Accelersted Reader 354

AlphaSmart devices connected: 1 [ Direct USB )
*

6. If you have a SmartOption Mobile Lab, and you don’t want to send the
SmartApplet to all NEOs, click Select Devices 0 check the NEOs that
you want to have the SmartApplet, and then click OK.

7. Click Send to send the SmartApplet to your NEO(s).

)
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Disabling SmartApplets on NEOs

You can disable SmartApplets so that they cannot be used on your NEO(s).
The SmartApplets are not deleted, but they are not available until you enable
them again. (To delete SmartApplets, see page 1-8.)

There are two ways to disable SmartApplets: you can change the settings in
AlphaSmart Manager, or you can disable SmartApplets on the NEO itself.
You'll find both procedures below.

Disabling SmartApplets on the NEO Itself

1.
2,

With the NEO on, press applets.

Use the arrow keys to move the cursor next to the SmartApplet that you
want to disable.

Press ctrl-88-L.

Enter the NEO’s master password. (This password is set in AlphaSmart
Manager in the System settings; for more information, see the
AlphaSmart Manager 2 User Manual.)

Disabling SmartApplets within AlphaSmart Manager

You need AlphaSmart Manager installed on your computer to follow these
steps.

1.

)
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If you have a single NEO, use the USB cable that came with your NEO to
connect it to your computer.

If you have a SmartOption Mobile Lab with several NEOs, make sure that
the NEOs are connected to the appropriate cables in your cart and that
your computer is connected to the cart.

Start AlphaSmart Manager on your computer.
Click the Settings tab.

In the list on the left (@] on the next page), click the SmartApplet that you
want to disable.



)
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Disabling SmartApplets on NEOs

Untitled - AlphaSmart Manager, 2
File Edit Setup Help
O=HE i
Get/Print Alphatword Files | Alphaword Files to Send | KeywWords | Smartdpplets  Settings l Send List

Mote: Only checked settings will be sent ta the AlphaSmarts.

Settings List
[ Alphaword Plus 3.81 -

Calculator 3.02 Seftings

(+ ‘es

o

[v¥  Disable this Smartipplet " Mo

1 Control Panel

] Keywords 3.4

1 MathFacts in a Flash 3.8

[ Ao Ao - i £ ange 27
[ A Fornt - £ anme /o dnad
[ A Ao - Mactiam (5 s
] A Fevst - Sl 6 daesi
(] A Feowat - biapr L aapa (73
[ Responder 1.1 »

Restore Defaults...

AlphaSmart devices connected:

+

1 [Direct USE )

6. Click the Send List tab and make sure your setting change is in the

list @.

Untitled - AlphaSmart Manager, 2
File Edit Setup Help
=y =]

Get/Print &lphaiwford Files] Alphaiwiord Files to Send | Keyw/ords | Smartdpplets | Settings  end List l

& i

Send List Dizplay

SmartApplets:

Calculator 3.0 Options: G
Dizable this Smartbpplet =‘Yes

End Send List =

| Send

AlphaSmart devices connected:

+

1 [Direct USE )

On the right, after the Disable this SmartApplet setting, click Yes @.
The box will be checked.
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If you have a SmartOption Mobile Lab, and you don’t want to disable the
SmartApplet on all NEOs, click Select Devices, check the NEOs on
which you want to disable the SmartApplet, and then click OK.

Click Send to send the setting change to your NEO(s).

Changing the Startup SmartApplet for NEOs

Changing the Startup

Changing the Startup

v1r_ If you don’t set a
P ). startup SmartApplet,
when you turn on your
NEQO, it goes to the
SmartApplets list, with the
cursor next to the SmartApplet
you were working in when you
turned the NEO off.

N
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Normally, AlphaWord Plus is the SmartApplet that starts when you turn on a
NEO. If you want to change the startup SmartApplet, you can do so either on
the NEO itself or using AlphaSmart Manager.

SmartApplet on Your NEO

1.
2,

Press applets on the NEO.

Use the arrow keys to move the cursor next to the SmartApplet that you
want to start when you turn on the NEO. (The current startup SmartApplet
is marked with an asterisk.)

Press ctrl-applets. Notice that the asterisk has moved next to the
SmartApplet you chose to show you that it is now the startup
SmartApplet.

SmartApplet for NEOs Using AlphaSmart Manager

1.

o e DN

Make sure your NEO or SmartOption Mobile Lab is connected to your
computer.

Start AlphaSmart Manager.
Click the Settings tab.
Click System in the settings on the left.

In the settings on the right, click the drop-down list next to Startup
SmartApplet and choose the SmartApplet that you want to start when the
NEO(s) are turned on. When you do this, the box for the setting will be
checked.

Click the Send List tab and verify that your system setting change
appears in the send list.

If you are using a SmartOption Mobile Lab and you want to send the
setting change to some, but not all, of the NEOs, click Select Devices,
check the numbers to which you want to send the change, then click OK.
(To send to all connected NEOs, skip this step.)

Click Send to send the setting change to your NEO(s).



ABOUT SMARTAPPLETS
Deleting SmartApplets from NEOs

Deleting SmartApplets from NEOs

By following these steps, you can delete SmartApplets from NEOs. This is
helpful if you want to free space on the NEO or if you don’t plan to ever use a
specific SmartApplet. However, if you're expecting to use the SmartApplet
again in the future, it may be better to disable the SmartApplet instead as
described on page 1-5 because reinstalling SmartApplets can take some time.

Important: If you remove some SmartApplets, such as AlphaQuiz or
KeyWords, you also remove any files associated with them. For example, if
you remove KeyWords, you also remove your students’ KeyWords work and
progress reports. If there is information on the NEOs that you want to save,
be sure to retrieve the data first.

You need AlphaSmart Manager installed on your computer to follow these
steps.

1. If you have a single NEO, use the USB cable that came with your NEO to
connect it to your computer.

If you have a SmartOption Mobile Lab with several NEOs make sure the
NEOs are connected to the appropriate cables in your cart, and make
sure your computer is connected to the cart.

Start AlphaSmart Manager on your computer.
Click the SmartApplets tab.

B ful not ¢ Click each SmartApplet you want to install or keep in the SmartApplets
G- d:,:;’ign_no ° List (@) on the next page), then click Add => to move it to the Install List
v SmartApplet items ©. You should add all SmartApplets that you want on your NEOs,

that you want to keep. The including those that are already installed on the NEOs.
SmartApplet list includes the
fonts included on your NEO,
spell check, the Thesaurus,

.

You can add the SmartApplets one at a time, or you can select multiple
SmartApplets by holding down the Ctrl key (Windows) or the 38 key

Text2Speech Updater for (Macintosh) as you click SmartApplets. You can select a group of
Text2Speech devices, and SmartApplets by holding down the Shift key and clicking the first and last
Wireless File Transfer (NEO 2 SmartApplet in the group.

only) for transferring files to . .
and from services such as 5. Check the box above the SmartApplet list @ to specify that all

Google Docs. SmartApplets that aren’t in the Install List should be deleted from NEOs.

)
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In the example below, AlphaQuiz would be deleted since it isn’t included
in the Install List.

ntitled - AlphaSmart Manager, 2
File Edit Setup Help
O=HE i
Get/Print Alphaword Files | Alphawiard Files to Send | Keywiards  Smartdpplets | Settings | Send List

Iv Delete Smarttypplets that are not in the Install List from AlphaSmart Devices

Smartdpplet List 6 Install List E Memory

Mame Yersion | A& Mame Yersior & 38 % uzed
Accelerated Reader 1.0 Accelerated Reader 1.0
Alphaluiz 31 Alphawiord Pluz 38
Alphatsford Pluz a8 Beamer 1.0
Beamer 1.01 | Calculator 302
Calculator 302 Contral Panel 38
Contral Panel 38 Kepwords 34
Keywards 34 MathFactz inaFlash 3.8
MathFacts in a Flash 3.81 oo Ffow-Laapafd.. 1.0
Meo Font - Large ... 1.0 A Foend - Madfiam £52.. 1.0
Meo Font - Mediu.. 1.0 bt Moo Foed - EmafiE.. 10 %
< IR | &

fdd => I = Neded by Instal List

B = Currently Uzed
[bazed on fullest device]

AlphaSmart devices connected: 1 [ Direct USE ]
+

6. Click the Send List tab and verify that only the SmartApplets you want to
keep on your NEOs are in the Send List.

ntitled - AlphaSmart Manager, 2
File Edit Setup Help
O=HE & i

Get/Print &lphaiwford Files] Alphaiwiord Files to Send | Keyw/ords | Smartdpplets | Settings  end List l

Send List Dizplay

Send To device:AlphaSmart USE

Current System Applet: System 3.54 [Latest system]
AlphaSmart devices with a lower version of Spstem Applet will be updated to the Current Spstem
Applet.

Delete Smartdpplets that are not in the Install List from AlphaSmart devices.

.&;celerated H;;der 354
Alohatwiord Plus 3.54 b

0 Select Devices... Send

AlphaSmart devices connected: 1 [ Direct USE ]
+

)
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7. If you have a SmartOption Mobile Lab, and you don’t want to delete the
SmartApplet on all NEOs, click Select Devices @), check the NEOs on
which you want to delete the SmartApplet, and then click OK.

8. Click Send to send the change to your NEO(s) and to delete the
SmartApplets that were not selected.

Viewing SmartApplet Information

You can view information about a SmartApplet on the NEO itself or in
AlphaSmart Manager.

Viewing SmartApplet Information on the NEO Itself

Follow these steps to get information about one of the SmartApplets on your
NEO:

1. Press applets on the NEO.

2. Use the arrow keys to move the cursor next to the SmartApplet that you
want information about.

3. Press option-applets to see the SmartApplet version and copyright.

Viewing SmartApplet Information in AlphaSmart Manager

Follow these steps to get more information about the SmartApplets that are
installed on your computer and that are available to install on NEOs.

1. In AlphaSmart Manager, click the SmartApplets tab.

2. In the SmartApplet List, double-click the SmartApplet for which you want
information, or click the SmartApplet, click the File menu, and choose Get
SmartApplet Info. The dialog box that appears will show you the name of
the SmartApplet, the version, the RAM and ROM size, and the copyright
date.

3. To close the dialog box, click OK (Windows) or Close (Macintosh).

)
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Settings for Your SmartApplets

Learning to Use

)
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Some SmartApplets, such as AlphaWord Plus and its spell check, KeyWords,
or Beamer, have their own settings.

+ For more information about the AlphaWord Plus settings, see page 6-4.
 For more about spell check settings, see page 6-3.
« For Beamer settings, see page 7-10.

« For KeyWords settings, see “Teacher Options” on page 5-11.

Your SmartApplets

The rest of this manual explains how to use each of the SmartApplets that
came installed on your NEO(s). You can use this manual to learn to use the
SmartApplets, or you can use it as a reference as you use the SmartApplets on
your NEO.



N
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RESPONDER

NEO 2 includes a Responder SmartApplet that lets you use your NEO 2
laptop like a classroom response system or “clicker.” Students can use NEO 2
to complete assignments for Accelerated Math RP and AccelTest software.
You can also use NEO 2 with the 2Know! Toolbar.

Important: You can’t use NEO 2 with more than one program at a time. If
you have both AccelTest and Accelerated Math RP, or if you have the 2Know!
Toolbar and one of these programs, you should only have one of the three
programs open at a time.

Preparing to Use NEO 2 with AccelTest, Accelerated
Math RP, or the 2Know! Toolbar

Using NEO 2 to

.ty NEO 2 does not
Z@: support the
homework and

notes features in AccelTest,
though you can use those
features with Renaissance
Responders. Also, NEO 2
laptops do not support
assigned owners.

N
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Make sure you have done the following before you use NEO 2 with any of
these programs:

« Connect the Renaissance Receiver to your computer and assign a unique
name to the Receiver as described in the NEO 2 Quick Guide.

« Ifyou want to use NEO 2 with Accelerated Reader and you have not already
installed AccelTest, the 2Know! Toolbar, or the Renaissance Responder
program, install AlphaSmart Manager on your computer using the
AlphaSmart Manager CD or the file you downloaded (for instructions, see
the AlphaSmart Manager 2 User Manual). This is necessary because
AlphaSmart Manager updates the Renaissance Wireless Server Utility,
which helps NEO 2 communicate with the Accelerated Reader RP software.

Complete AccelTest Assignments

If you ordered a SmartOption Mobile Lab, you received AccelTest software
with your NEO 2 laptops. When you choose “Responder” as the scoring
method for assignments in AccelTest, students can use their NEO 2 laptops to
complete assignments instead of using Responders. If you choose “NEO 2
Only” as the scoring method, students may only use NEO 2 laptops. Students
can use NEO 2 to complete in-class assignments, but not homework.

241
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Using NEO 2 in a Student-Paced Session in AccelTest

)
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Student-paced sessions allow students to work on anything that has been
assigned to them in the AccelTest class Gradebook except for Homework.
Students can complete these assignments without needing the teacher to lead
the session or send the questions one by one. The instructions below explain
what teachers and students need to do in order to use NEO 2 during a
student-paced session.

Teacher Preparation Steps

1.

Make sure your Renaissance Receiver is connected to your computer
and that the computer is on.

Click the AccelTest Responder menu and choose Start Student-Paced
Session.

Make sure students have their student ID from the AccelTest Gradebook.
(IDs are also available in the AccelTest Student ID Report.) Since NEO 2
laptops don’t have assigned owners, the student ID is always used to
identify the student for assignments.

Steps Students Follow during a Student-Paced Session

1.

2
3.
4

Press onl/off to turn NEO 2 on.
Press applets.
Make sure the cursor is next to Responder; then, press enter.

NEO 2 will attempt to join the session. If you have connected to a
Renaissance Receiver before, it will ask if you want to stay connected to
it; press Y for yes or N for no. Then, press enter.

If you haven’t connected to a Renaissance Receiver before, NEO 2 will
show you a list of networks (Renaissance Receivers). Use the arrow keys
to highlight the one you want to connect to; then, press enter.

Type your AccelTest student ID and press enter.

If you have only one assignment available, the program will ask if you are
ready to work on the assignment. Press Y for yes to continue; then, press
enter.

If you have more than one assignment, the program will ask which one
you want to work on. It will list the assignments you have with a letter
before each assignment name. Press the letter for the assignment you
want; then, press enter.



-

v1r_ You may see
P J. “Sending” when you
enter the answer to
each question.
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NEO 2 will show you the first question in the assignment. Choose or type

an answer for each question; then, press enter:

* For multiple-choice questions, press the letter next to the answer you

want to choose.

e For true-false questions, press T for true or F for false.

* For yes/no questions, press Y for yes or N for no.

e For questions that ask you to enter a number, type the number and

press enter.

* For short-answer questions, type the answer and press enter.

Note: If the assignment is printed, it may include some questions that you
can’t answer on NEO 2, such as essay questions; answer these

questions on paper.

You can answer the questions in order or use these commands to go
back or to go to a specific question:

To do this...

Scroll through a question.

..press these keys:
Press T and V.

Go forward or back one
question.

Press 38-?. Arrows (¢) will appear to the
right of the question number. As long as you
see those arrows, you can press 7' to go back
one question or |, to go forward one question.
Press 8-? again when you want the arrow
keys to scroll through the question instead.

Go to a specific question
number.

Press find, type the question number, and
press enter.

Go to the end of the Press 8-V
question.
Go to the beginning of the  Press 3- T.

question.

Switch between the
question and answers in
multiple-choice questions
on NEO 2.

On NEO 2, if both the question and the answer
choices require scrolling, you can press the
tab key or the €= or = key to switch between
the question and the answer. Then, use the 1
and |, keys to scroll up or down.

8. When you've answered all the questions, the program will ask if you are

ready to submit your work. If you are, press Y for yes and press enter.

When the assignment is complete, your score may be shown; if so, press
any key when you're ready to leave that screen. The NEO 2 will go back
to the SmartApplets list. If you want to work on another assignment, press



Using NEO 2 in a Teac

_str_ For some types of

P J. teacher-paced
sessions, you’ll see

the question on the NEO 2

screen. For others, you will

only see your answer choices

(not the possible answers).

)
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enter to choose the Responder SmartApplet again and repeat these
steps.

If you are not ready, press N for no and press enter. You will go back to
question one, and you can go through each question again to check your
answers.

her-Paced Session in AccelTest

In AccelTest, teachers use teacher-paced sessions when they want to ask
questions of the entire class and have the class answer the questions at the
same time. The instructions below explain how to use NEO 2 during a
teacher-paced session.

Teacher Preparation Steps

1. Make sure your Renaissance Receiver is connected to your computer
and that the computer is on.

2. Click the AccelTest Responder menu and choose Start Teacher-Paced
Session.

The steps that you follow next depend on the options you choose in the
Responder Session Wizard. For detailed instructions for setting up the
session and asking the questions during the session, refer to the user manual
that was installed with your AccelTest software.

Steps Students Follow during a Teacher-Paced Session
1. Press on/off to turn NEO 2 on.
2. Press applets.

3. Once the teacher has started the session, make sure the cursor is next to
Responder; then, press enter.

4. NEO 2 will attempt to join the session. If you have connected to a
Renaissance Receiver before, it will ask if you want to stay connected to
it; press Y for yes or N for no. Then, press enter.

If you haven’t connected to a Renaissance Receiver before, NEO 2 will
show you a list of networks (Renaissance Receivers). Use the arrow keys
to highlight the one you want to connect to; then, press enter.

Type your AccelTest student ID and press enter.

When the teacher tells you to do so, press enter. Then, choose an
answer for the first question:

* For multiple-choice questions, press the letter next to the answer you
want to choose and press enter.

2-4
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e For true-false questions, press T for true or F for false and press
enter.

e Foryes/no questions, press Y for yes or N for no and press enter.

* For questions that ask you to enter a number, type the number and
press enter.

* For short-answer questions, type the answer and press enter.
After you press enter, a message will tell you that your answer has been
recorded. Repeat this step for each question in the session.

7. When the teacher ends the session, the teacher will ask you to press
enter again. A message will tell you that there is no session. Leave N (no)
selected and press enter again to finish.

Using NEO 2 to Complete Accelerated Math Assignments

If you are using Accelerated Math RP version 3.1 or higher, your students can
use NEO 2 to complete assisted-response (multiple-choice) assignments, but
not for free-response assignments or extended-response assignments. For
each class, the teacher uses the Accelerated Math RP Scoring preference to
determine whether students can use Responders (and therefore NEO 2) with
exercises or tests.

Before you can use NEO 2 with Accelerated Math RP, you must have a
Renaissance Receiver connected to your computer (see the NEO 2 Quick
Guide), and you must have the Renaissance Responder client program
installed (see the Accelerated Math RP Software Manual).

Teacher Preparation Steps
1. Make sure your students have printed copies of their assignments.

2. Start the Renaissance Responder program and log in with your
Accelerated Math RP user name and password. (To install the program
and connect it to your Renaissance Place server, see the Accelerated
Math RP Software Manual.)

Steps Students Follow to Complete Accelerated Math
Assignments

1. Press on/off to turn NEO 2 on.

2. Press applets.

3. Make sure the cursor is next to Responder; then, press enter.

)
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4. NEO 2 will attempt to join the session. If you have connected to a
Renaissance Receiver before, it will ask if you want to stay connected to
it; press Y for yes or N for no. Then, press enter.

If you haven’t connected to a Renaissance Receiver before, NEO 2 will
show you a list of networks (Renaissance Receivers). Use the arrow keys
to highlight the one you want to connect to; then, press enter.

5. Enter the form number printed at the top of the assignment. Then, press
enter.

6. If the NEO 2 tells you to wait until your assignment is retrieved, press
enter again.

7. When the NEO 2 shows your name and form number, press Y for yes if
this information is correct; then, press enter. (If not, press N for no and
enter the form number again.)

8. Press the letter keys (A, B, C, or D) to enter your answer to each
question. Then, press enter.

You can answer the questions in order or use these commands to go
back or to go to a specific question:

To do this... ...press these keys:

Scroll through a question.  Press Tand V.

Go forward or back one Press -?. Arrows (¢) will appear to the

question. right of the question number. As long as you
see those arrows, you can press T to go back
one question or | to go forward one question.
Press 38-? again when you want the arrow
keys to scroll through the question instead.

Go to a specific question Press find, type the question number, and

number. press enter.
Go to the end of the Press 38-1.
question.

Go to the beginning of the = Press 8- T
question.

-

v1s_ If some students

A haven't submitted 9. When you've answered the last problem, NEO 2 asks if you're ready to

their work before submit your work. If you are, press Y for yes and press enter. (If you're
you end the session, you'll not ready, press N for no and press enter to go back and go through the
be asked whether these problems again.)

scores should be recorded as

is or saved fora laterdate. For 10+ 1F NEO 2 asks you to wait while your assignment is saved, press enter

details, see the Accelerated again. When the assignment is done, you’ll be asked to get your TOPS
Math RP Software Manual. report at the printer. The NEO 2 will go back to the SmartApplets list.
D
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11. When all students have finished their assignments, the teacher can click
End Session in the Renaissance Responder program and close the
program.

Using NEO 2 with the 2Know! Toolbar

If you have your Renaissance Receiver connected and you’ve installed
AlphaSmart Manager, you can also use NEO 2 with the 2Know! Toolbar.
Participants can use NEO 2 to respond to questions. Teachers or session
leaders can use it to control the toolbar program as they would use a teacher
Responder. For more information about using the 2Know! Toolbar, click the
Options button in the program and choose Getting Started.

How Participants Respond to 2Know! Toolbar Questions Using NEO 2

Participants follow these steps to respond to questions from the 2Know!

Toolbar:

1. Press on/off to turn NEO 2 on.

2. Press applets.

3. Make sure the cursor is next to Responder; then, press enter.

4. NEO 2 will attempt to join the session. If you have connected to a

s To help students
Z@: answer multiple-
choice, true/false, or

pulse questions, you can
press ctrl-caps lock or cmd-
caps lock on NEO 2 to put
the Responder SmartApplet
in “bubble mode.” In this
mode, when students type
A-E, T FY,N R, orG
answer bubbles appear
(similar to the ones on
Responders) to help students
see the available choices. The
SmartApplet goes back to the
standard text mode when you
press ctrl-caps lock or cmd-
caps lock again, exit the
SmartApplet, or shut off the
NEO 2.

N

Sma IAPPLET' User Manual

Renaissance Receiver before, it will ask if you want to stay connected to
it; press Y for yes or N for no. Then, press enter.

If you haven’t connected to a Renaissance Receiver before, NEO 2 will
show you a list of networks (Renaissance Receivers). Use the arrow keys
to highlight the one you want to connect to; then, press enter.

Enter your response to each question:

e For multiple-choice questions, type the letter for the answer you want
to choose and press enter.

¢ For true/false questions, type T for true or F for false and press enter.

* For questions that require a number for an answer, type the number
and press enter.

e For “pulse” questions, you can enter Y, T, or G for yes/true/green, and
you can enter N, F, or R for no/false/red; then, press enter.

e For short-answer questions, type the answer and press enter.

The teacher will let you know when you can send your answer to each
question.
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6. When you’ve finished answering questions, the teacher can shut down
the 2Know! Toolbar program. The next time you press enter, NEO 2 will
tell you there is no session and ask if you want to search for networks.
Press N for no and press enter to go back to the SmartApplets menu.

How Teachers Can Use NEO 2 to Control the 2Know! Toolbar Program

Teachers can use NEO 2 to control the 2Know! Toolbar program. The steps
are similar to those you would use on a Responder:

1. In the 2Know! Toolbar program,
click the Options button and OV -.rioro oot
choose Teacher Responder
from the menu.

Themes ...

Getting Started ...

About Zknow! Toolbar ...

2. Click Assign in the Teacher
Responder dialog box. The
program will show you a PIN.
Leave this dialog box open.

Press on/off on the NEO 2 to turn it on.
Press applets.
Make sure the cursor is next to Responder; then, press enter.

U

NEO 2 will attempt to join the session. If you have connected to a
Renaissance Receiver before, it will ask if you want to stay connected to
it; press Y for yes or N for no. Then, press enter.

If you haven’t connected to a Renaissance Receiver before, NEO 2 will
show you a list of networks (Renaissance Receivers). Use the arrow keys
to highlight the one you want to connect to; then, press enter.

7. When NEO 2 asks you to enter the Teacher Responder PIN, enter the
one that is shown in your 2Know! Toolbar program. Then, press enter.

In the 2Know! Toolbar program, click Close to go back to the toolbar.
NEO 2 will list your options. Press A to ask a question, B to show a graph,
or C to minimize the Toolbar on your computer or maximize it again; then,
press enter.

Once you choose to view a graph, you can press A to stop receiving

responses, B to close the graph, C to reset so that participants can
answer again, or D to mark or enter the correct answer; then, press enter.

)
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RESPONDER
Using NEO 2 with the 2Know! Toolbar

10. When you've finished, you can unassign the NEO 2 so it is no longer
meant for use by the teacher. Follow these steps:

)
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a.

In the 2Know! Toolbar program, click Options and choose Teacher
Responder.

Click Unassign in the Teacher Responder dialog box.

c. Click Close.
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ALPHAWORD PLUS
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When you start your NEO, AlphaWord Plus opens automatically (unless
you’ve changed settings to have another SmartApplet open).

AlphaWord Plus is the program that lets you write in NEO. Simply press one
of the file keys (file 1, file 2, etc.) to choose the file to write in and start typing.
Characters are saved in that file as you type them; there’s no need to worry
about losing text if you accidentally shut off the NEO. The arrow keys,
backspace, and delete all work as they do on a typical computer keyboard.

To copy, cut, and paste text, you can use the same keyboard commands that
you use in word processing programs on your computer. To copy text, select it
and press ctrl-C or $8-C. To cut text, select it and press ctrl-X or #-X. To
paste it, press ctrl-V or $8-V. (For a list of helpful keyboard commands, see
the label on the back of your NEO.)

If you want to delete the text from one of the files, press clear file. Then,
press Y for “yes” when the NEO ask if you’re sure you want to clear the file.

If you want to name and save a file so you can use the file space for other text,
press ctrl-S. Then, type a name for the file and press enter. You can then
clear the file space without losing the file you saved.

You'll find detailed instructions for using AlphaWord Plus in the NEO 1 and
NEO 2 User Manual that you received. The user manual also explains how to
send files to or retrieve them from supported programs such as Google Docs;
you must have a Renaissance Receiver and a supported program to do this.

For those with special needs, Text2Speech devices are available to read your
AlphaWord Plus documents aloud as you write. If you have purchased a
Text2Speech device, refer to the Text2Speech User Manual for instructions.

3-1
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ACCELERATED READER SMARTAPPLET

NEO 2 includes an Accelerated Reader SmartApplet that students can use to
take Accelerated Reader RP Reading Practice Quizzes, Vocabulary Practice
Quizzes, and Other Reading Quizzes right on the NEO 2. The Renaissance
Receiver at the teacher’s computer enables NEO 2 quiz data to be sent to
Accelerated Reader RP.

Preparing to Use NEO 2 with Accelerated Reader RP

Before students can use NEO 2 to take quizzes, you must do the following;:

)
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Have Accelerated Reader RP version 7.5 or higher installed and registered
on your Renaissance Place server.

Install AlphaSmart Manager version 3.0 or higher on the teacher’s
computer. This will also install or update the Renaissance Wireless Server
Utility, which enables NEO 2 and the Renaissance Receiver to
communicate with Accelerated Reader RP. For instructions, see the NEO 2
Quick Guide or the AlphaSmart Manager 2 User Manual.

Make sure the Accelerated Reader SmartApplet is installed on your NEO 2
laptop(s). If it isn’t, you can install it using AlphaSmart Manager. (See
page 1-3.)

Connect a Renaissance Receiver to the teacher’s computer as described in
the NEO 2 Quick Guide.

In the Renaissance Wireless Server Utility, name your Renaissance
Receiver and make sure students know the Receiver name. See page 4-2.

Also in the utility, enter the address of your Renaissance Place server in the
Renaissance Place Settings. (See page 4-2.)

4-1



ACCELERATED READER SMARTAPPLET
Setting the Receiver (Network) Name and Renaissance Place Address in the Renaissance Wireless Server Utility

Setting the Receiver (Network) Name and Renaissance
Place Address in the Renaissance Wireless Server
Utility

Setting the Receiver (network) name helps students identify the Receiver they
want to connect to. Entering the Renaissance Place address provides the
utility with the server address where Accelerated Reader RP is installed. This
enables the utility to send the Accelerated Reader quiz results from NEO 2 to
Accelerated Reader RP.

Follow these steps to change the Receiver name and to enter the Renaissance
Place address in the settings:

1. Start the Renaissance Wireless Server Utility:

*  Windows computers: Right-click in the lower-right corner of your
computer screen (in the system tray) and choose Manage from the
menu that appears. You can also click Start » Programs »
Renaissance Wireless » Server Renaissance Wireless Server
Utility.

e Macintosh computers: In your computer’s Applications folder, open
the Renaissance Wireless Server folder. Then, double-click
Renaissance Wireless Server Utility.

2. Type 1234 and click OK to log in. (This is the default Administrator PIN. If
you have changed the PIN, enter your new PIN.) If necessary, click Start.

Ej Server Login

Please login with the Administrator PIN,

Cancel

)
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ACCELERATED READER SMARTAPPLET
Setting the Receiver (Network) Name and Renaissance Place Address in the Renaissance Wireless Server Utility

3. Click the Server Settings tab @).

%3 Renaissance Wireless Server Litility
File Edit Tools Help

Server is running. Click Stop to shutdown the Renaissance Wireless Server, Q

evice Settings | Receivers | Wireless Devices

Metwark Mame: | TP Receiver e

Users will use this name to locate and connect ko this
server using their wireless devices.

Encryption: (&) GfF Oon
Enabling encryption requires that each device share the

key you enter in the above area. Keys are limited to
digits 0-9 and characters A-E.

I Update Metwork Settings I 0

[ Set Administrator PIN ] Renaissance Place Settings ] o
The Administrator PIN is required to authorize Renaissance Place connection information is
use of secure Features such as device required for wireless device access to a
firmwiare updates and resetting a user's PIN, Renaissance Place server.

4. If necessary, change the network name (Receiver name) ). Choose a
name that is easy for your students to recognize so that they connect to
the correct Receiver when they take quizzes. After changing the name,
click Update Network Settings @. When the program verifies that the
settings have been updated, click OK.

Click Renaissance Place Settings @).

Enter the Web address or IP address for the Renaissance Place server
that has Accelerated Reader RP installed @.

%2 Renaissance Place Server Settings

Enter your Renaissance Place server address:

111111111

Example: httos.fmyserver. com or 192, 168.1.208

Click bo werify the address connection

Cancel

7. Click Verify @ to make sure that the utility recognizes the address you
entered as valid. If it does, you will see “Connection Verified” at the
bottom of the window. If the utility isn’t able to verify the address, check
the format of the examples to see if you need to make any changes.

)
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ACCELERATED READER SMARTAPPLET
How Students Take Quizzes in the Accelerated Reader SmartApplet on NEO 2

8. Click OK to save the address and close the window. (The OK button is
not available until you have verified the address; see the previous step.)

9. When the program verifies that the settings have been changed, click OK.

How Students Take Quizzes in the Accelerated Reader
SmartApplet on NEO 2

Things to Check Before Students Start Quizzing on NEO 2

« Make sure you've set the Receiver name and Renaissance Place address in
the Renaissance Wireless Server Utility (see page 4-2).

iz The same « In Accelerated Reader RP, set the School and Classroom Student Quizzing
3@: preferences apply to preferences and the Other Reading Series preference for your class. (See

students no matter the Accelerated Reader RP Software Manual for instructions.)
where they take quizzes—

on NEO 2 or at a computer— + Students need to know this information before they start taking quizzes on
so you only need to set the NEO 2 laptops:
preferences once.

« The name you gave the Renaissance Receiver on the Server Settings
tab. Students will need to choose a Renaissance Receiver when they
take quizzes.

» Their Renaissance Place user names and passwords. You can get this
information from the Accelerated Reader RP Student Information
Report.

+ The quiz number. On NEO 2, students may only search for quizzes by
quiz number. If students will be using NEO 2 laptops to take quizzes
on a regular basis, consider including quiz numbers on your
Accelerated Reader book labels.

Steps for Taking a Quiz on NEO 2

1. The teacher’s computer must be on, with the Receiver connected. (You
can use the teacher’s computer for other things while students are
quizzing; the computer does not need to be dedicated to quizzing.)

Turn the NEO 2 on and press applets.

Press V¥ until the cursor is next to Accelerated Reader. Then, press
enter.

)
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ACCELERATED READER SMARTAPPLET
How Students Take Quizzes in the Accelerated Reader SmartApplet on NEO 2

4. The first time you use the Accelerated Reader SmartApplet, it will list the
Networks that are available. (Networks are Renaissance Receivers

sLs_ The name that you

AB): gave the connected to computers.) Use the up and down arrow keys to highlight
Renaissance the Receiver you want to connect to; then, press enter.

Receiver is the one students

will see in the Networks list. %

See page 4-2 to find out how

Lang Arts Receiner
to change the name.

If you have chosen a Receiver before, the program may ask if you want to
stay connected. Press Y for yes or N for no; then, press enter. (If you
choose no, you'll need to select another Receiver.)

5. When the program asks for your user name and password, type your user
name and press enter or { or tab. Then, type your password and press

enter.
Uzer Mame [] 1 Accelerated
Pazsword [ 1 Reader

6. If you have an unfinished quiz, the screen will ask if you want to finish it.
Press Y for yes or N for no. If you choose yes, go to step 13. If you
choose no, the teacher or quiz monitor must enter the monitor password.

7. Ifyou are in more than one Accelerated Reader class, your classes will be
listed. Use the up and down arrow keys to highlight the class that you are
taking this quiz for; then, press enter.

Michael Deleza

Longuage Arts, English Literature LATOEY,
First Quarter

Stephenzon  Languoge Arts, Title One English LATSST,
First Quarter

D
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ACCELERATED READER SMARTAPPLET
How Students Take Quizzes in the Accelerated Reader SmartApplet on NEO 2

8. On the next screen, use the up and down arrow keys to highlight the type
of quiz you want to take (Reading Practice, Vocabulary Practice, or Other
Reading). Then, press enter.

Michael Deleza

Reading Practice
I‘-"l:ll:l:ll:ll.lh:ll"l:l Practice
Other Reading

9. For Reading Practice and Other Reading Quizzes, the Find RP Quiz
screen will appear next. Type the quiz number and press enter. (If you
chose to take an Other Reading Quiz, and none are available for your
class, the screen will notify you. Press enter.)

Find RF Quiz Michael Deleza

Quiz Humber: |

For Vocabulary Practice Quizzes, you will be asked how you want to find
the quiz: by quiz number, by matching another quiz already taken, or by
taking a ~Second-Try and Review Words~ Quiz. Highlight an answer and
press enter. If you chose to find the quiz by quiz number, type the number
and press enter. If you chose to match a quiz already taken, highlight the
quiz name and press enter; if there was only one matching vocabulary
quiz, you won't be asked to select one.

Find “F Quiz Michael Deleza

El guiz number
Match another quiz already taken
Take a ~Second-Try and Reuicw Words- Quiz

10. If the quiz is available in both English and Spanish, the screen will list
both. Use the arrow keys to select the English quiz and press enter.
(Spanish quizzes aren’t yet supported on the NEO 2.)

D
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ACCELERATED READER SMARTAPPLET
How Students Take Quizzes in the Accelerated Reader SmartApplet on NEO 2

11. If the screen asks you how the book was read, use the arrow keys to
select an answer; then, press enter.

How The ook Was Read Michaoel Oelezo
Read With

Read Independently

12. The quiz title will be shown.

sts_ You cannot If the monitor password is not required, press Y for yes to confirm that you
3@: substitute the NEO 2 want to take the quiz; then, press enter.
master password for

Start RE Quiz Michael Delezo

the monitor password. You
must use the monitor
password set in Accelerated
Reader RP.

The Berenstain Bears and the Escaope of the Bogg Brothers

by Stan Eerenstain # QUiz Humber 12751 EH
Read Independently

Take this quiz? (XD

If the screen asks for the monitor password, the teacher or quiz monitor
must enter the Accelerated Reader monitor password and press enter.

Start RP Uiz Michael Delazo
The Eerenstain Eears and - The monitor password

the Escape of the Bogg preference is turned on.
Erothers

by Stan Eerenstain
iz Hnmber 1759 F
Monitor password to allow: |

Note: If you are not allowed to take the quiz, the screen will notify you.
Depending on the restriction, it may ask if you want to take a different quiz
or tell you to press applets to log out. There are many reasons why you
may not be allowed to take the quiz:

* There are date or time restrictions.

* You aren't allowed to take quizzes.

¢ No students are allowed to take this specific quiz.

* You have taken the quiz before.

¢ You have chosen a ~Second-Try and Review Words~ Quiz, but you
don’t have review words.

s To stop a quiz, press

f@; ctrl-A or cmd-A. 13. NEO 2 will show you one question in the quiz. To answer each question,
Then, ask the quiz press the letter for the answer you want to choose; then, press enter to
monitor or teacher to enter the go to the next question.

Accelerated Reader monitor

password and press enter. If you need to scroll to see all of the answers @), use the up and down

arrow keys. If the question is long and you need to scroll to see all of the

D
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ACCELERATED READER SMARTAPPLET
How Students Take Quizzes in the Accelerated Reader SmartApplet on NEO 2

question, you can use the up and down arrow keys to scroll in the
question; then, press tab or = to switch to the answers so you can use
the arrow keys to scroll there.

0Of Mice and Men Michael Deleza
GE‘DI"QE‘ tl'll:ll.lgl'lt he A.the other warkers could see how
and Lennie would gE't E-tl"l:ll'lg Lennie was o
the job if ---. E.he could think of a good lie 1o
E'H|:I|l:|i|'| their prezence at the
_ronch
1af z0 [CR BT

14. After you enter your answer to the last question, you may be asked how
you liked the book. Press the letter for the answer you want to choose;
then, press enter.

Eaok Yating Michael Deleza

How did you like this book?

A. One of the uery best books I haue euet read
E. A uery good book

C. An Ok bk

CROCEDNEDD Tour answer will not affect Yyour score,

15. If the screen asks for the monitor password, ask the teacher or quiz
monitor to enter the password and press enter.

Ready To Yiew Resudit= Michael Deleza

The Eerenstain Bears and the Escape of the Eogg Erothers
by Stan Eerenstain
ATOS Book Leuel: 2.9 ¢ Lower Grades

Monitor pazsword to continue: |

16. The RP Score Summary will show you how you did on the quiz. It may
also show you information about the points you've earned.

If the summary asks if you want to see the questions you missed, press Y
for yes or N for no and press enter. If you choose yes, you can see each
missed question, your answer, and the correct answer. Press enter after
you read each one.

RF Score Summary Michiel Deleza

9 0f 10 correct [90%)
54 of 6.0 points earned
Tou passed the quiz.

View mizzed question? (YD

If the summary does not ask if you want to view the missed questions,
press enter to continue.

D
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ACCELERATED READER SMARTAPPLET
How Students Take Quizzes in the Accelerated Reader SmartApplet on NEO 2

17. A TOPS Report may be sent to the default printer for the teacher’s
computer. If the program asks what language you’d like to print the report
in, use the arrow keys to highlight a language. Press enter.

18. After you finish a Reading Practice Quiz, the program may ask if you want
to take the matching Vocabulary Practice Quiz. Press Y for yes if you
want to take that quiz, or N for no if you don’t want to take it right now.
Then, press enter.

Quiz Completed Michael Deleza

Take the matching Yocabulary Practice Quiz? (XD

19. The program will ask if you want to take a different quiz. Press Y for yes if
you want to take another quiz, or N for no if you don’t want to take another
one right now. Then, press enter. If you choose no, you will go back to the
list of SmartApplets available on the NEO 2.

Quiz Completed Michael Deleza

Take a different quiz? (XD

D
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MATHFACTS IN A FLASH SMARTAPPLET

NEO 2 includes a MathFacts in a Flash SmartApplet that students can use to
practice or take tests right on the NEO 2. The Renaissance Receiver at the
teacher’s computer enables the student’s NEO 2 work to be sent to MathFacts
in a Flash RP.

Preparing to Use NEO 2 with MathFacts in a Flash RP

Before students can use the MathFacts in a Flash SmartApplet on NEO 2, you
must do the following:

)
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Have MathFacts in a Flash RP version 3.1 or higher installed and registered
on your Renaissance Place server.

Install AlphaSmart Manager version 3.3 or higher on the teacher’s
computer. This will also install or update the Renaissance Wireless Server
Utility, which enables NEO 2 and the Renaissance Receiver to
communicate with MathFacts in a Flash RP. For instructions, see the NEO
2 Quick Guide or the AlphaSmart Manager 2 User Manual.

Make sure the MathFacts in a Flash SmartApplet is installed on your NEO
2 laptop(s). If it isn’t, you can install it using AlphaSmart Manager. (See
page 1-3.)

Connect a Renaissance Receiver to the teacher’s computer as described in
the NEO 2 Quick Guide.

In the Renaissance Wireless Server Utility, name your Renaissance
Receiver and make sure students know the Receiver name. See page 5-2.

Also in the utility, enter the address of your Renaissance Place server in the
Renaissance Place Settings. (See page 5-2.)

In Renaissance Place, make sure your students have been added to the
database and enrolled in a MathFacts in a Flash class.

In MathFacts in a Flash RP, set the Classroom preferences. (For
instructions, see the MathFacts in a Flash RP Software Manual.)
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MATHFACTS IN A FLASH SMARTAPPLET
Setting the Receiver (Network) Name and Renaissance Place Address in the Renaissance Wireless Server Utility

Setting the Receiver (Network) Name and Renaissance
Place Address in the Renaissance Wireless Server
Utility

Setting the Receiver (network) name helps students identify the Receiver they
want to connect to. Entering the Renaissance Place address provides the
utility with the server address where MathFacts in a Flash RP is installed.
This enables the utility to send information about students’ work from NEO 2
to MathFacts in a Flash RP.

Follow these steps to change the Receiver name and to enter the Renaissance
Place address in the settings:

1. Start the Renaissance Wireless Server Utility:

*  Windows computers: Right-click in the lower-right corner of your
computer screen (in the system tray) and choose Manage from the
menu that appears. You can also click Start » Programs »
Renaissance Wireless » Server Renaissance Wireless Server
Utility.

e Macintosh computers: In your computer’s Applications folder, open
the Renaissance Wireless Server folder. Then, double-click
Renaissance Wireless Server Utility.

2. Type 1234 and click OK to log in. (This is the default Administrator PIN. If
you have changed the PIN, enter your new PIN.) If necessary, click Start.

Ej Server Login

Please login with the Administrator PIN,

Cancel

)
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MATHFACTS IN A FLASH SMARTAPPLET
Setting the Receiver (Network) Name and Renaissance Place Address in the Renaissance Wireless Server Utility

3. Click the Server Settings tab @).

%3 Renaissance Wireless Server Litility
File Edit Tools Help

Server is running. Click Stop to shutdown the Renaissance Wireless Server, Q

evice Settings | Receivers | Wireless Devices

Metwark Mame: | TP Receiver e

Users will use this name to locate and connect ko this
server using their wireless devices.

Encryption: (&) GfF Oon
Enabling encryption requires that each device share the

key you enter in the above area. Keys are limited to
digits 0-9 and characters A-E.

I Update Metwork Settings I 0

[ Set Administrator PIN ] Renaissance Place Settings ] o
The Administrator PIN is required to authorize Renaissance Place connection information is
use of secure Features such as device required for wireless device access to a
firmwiare updates and resetting a user's PIN, Renaissance Place server.

4. If necessary, change the network name (Receiver name) ). Choose a
name that is easy for your students to recognize so that they connect to
the correct Receiver when they take quizzes. After changing the name,
click Update Network Settings @. When the program verifies that the
settings have been updated, click OK.

Click Renaissance Place Settings @).

Enter the Web address or IP address for the Renaissance Place server
that has MathFacts in a Flash RP installed @.

%2 Renaissance Place Server Settings

Enter your Renaissance Place server address:

111111111

Example: httos.fmyserver. com or 192, 168.1.208

Click bo werify the address connection

Cancel

7. Click Verify @ to make sure that the utility recognizes the address you
entered as valid. If it does, you will see “Connection Verified” at the
bottom of the window. If the utility isn’t able to verify the address, check
the format of the examples to see if you need to make any changes.
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MATHFACTS IN A FLASH SMARTAPPLET
How Students Do MathFacts in a Flash Work on NEO 2

8. Click OK to save the address and close the window. (The OK button is not
available until you have verified the address; see the previous step.)

9. When the program verifies that the settings have been changed, click OK.

How Students Do MathFacts in a Flash Work on NEO 2

Things to Check Before Students Start Using the MathFacts in a Flash
SmartApplet on NEO 2

« Make sure you've set the Receiver name and Renaissance Place address in
the Renaissance Wireless Server Utility (see page 5-2).

« Make sure students know the name you gave the Renaissance Receiver on
the Server Settings tab. Students will need to choose a Renaissance
Receiver when they work in the MathFacts in a Flash SmartApplet.

« Make sure students know their Renaissance Place user names and
passwords. You can get this information from the MathFacts in a Flash RP
Student Information Report.

« If you have younger students, explain how the questions and answers are
displayed on the screen and how to select or enter answers.

How Students Use NEO 2 with MathFacts in a Flash

1. The teacher’s computer must be on, with the Receiver connected.
(Teachers can use the computer for other things while students are
working in MathFacts in a Flash; the computer doesn’t need to be
dedicated to this task.)

Turn the NEO 2 on by pressing on/off; then, press applets.
Press ¥ until the cursor is next to MathFacts in a Flash. Then, press

enter.
1, The name that you 4. The first time you use the MathFacts in a Flash SmartApplet, it will list the
AP): gave the Networks that are available. (Networks are Renaissance Receivers
Renaissance connected to computers.) Use the up and down arrow keys to highlight

Receiver is the one

students will see in the the Receiver you want to connect to; then, press enter.

Networks list. See page 5-2 If you have chosen a Receiver before, the program may ask if you want to
to find out how to change the stay connected. Press Y for yes or N for no; then, press enter. (If you
name.

choose no, you’ll need to select another Receiver.)

)
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MATHFACTS IN A FLASH SMARTAPPLET
How Students Do MathFacts in a Flash Work on NEO 2

5. When the program asks for your user name and password, type your user
name and press enter or A (You can also press the tab key or one of the
other arrow keys to move between the two fields.) Then, type your
password and press enter.

User Mame [| 1 MathFacts
Faszword [ 1 in a Flash

6. If you are in more than one MathFacts in a Flash class, your classes will
be listed. Use the up and down arrow keys to highlight the class that you
are taking this quiz for; then, press enter.

7. What you see next depends on several things:

* whether you have worked in MathFacts in a Flash for this class before
* whether you can practice or test

* the teacher’s settings for the Mandatory Practice preference and the
Time Goals preferences

The screen may ask you whether to start a test or practice; if so, press Y
for yes or N for no; then, press enter.

If the screen does not give you any choices, press enter to continue.
8. During a practice or test, you’ll see questions like the one shown below.

9 of Ho o Michael Delazo

E&-6= 4 10 Z2
= () =)

The way you answer the question depends on what you see on the
screen:

* If you see arrows below the answers, press €, ~L, or = and press
enter. The circles below the answer choices will show you what keys
to press to choose each answer.

* If you see letters or numbers below the answers, press the letter or

number for the answer and press enter. The circles below the answer
choices will show you what keys to press to choose each answer.

D
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MATHFACTS IN A FLASH SMARTAPPLET
How Students Do MathFacts in a Flash Work on NEO 2

* If you don’t see any answer choices, type your answer and press
enter.

Tips for Practices and Tests:

« During practices, if you enter an incorrect answer, the program will put
an X over it and a box around the correct answer. Then, it will give you
the chance to choose the correct answer again.

« During tests, you can press esc or back space to go back one question.

If the time limit is almost up for the problem, practice, or test, a clock
will flash in the middle of the black bar at the top of the screen. If you
run out of time for the practice or test, the program will let you know.

To stop a practice or test, press ctrl-A or cmd-A. If the NEO 2 asks for a
monitor password, your teacher must enter the MathFacts in a Flash
monitor password.

s1s_ The MathFacts in a 9. After you finish the practice or test, the screen will show you how you did.

Z@: Flash TOPS Report A TOPS Report may also be sent to the default printer for your teacher’s
Preference setting computer. Follow the instructions for the screen you see:

determines whether the report

is sent to the printer * If the screen asks you whether to move on to the next level, start a

automatically. practice, or test at a new time goal, press Y for yes or N for no; then,

press enter.

* If the screen shows your score but does not give you any choices,
press enter after you read the information. After you do this, you may
be shown a list of options. If the screen gives you a list of choices,
press dto highlight the choice you want; then, press enter.

10. When the screen shows you that the session has been completed, press
applets to close the MathFacts in a Flash SmartApplet.

)
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KEYWORDS

Welcome to KeyWords

The KeyWords SmartApplet develops basic keyboarding skills using fun and
interesting lessons. Keyboarding is an essential skill for success, and good
keyboarding skills allow you to write much more quickly than you could if you
had to spend time hunting for each key.

KeyWords keeps learners interested as it teaches typing, employing a
language-based system that entertains as it trains. It provides cumulative
lessons that teach accuracy and speed a few keys at a time, and it offers
encouragement with positive feedback and helpful hints. KeyWords also
checks progress at each level with typing tests. You can then view progress
reports on the NEO or by using the KeyWords program in Renaissance Place.

The KeyWords design is based on research about how people learn to type:

+ Speed and typing fluency increase more readily if simple words are used
and repeated. The KeyWords method follows this model of repetition,
presenting diverse vocabulary, rhymes, and humor to keep lessons
interesting.

« Typists learn patterns of keystrokes more quickly when they aren’t
interrupted by immediate corrections. The KeyWords error-checking
method emphasizes the importance of words and phrases.

+ Speed skills and accuracy are best developed independently. KeyWords
provides separate lessons for these skills. You can set proficiency goals and
view reports as learners test themselves.

+ Speed increases with practice typing words and phrases instead of random
letters. By practicing with words and phrases, new typists learn common
letter patterns that are the building blocks for simple and complex words.
This promotes the ability to quickly recognize and type letter combinations
that occur frequently.

)
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How the KeyWords SmartApplet Works

Teachers add students, or learners add themselves as students.
sts_ Ifyou plan to use the

P 2. KeyWords RP
reports (within

Renaissance Place), you'll

need to perform some

additional setup. See

page 6-36.

The student selects a group of keys to learn.

The student works through the activity for learning the new keys.
The student uses the accuracy and speed builder activities.

The student takes an accuracy and speed test.

AN

The student or teacher checks student progress using reports on the
NEO, or the teacher synchronizes the KeyWords data with Renaissance
Place and views reports in the KeyWords RP program.

Starting the KeyWords SmartApplet

- KeyWords comes installed on each NEO. To start KeyWords, follow these
s If KeyWords is not

Z@: installed on your steps:

) _NEO, see page 1-3 to 1. After starting the NEO, press applets.
install it.

Select a SmartApplet and press enter:
T AlphaWord Plus 3.1

- KeyWords 3.4

! Control Panel 1.01

2. Use the arrow keys to move the cursor next to KeyWords; then, press
enter. You'll see this KeyWords startup screen:

Select your name or choose to add name:
- Teacher options
- Add a student

D
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Adding a Student

s These steps

P " describe how to add
a student to the

KeyWords SmartApplet. If

you want to use KeyWords RP

for reports, you’ll need to add

students in Renaissance

Place as well; see page 6-36.

ALe_ If you make a
ARJ: mistake, press
' backspace to erase
and correct the error. If the
error is on a different line, use
the arrow keys to go to the

error so you can correct it.

N
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If you are a teacher using KeyWords in the classroom, you can follow the
steps below to add a student. If you are the student or the person learning
keyboarding skills, you can follow these steps to add yourself as a student.

Important: To avoid confusion in reports, add each student to just one
NEO. The student can only use KeyWords on a NEO where he or she has been
added, and limiting the student to work on a single NEO will help you
accurately monitor the student’s progress through KeyWords lessons.

1. After starting KeyWords, press the ~L key to move the cursor next to Add
a student; then, press enter.

Select your name or choose to add name:
- Teacher options
- Add a student

2. Enter the student’s first name, press enter, and enter the student’s last
name. Then, press enter.

Enter your first and last name:
First Name:
Last Name:

Press enter after typing the names.

3. Enter a password for the student (2—6 characters), press enter, and type

the password again. Then, press enter.

4. NEO will show you that the student is being added; then, it will return to

the KeyWords start screen, which will now include the new student’s
name.

Select your name or choose to add name:
- Teacher options
- Add a student

J Luis Camacho

5. If you want to add more students, repeat the steps above. All students

that you add will be listed alphabetically by last name.
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Choosing Your Name and Starting Lessons

x'ts_ The arrows on the
Z@: screen show you that
there are more options
above or below the ones
you’re viewing.

)
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After students have been added, they can begin working through the lessons.
The first lesson is an introductory overview to teach students how to sit
properly and where to place their hands on the keyboard. The other lessons
help students learn new keys, build speed and accuracy, and test their
proficiency.

Students can follow these steps to start work in the KeyWords SmartApplet.

1. After starting KeyWords, use the arrow keys to move the cursor down
next to your name in the list. Then, press enter.

Select your name or choose to add name:
- Teacher options
- Add a student

J Luis Camacho

2. Type your password and press enter. (The password was assigned when
you were added as a student.)

3. To start the first lesson, move the cursor next to Start Here! and press
enter.

Select Lesson or Option:
- Student reports

- Start Here!

! A SKLKeys

4. Follow the instructions on the NEO screen to learn about the space bar
and enter key, how to sit properly, and where to put your hands on the
keyboard.

Note: This lesson will refer you to the keyboard picture. You or your
teacher can find this picture in the KeyWords Extras folder on the
AlphaSmart Manager 2 CD, in the SmartApplets folder on the NEO 1 and
NEO 2 Documentation CD, or in the KeyWords RP resources. For more
about the resources available to KeyWords teachers, see page 6-48.
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5. After you complete this lesson, you will return to the lesson list. Notice
that there is an asterisk (*) next to the lesson you’ve completed. The * will
appear next to each lesson as you complete it. The + will appear next to
each lesson that you have started, but not finished.

Select Lesson or Option:
T*Start Here!
-ASKLKeys

! DJF Keys

6. Now, move the cursor next to another lesson you want to complete (such
as A S KL Keys) and press enter. In each of the other lessons, you can
choose one of three options:

* Learn new keys helps you learn to type the keys. For more
information about this, see the next section.

* Use accuracy and speed builders helps you improve your accuracy
and increase your speed while typing these keys. For more
information, see page 6-6.

* Take accuracy and speed test lets you test your proficiency using
these keys. For more information, see page 6-8.

As you complete each task, you can choose another option within this

lesson, or you can select another lesson. To go back to a previous screen

(such as the lesson list or the list of names), press esc until you get to that

screen.

Learning New Keys

When you choose the Learn new keys option within a lesson, KeyWords
asks you to type the keys you’re learning and to type combinations of the keys
in different sequences.

If you type the wrong key, KeyWords will make corrections, but if you
continue to type the wrong keys, KeyWords will give you a hint and show you
the keyboard layout with the key highlighted to help you find it. You must
press the correct key to go on.

You can find visual aids that help you learn keyboarding on the AlphaSmart
Manager 2 CD, on the NEO 1 and NEO 2 Documentation CD, or in the
KeyWords RP resources. See page 6-48.

)
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Building Accuracy and Speed

sty You can’t skip
P " forward or backward
during a lesson. You
must perform the activities as
they are presented. However,
you can stop a lesson by
pressing esc.

Accuracy

N

When you choose Use accuracy and speed builders in a lesson,
KeyWords helps train you to press keys correctly, which improves your
accuracy and helps you build up speed. For each lesson, there are six practice
passages in the accuracy and speed builders. The following example shows
the practice passages for the ASKL keys. (On the NEO, you would typically
only see three of these passages listed at one time.)

Select a passage:

- ALL ASK

- AS ALL ASK

- A LASS ASKS

- AS A LASS ASKS
- ASKS A LASS

- ALAS ALL ASK

To choose the passage you want to work on, move the cursor next to it and
press enter.

During the accuracy portion of this activity, KeyWords will ask you to type
each of the words and then give you the words in different sequences. The
accuracy builder helps you practice your newly learned keystrokes with whole
words and phrases. It emphasizes precision, not momentum. KeyWords
presents passages of small words or letter patterns to type.

Type carefully:
tree frog free frog
tree fr

When you complete all the lines in the passage, KeyWords displays the
number of errors you made. Errors are the number of words you typed
incorrectly; even if you make more than one mistake typing a word, it counts
as only one error. Typing extra spaces between words also counts as one
€error.
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KEYWORDS
Building Accuracy and Speed

KeyWords compares your accuracy (number of errors) to the passing criteria
(see page 6-14). If you don’t meet the passing criteria, a message will tell you
to type more carefully so you make fewer mistakes, and you will not go to the
speed builder. Instead, you will go back to the screen where you can select

passages.

You had 20 errors. You will need 12 or fewer
to continue. Please type more carefully so you

make fewer mistakes.

(Press [SPACE BAR] to continue.)

If you meet the passing criteria, you will see a message like the one below, and

when you press the space bar, you will go on to the speed builder.

Nice job! You only made 1 error.

You are now ready for Speed Builder.

(Press [SPACE BAR] to continue.)

After you pass the accuracy activity, KeyWords gives you a speed builder

activity. You cannot go straight to the speed builder activity; it always starts
automatically after you pass the accuracy activity. Even if you've completed
the accuracy activity before, you must go through it again before you can work

on the speed builder.

KeyWords shows you your goal before the activity, and afterwards, it shows
you whether you met the goal. (To set goals, see page 6-14.) Goals are based
on the number of words you type per minute. Type the text on the screen and
press the space bar when asked to do so. As you type, the progress bar will

show you the rate at which you should be typing words to meet your goal.

When you finish the activity, a message will show you whether you met your

goal. If you met your goal, you will see a message like this:

Way to go! Your typing rate was 20
words per minute. Your goal rate was

8 words per minute. You passed!

(Press [SPACE BAR] to continue.)
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If not, you will see a message like the one below. After you press the space bar,
you will see a message asking if you want to try the speed builder again. Press

Y for yes or N for no.

Your typing rate was 5 words per
minute. You need to type 8 words per

minute or more.

(Press [SPACE BAR] to continue.)

Taking an Accuracy and Speed Test

)
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The third option in each lesson, Take accuracy and speed test, lets you
test your progress. Each lesson has four different tests that you can take. You

can retake a test anytime. Your record shows only your best results.

When you choose this option, the NEO shows the goals you need to meet for

accuracy and speed in order to pass the test.

Your goal for the Speed and Accuracy
Test is 12 Words Per Minute with

12 errors or fewer.

(Press [SPACE BAR] to continue.)

As in the accuracy builder, the number of errors is counted as the number of

incorrectly typed words. Even if you make more than one mistake while

typing a word, it counts as only one error. Typing extra spaces between words

also counts as an error.

The top two lines on the screen show you the text to type and when to press
enter. After you've typed the text, the screen shows your accuracy and speed
scores, your goal, and whether you passed for accuracy and for speed. Note

that you may pass either accuracy or speed without passing the other

element. When you press the space bar after viewing the score, you’ll return

to the lesson screen.

Your score Your goal Passed
40 WPM 8 WPM Yes

7 Errors 10 Errors Yes

(Press [SPACE BAR] to continue.)
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How Students Check Progress Using Reports

uts_ Teachers can also
Z@: create a Group
Progress Report.
See page 6-12. Reports are
also available in KeyWords
RP in Renaissance Place, see
page 6-39.

N
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You can check your progress any time to see how well you’re doing on your
KeyWords lessons.

The Student Progress Report includes all the lessons you’ve worked on. It
shows the keys you did each lesson for, your goals for words per minute
(WPM) and accuracy, and your actual scores. It also shows whether you have
passed the accuracy and speed test, and it lists the accuracy and speed
builders that you have done.

The Last Lesson Report shows the keys the lesson was for, your goal for words
per minute (WPM), your actual words per minute, your goal for errors, your
actual number of errors, and whether you passed the accuracy and speed test.

When you select a report, you can

« choose to print it

« send it directly to the computer that has the Receiver attached, or
« send it to an AlphaWord Plus file.

If you choose to send it to an AlphaWord Plus file, the report may wrap across
several lines, making it difficult to read, but you can then transfer the file to a
computer or printer and see the report with its proper formatting if you use a
monospace font like Courier. Sending reports to AlphaWord Plus is also
useful because if you are using several NEOs with AlphaSmart Manager, you
can use that program to retrieve the files from multiple NEOs at the same
time, and you can then view, save, or print the reports.

Follow these steps to create a report:
1. In KeyWords, select your name from the student list and press enter.

Type your password and press enter.

On the Select Lesson or Option screen, press T to move the cursor up
next to Student reports, which is at the top of the list. Then, press enter.

Select Lesson or Option:
- Student reports

-*Start Here

L*A SK L Keys




xts_ If file passwords are
Z@: enabled for
AlphaWord Plus (see

page 5-4), you must enter the
password for the file you've
chosen before the KeyWords
report can be saved there.
You can substitute the master
password for the file
password.

)
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KEYWORDS
How Students Check Progress Using Reports

. You can choose a Student Progress report or a Last Lesson Report. Move

the cursor next to the report you want; then, press enter.

Student reports
- Create Student Progress report

- Create Last Lesson report

Select one of the options and press enter:

Print: Choose this option if you want to send the report directly to the
printer. Then, press print. (NEO must be connected to a printer with a
USB cable or be able to send the file to a printer via infrared beaming,
or, for NEO 2 only, using radio frequency technology.)

Send directly to computer: Choose this option if you want to send
the report to a file on your computer. Make sure AlphaSmart Manager
is not running on the computer. Then, connect your NEO to the
computer via USB cable as directed by the NEO. At the computer,
open any program that accepts text (such as a word processing or
spreadsheet program). Press send on the NEO. Disconnect the cable
when the file has been sent. (If characters get jumbled in the
computer file, you may need to change the transfer speed by pressing
option-3-S.)

Transfer to AlphaWord file: Choose this option if you want to send
the report to an AlphaWord Plus file in one of the eight file spaces on
the NEO. Then, type the number of the file you want to send the report
to. If the NEO warns you that the text that’s already in the file will be
deleted, press Y for yes if you want to continue. The file that you sent
the report to may open.

Create Student Progress report
- Print

- Send directly to computer

- Transfer to AlphaWord file
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xts_ Youcanalso change
P 2. these settings in

AlphaSmart
Manager. Click the Settings
tab, then click KeyWords on
the left to see the settings you
can change.

KEYWORDS
Teacher Options

The Teacher Options in KeyWords allow you to do the following:

+ Delete one or more KeyWords students

« Control whether home row confirmation is required

« Control whether KeyWord reinforces use of the correct shift key

+ Set whether one space or two spaces are required between sentences
+ View student progress using various reports

The master password is required when you set teacher options.

You can use AlphaSmart Manager to set the master password for your NEOs.
For instructions, see the AlphaSmart Manager 2 User Manual. You can find
the manual in the Start menu (Windows) or the program folder (Macintosh).

Follow these steps to change teacher options:

1. In KeyWords, use the arrow keys to move the cursor next to Teacher
options and press enter.

2. Type the master password and press enter. The teacher options will be
listed.

Select a Teacher Option:
- Delete a student
- Delete all students

1 Create group progress report

Deleting Students

s You can also delete
Z@: all KeyWords
students using

AlphaSmart Manager. To do
this, click Settings, click
KeyWords on the left, and
choose Yes for the Delete all
students option. Then, send
the change to your NEOs. You
cannot remove individual
students in AlphaSmart
Manager.

N
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Within the teacher options, you can choose to delete one or more KeyWords
students. (This does not delete students from KeyWords RP.)

Important: After you delete a KeyWords student, there is no way to recover
that student’s work. Make sure you want to permanently delete the student’s
work before following the steps below.

Follow these steps:

1. In KeyWords, move the cursor next to Teacher options and press enter.
2. Type the master password and press enter.

6-11
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Creating a Group Progress Report

3. In the list of teacher options, do one of the following:

¢ If you want to delete just one student, move the cursor next to Delete
a student and press enter. Then, move the cursor next to the
student’s name, and press enter.

¢ If you want to delete all KeyWords students, move the cursor next to
Delete all students and press enter.

Select a Teacher Option:
- Delete a student
- Delete all students

1 Create group progress report

4. A message will warn you that the data for the student(s) is about to be
erased. If you're sure you want to continue, press Y for yes. If not, press N
for no.

Creating a Group Progress Report

s Students can also
Z@: view Progress

Reports and Last
Lesson Reports. See
page 6-9. Reports are also
available in KeyWords in
Renaissance Place; see
page 6-39.

N
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One of the teacher options is the ability to create a group progress report. This
report provides information on each student’s last lesson, including the
student’s goals and actual performance for speed and accuracy and whether
the student passed the accuracy and speed test. The report includes only
those students who have used KeyWords on this NEO.

Follow these steps to create the report:

1. In KeyWords, move the cursor next to Teacher options and press enter.
Type the master password and press enter.

Move the cursor down next to Create group progress report and press
enter.

4. Select one of the options and press enter. (The options are described
below.)

Print

Choose this option if you want to print the report directly. Then, press print.
(NEO must be connected to a printer with a cable or be able to send the file to
a printer using infrared beaming. NEO 2 laptops can also print using radio
frequency technology.)
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Z@: enabled for
' AlphaWord Plus (see

page 5-4), you must enter the
password for the file you've
chosen before the KeyWords
report can be saved there.
You can substitute the master
password for the file
password.

KEYWORDS
Creating a Group Progress Report

Send Directly to Computer

Choose this option if you want to send the report to a file on your computer.

a. Make sure AlphaSmart Manager is not running on the computer.
b. Connect your NEO to the computer.

c. Atthe computer, open any program that accepts text (such as a word
processing or spreadsheet program). Open a new file or the file that
you want to accept text into. Make sure the cursor is in the file so it is
the active window. (For best formatting results, use a monospace font
like Courier for the report text.)

d. Press send on the NEO.

Disconnect the cable when the file has been sent.

Transfer to AlphaWord File

Usually, you would not need to send reports to an AlphaWord Plus file since
you can open them directly on your computer in AlphaSmart Manager.
However, you can choose this option if you want to send the report to an
AlphaWord Plus file in one of the eight file spaces on the NEO. On the NEO,
the report may wrap across several lines, making it difficult to read, but if you
later transfer the file to a computer or printer and you use a monospace font
like Courier, you can see the report with its proper formatting.

Follow these steps to send the report to AlphaWord Plus:

a. Type the number of the file you want to send the report to.

b. If the NEO warns you that the text that's already in the file will be
deleted, press y for yes if you want to continue. The file will open in
AlphaWord Plus.

You will see a report like the one below, showing information for each
student’s latest KeyWords lesson:

KeyWords Group Progress Report

Student Name Latest Goal Actual Goal Actual Passed
Lesson WPM WPM Errors Errors

Luis Camacho ASKL 8 77 12 2 Yes

Benjamin Donne ASKL 8 48 12 19 No

Keisha Fuller ASKL 8 5 12 24 No

)
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Setting Speed and Accuracy Goals for KeyWords

Students

In the Teacher Options, you can also set new speed (words per minute or
WPM) and accuracy (error) goals for students who use KeyWords on this
NEO. As your students’ typing improves, you may want to set a higher goal
for words per minute and a lower goal for errors. Only teachers can set goals;
students can’t set their own goals.

When you set goals, you are setting them for all lessons and all students who
use this NEO. You can’t set different goals for different students who are
using the same NEO. The goals apply to all accuracy and speed builders and
to tests.

Setting Goals Manually Changes How KeyWords Works

If you set goals using the teacher options, those goals will stay the same for all
lessons and students until you change them.

If you do not set goals using the teacher options, KeyWords starts with easy
goals for all students and gradually makes the goals more difficult as students
progress through lessons. The following table shows how the goals progress
as a student works through lessons.

Accuracy/Error Goal Words per Minute (WPM)
Lesson (Maximum) Goal (Minimum)

ASKL Keys 12 8
DJF Keys 12 10
TH Keys 12 12
GO Keys 10 14
EI Keys 10 16
PR Keys 10 16
QU Keys 8 16
WY Keys 8 18
Z? Keys 8 16
X. Keys 8 18
C, Keys 8 20
MV Keys 8 22

)
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Accuracy/Error Goal Words per Minute (WPM)
Lesson (Maximum) Goal (Minimum)
NB Keys 8 22
" Keys 8 14
Number Keys 6 14

If you have set goals in the teacher options and you want to go back to the
default automatic goals that are shown in the table, see the instructions on
page 6-16 to reset goals to the default.

How to Set Goals Manually in the Teacher Options

11 You can also set

- KeyWords goals in

' AlphaSmart
Manager. With the NEO(s)
connected, click the Settings
tab in AlphaSmart Manager
and click Keywords on the
left. Then, check and change
the WPM and error goals and
send the changes to your
NEOs.

N

Follow these steps to set new goals that are the same for all students and

lesson activities:

1. In KeyWords, move the cursor next to Teacher options and press enter.

2. Type the master password and press enter.

3. Move the cursor down next to Set custom WPM and error goals and
press enter.

4. To make the words per minute (WPM) goal higher, press the T key. To
decrease it, press the d key.

Use the arrow keys to change the

words per minute:8

(Press [SPACE BAR] to continue.)

5. Press the space bar.

6. To increase the number of allowable errors, press the T key. To decrease
it, press the 4 key.

Use the arrow keys to change the

Allowable errors:12

(Press [SPACE BAR] to continue.)

7. Press the space bar to go back to the teacher options.
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Resetting Goals to the Default

srr_ You can also reset
ABJ: KeyWords goals in

' AlphaSmart
Manager. With the NEO(s)
connected, click the Settings
tab in AlphaSmart Manager
and click Keywords on the
left. Choose Yes after Reset
WPM/error goals to default.
Then, send the change to your
NEOs.

Follow these steps to change back to the default goals, which change as
students progress through the lessons. (See the table that starts on

page 6-14.)

1. In KeyWords, move the cursor next to Teacher options and press enter.
2. Type the master password and press enter.

3. Move the cursor down next to Reset WPM and error goals to default
and press enter.

4. A message will tell you that the goals have been reset. Press the space
bar to go back to the teacher options.

Choosing Whether to Enforce Use of the Correct

Shift Key

xts_ Youcanalso change

\@X: this setting in
AlphaSmart

Manager. With the NEO(s)
connected, click the Settings
tab in AlphaSmart Manager,
click KeyWords on the left,
and choose Yes or No after
Turn Require correct shift
key OFF or ON. Then, send
the change to your NEOs.

N
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For faster and more accurate touch-typing, students should learn to type a
capital letter by holding down the shift key with the opposite hand from the
one that is typing the letter. For example, to type “A,” you should hold down
the shift key using the little finger of the right hand while typing a with the
little finger of the left hand.

If you choose to enforce this practice, in the teacher options, Correct Shift Key
Enforcement should be “On” (as it is when you first receive the NEO). If it is
on, when students are learning new keys in lessons that require them to type
capital letters, NEO will show a message like the one below if they use the
incorrect shift key.

To type a capital A, press the right
shift key.
(Hold down the right [shift] key and

press A now.)

Follow these steps to turn this option on or off:

1. In KeyWords, move the cursor next to Teacher options and press enter.
2. Type the master password and press enter.

6-16



KEYWORDS
Enforcing Use of the Home Row

3. Move the cursor down next to Turn require correct shift key ON (or
OFF) and press enter.

4. The next screen will show you whether correct shift key enforcement is on
or off; then, it will ask if you want to turn it on (if it's off) or off (if it's on). If
you want to change the setting, press Y for yes.

Enforcing Use of the Home Row

Because returning your fingers to the home row is such an important concept
in touch-typing, you can choose to have KeyWords request that students
press the home row keys (A S D F J KL ;) in sequence during lessons.

s Youcanalso change
P Tllshs?tm?'t In When this option is turned on, students see the message below at the
lphaSma . . ..
Manager. With the NEO(s) beginning of each accuracy and spe‘ed builder activity an‘d each test. They
connected, click the Settings must then type the home row keys in order from left to right before they can
tab in AlphaSmart Manager, exit the screen and go on to the lesson. If they type the keys incorrectly,
click KeyWords on the left, KeyWords backspaces to where they made the error, and it won’t let them

and choose Yes or No after continue until they press the correct letters in the correct order.
Turn Home Row

Confirmation ON or OFF.
Then, send the change to your
NEOs. Type each Home Row key one at a time

Place your fingers on the Home Row now.

from left to right.

This option is off by default. To turn it on or off again, follow these steps:

1. In KeyWords, move the cursor next to Teacher options and press enter.
Type the master password and press enter.

Move the cursor down next to Turn Home Row Confirmation ON (or
OFF) and press enter.

4. The next screen will show you whether home row confirmation is on or off;
then, it will ask if you want to turn it on (if it's off) or off (if it's on). If you
want to change the setting, press Y for yes.

)
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Requiring One or Two Spaces between Sentences

s Youcanalso change

ABJ: this setting in
' AlphaSmart

Manager. With the NEO(s)
connected, click the Settings
tab in AlphaSmart Manager,
click KeyWords on the left,
and choose 1 or 2 after Set
Spaces between sentences.
Then, send the change to your
NEOs.

Traditional keyboarding classes taught with typewriters specified that typists
should put two spaces after a period before starting a new sentence. Modern
typesetting, word processing, and Web pages all use just one space between
sentences.

In the teacher options, you can specify the number of spaces that you want
your students to include between sentences. Follow these steps:

1. In KeyWords, move the cursor next to Teacher options and press enter.
2. Type the master password and press enter.

3. Move the cursor down next to Set one/two spaces between sentences
and press enter.

4. Usethe T ord keys to change the number of spaces between
sentences. You can specify either 1 or 2.

5. Press the space bar when you have finished making the change.

Using AlphaSmart Manager 2 with KeyWords

N
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AlphaSmart Manager 2 comes with each NEO. When you're using KeyWords,
this program can be useful in many ways:

« It lets you set all KeyWords options from one screen at your computer.

« If you have a SmartOption Mobile Lab with an AlphaHub, AlphaSmart
Manager 2 lets you manage KeyWords options for up to thirty NEOs at the
same time.

+ In AlphaSmart Manger version 2.6 and higher, the program can retrieve
KeyWords data from NEOs and create reports that you can print and save.

+ AlphaSmart Manager version 2.6 and higher can also synchronize that data
with the KeyWords program in Renaissance Place, allowing you to use that
program to generate reports. (See page 6-24.)

The following procedures explain how to use some KeyWords features of
AlphaSmart Manager 2. For complete instructions for AlphaSmart Manager,
refer to the AlphaSmart Manager 2 User Manual that is available on the
program CD or on our Web site.
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Setting KeyWords Options in AlphaSmart Manager

The KeyWords settings that you can change in AlphaSmart Manager are the
same ones that you can change on the NEO itself in the Teacher Options.
However, changing the settings is sometimes faster in AlphaSmart Manager
because you can make all setting changes in one window, and you can change
settings for all NEOs that are connected to your computer.

The following table describes the KeyWords settings you can change and
where to find the same settings on the NEO itself.

Setting What It Does
Disable this Turns off access to KeyWords so it can’t be used on the
SmartApplet NEO(s). KeyWords is still installed, but if anyone tries

to select it in the list of SmartApplets, they are notified
that it is disabled. Users of NEO need the master
password to enable it again. Click Yes or No.

Where to Find on the NEO

Press applets, move the cursor
down next to KeyWords, and
press ctrl-38-L. Then, enter the
master password and press
enter. | " will appear next to
KeyWords in the list.

Delete all students Deletes all students who have been added to
KeyWords and their KeyWords data. Click Yes or No.
Note: In AlphaSmart Manager, you can delete all
students, but not individual students. To delete one
student, use the KeyWords teacher options on the

You can delete one student or
all students in the teacher
options in KeyWords. (See
page 6-11.)

NEO.
Set custom WPM Sets a specific words per minute (WPM) speed goal for | You can set goals in the teacher
goals all students and all lessons. This overrides the options in KeyWords. (See

automatic progression of goals that KeyWords
normally uses (see page 6-14). Type the minimum
words per minute you want students to achieve. (The
default is 8.)

page 6-15.)

Set custom error Sets a specific goal for maximum errors allowed per
goals activity for all students and all lessons. This overrides
the automatic progression of goals that KeyWords
normally uses (see page 6-14). Type the maximum
errors you want students to be allowed. (The default
is12.)

You can set goals in the teacher
options in KeyWords. (See
page 6-15.)

Reset WPM /error Resets goals to the ones used by default in KeyWords
goals to default (see page 6-14). Click Yes or No.

You can reset goals in the
teacher options in KeyWords.
(See page 6-16.)

Turn require correct | Determines whether KeyWords checks to make sure
shift key OFF that students use the shift key opposite the letter they
are typing to make that letter uppercase. If students
use the wrong shift key, they will see a message asking
them to use the other shift key. Click Yes or No.

You can turn this requirement
on or off in the teacher options
in KeyWords. (See page 6-16.)

)
Sma IAPPLET' User Manual

6-19




KEYWORDS

Using AlphaSmart Manager 2 with KeyWords

Setting

Turn Home Row
confirmation ON

What It Does

Determines whether KeyWords requires students to
type the home row keys at the beginning of each
accuracy and speed builder activity and the beginning
of each test. This helps get students used to placing
their hands on the home row. Click Yes or No.

Where to Find on the NEO

You can turn this requirement
on or off in the teacher options
in KeyWords. (See page 6-17.)

Set spaces between
sentences

Determines whether students are required to type one
space or two between sentences. Click 1 or 2.

You can change the spaces
required between sentences in
the teacher options in
KeyWords. (See page 6-18.)

ALs_ If KeyWords isn’tin
AR the Settings list, one

* or more of the
connected NEOs doesn’t
have KeyWords installed. To
install it on all connected
NEOs, click the
SmartApplets tab, click
KeyWords in the list, and click
Add. (Once you’ve chosen to
install it, you can change the
settings.) Then, send the
SmartApplet to the NEOs (see
page 6-3).

s To restore all

ABJ: KeyWords settings
" tothe defaults, click

Restore Defaults at the

bottom of the window.

)
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Follow these steps to change KeyWords options in AlphaSmart Manager 2.
These steps assume that you have started the program and connected your
NEO(s) as described in the AlphaSmart Manager 2 User Manual.

1. Click the Settings tab in AlphaSmart Manager.

2. Click KeyWords @) in the list of SmartApplets on the left as shown.

=1 Untitled - AlphaSmart Manager, 2
File Edit Setup Help
D d i
Get/Print Alphatw/ord Files] Alphatwiord Files to Send] KeyWords] Smartpplst:  Settings ] Send L\st]

Mote: Only checked settings will be sent ta the AlphaSmarts.

Settings List Kemwords 3.4 Settings
[ Alphaluiz 31 ~ - -
Disable this Smarkspplet (e = N —_
[ Alphatword Pus 3.1 featle T Smaripn = -
7] Beamer 1.01 Dielete all students " Yes 1% Mo
[ ] Calculator 3.02
[ Contrial Panel 1.01 Set custom WPM goals 3
24 Set custom erar goals 12 —

(] & g £ anps L7
] A Fowad - £ e (5 dinanf
] Adser Feaear - Arsetiiom /7 e,
(1 Aewr Pt - Somad {6 A

New o - Vi Lagne (34
S SSL;JE;L:A'.{TWI?Z;’/;.V Tun Home Row confimation ON € Yes & Mo -

Restore Defaults...

Resst WP /smor goals to default ™ Yes T Mo

Turn Require comect shift key OFFT Yes % Mo

I I i i I B

AlphaSmart devices connected:

+

1 [ Direct USE |

3. Make changes as needed to the settings listed on the right. (Make sure

the box is checked for each setting you’re changing. As you change

settings, notice that the KeyWords box is automatically checked on the

left.)
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4. Click the Send List tab and make sure that your changes are listed.

=% Untitled - AlphaSmart Manager 2
File Edit Setup Help

OwE & i

Get/Print Alphaiword Files] Alphawiord Files to Send | Keywords SmarLAppIets] Gettings  Send List I

%

Send List Display

Send To device:alphaSmart USE

Current Spstem Applet: System 3.3 [Latest system)
AlphaSmart devices with a lower version of System Applet will be updated to the Curent System
Applet.

Keywords 3.4 Options:
Set custom WP goals = 8

Send

AlphaSmart devices connected: 1 [ Direct USE |
+

If you have multiple NEOs and you want to limit the changes to certain
NEOs, click Select Devices, check the NEOs that should get the
changes, and click OK.

Click Send.
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Retrieving KeyWords Data and Generating Reports in AlphaSmart Manager

)
Sma IAPPLET' User Manual

Follow the steps below to retrieve your students’ KeyWords data from NEOs
and view, save, or print reports. These steps assume that you have started the
program and connected your NEO(s) as described in the AlphaSmart

Manager 2 User Manual.

1. Click the KeyWords tab in AlphaSmart Manager. AlphaSmart Manager
will retrieve students’ KeyWords data from all connected NEOs. You can
use the drop-down list €)) to choose whether to sort by student or to list
students under the device (NEO) they’ve used.

=1 Untitled - AlphaSmart Manager, 2

File Edit Setup Help

D d i

Sort by | Student - o

Get/Print Alphatw/ord Files] Alphavword Files to Send  Kesw/ords Smartr’-\pplats] Sattings] Send L\st]

cho (Device #1)
Donne, Benjamin ....... [Device #1]
Fuller, Keisha ........[Device #1]

Synch with BP...

o Repoits...

AlphaSmart devices connected: 1 [ Direct USE |
*

2. Check the boxes next to the students or devices (NEOs) you want to
include in reports and click Reports @). (If you don’t check any students,
the program will assume you want to include all students listed.)

3. First, click the report you want
to generate: Student Detail or
Student Progress @:

e The Student Detail Report
lists each student’s
information separately by
lesson, including the goals,
actual words per minute
and errors, whether the

KeyWords Report Options E‘

Fieport Options

Choose a report:

Student group:

GG Student Detail
" Student Progress

ol’: Selected Students
" Al Studerts

lesson was passed, and the accuracy and speed builders completed.

¢ The Student Progress Report includes information on each student’s
latest lesson, including the goals, actual words per minute, actual
errors, and whether the lesson has been passed.
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Next, click the group you want to include: the selected (checked) students

or all students @.
Click OK to continue.

4. The report will open in a new window.

)
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KeyWords Report

X

Detailed Student Report CIuly 20, z007) s
(Lessons listed in the order they were completed.)
“amacho, Luis's Keywords Report
Lesson  Goal ACtual Goal ACtual Passed Accuracy & Speed
WEM R Errors Errors Euilders Done
ASKL -3 17 12 z Yes 1,2,3,4,5,6
D1F 3 13 12 il Yes 1,2,3,4,5,6
TH 1z 23 1z o TES 1,2,3,4,5,8
Donne, Benjamin's Keywords Report
Lesson  Goal ACtual Goal ACtual Passed Accuracy & Speed
WEM R Errors Errors Euilders Done
ASKL -3 12 12 13 No 1,2,3,4,5,6
DIF -— -— - -—- -—- 1
Fuller, Keisha's Keywords Report L3
Save... | Frirt... | Close |

To save the report, click Save, type a name for the report and choose a
location for the file, and click Save.

To print the report, click Print, choose your printer, and click OK

(Windows) or Print (

Macintosh).

To close the report window, click Close.
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st To find manuals in
Z@: Renaissance Place,

* click Manuals in the
upper-right corner of any
page. Then, click the manual
you want to open.
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ata with KeyWords RP

By following these steps, you can synchronize your KeyWords data with the
KeyWords program in Renaissance Place.

Renaissance Place is a Web-based information system that brings together a
wealth of student data, giving teachers, principals, and administrators the
information they need in one place. You can use KeyWords in Renaissance
Place if you own and have registered any other Renaissance Place product,
such as Accelerated Reader, Accelerated Math, STAR Reading, or STAR
Math.

Before you synchronize KeyWords data with KeyWords in Renaissance Place,
you must do the following:

» Make sure KeyWords RP is installed on your server.
+ Register at least one other Renaissance Place product.
« Activate your school(s) in Renaissance Place (see page 6-38).

« Make sure you have your Renaissance Place user name and password. (In
AlphaSmart Manager 2 version 3.0 and higher, different Renaissance Place
users can synchronize KeyWords data from the same computer as long as
they log in to the computer using different passwords or accounts.)

+ Add your KeyWords students to Renaissance Place (see the Renaissance
Place Software Manual). Make sure that the first and last names are
identical to the student names in KeyWords on the NEOs. This is important
because students’ KeyWords data is matched to their records in
Renaissance Place. Data can only be synchronized for students who have
been added to Renaissance Place.

« Make sure your KeyWords courses, classes, and teachers have been added
to Renaissance Place. Teachers must be assigned to the classes, and
students must be enrolled in the classes. You must also check the
KeyWords box for the lead teacher or check KeyWords when you assign
products to classes in the course. For instructions, see the Renaissance
Place Software Manual.

Follow these steps to synchronize KeyWords data with RP. These steps
assume you have already started AlphaSmart Manager and connected your
NEO(s) as described in the AlphaSmart Manager 2 User Manual.

1. Click the KeyWords tab in AlphaSmart Manager.

AlphaSmart Manager will retrieve students’ KeyWords data from all
connected NEOs. You can use the drop-down list (€)) on the next page) to
choose whether to sort by student or to list students under the device
(NEO) they’'ve used.
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=" Untitled - AlphaSmart Manager 2
File Edit Setup Help
b E f
GetPrint Alphatt/ord Files ] Alphaword Files to Send

Sort by: ’me

Keywards Smarb’-\pplats] Sattings] Send L\st]

[ e i)
onne, Benjamin [Device #1)

Fuller, Keisha ........ [Device #1)

Synch with RP. 0

Repoits

AlphaSmart devices connected: 1 [ Direct USE |

i

Click Synch with RP @.

3. Enter the Web address that you use to access Renaissance Place @.

Synch with Renaissance Place E|

Enter vour Renaizzance Place uzemame and password o gpnch your students using previous
synch options.

URL. |kt e G

[ v, myzchool.edusrenaissanceserver)

User name: |admin o

Password:  Jrssmes |
2 Keywords student(s] kotal
2 student(s) alieady matched to AP student(s]
(% Automatically sprch students | have aleady matched
" Use the full wizard to change previous matches of KeyWwords students to RP

| MNext > Caneel

Enter the user name and password that you use to log in to Renaissance

Place @).

If you have synchronized with RP before, you can choose to automatically
synch students that have already been matched, or you can use the full
wizard to change previous matches of KeyWords with RP @. Click an

option.
Click Next >.
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rs_ The first time you
3@: synchronize, or any
time you use the full
wizard, AlphaSmart Manager
performs a basic name match
(auto-matching) between the
list of Renaissance Place
students and the KeyWords
students on the NEOs.
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If this is your first time synchronizing, or if you chose to use the full wizard

to change previous matches, select the school you want to use if

necessary. Click Next >.

If you have synchronized before and chose to automatically synch
students with Renaissance Place in the previous step, a message will

appear telling you how many students were successfully imported into

Renaissance Place. Click Finish and go to step 11.

Check the class(es) containing the students that you want to synchronize

with Renaissance Place. Click Next >.

Match the KeyWords students with the Renaissance Place students as

described below.

Synch with Renaissance Place

Unmatched Students

. Lui
Donne, Benjamin
Fuller, Keisha
Keller, Bornie

Donne, Benjamin
Fuller, Keisha

(1]

=

o Matohed Students

Keyw'ords Students RF Students
Donne. Benjamin Donne, Benjamin

< Back Mext » |

Cancel ‘

@ Click a KeyWords student name

that you want to match to a
Renaissance Place student.
The list is based on the
KeyWords students who were
added to the NEO(s) connected
to your computer.

Click the Renaissance Place
student name you want to
match to the KeyWords student
you selected. The list is based
on Renaissance Place students
already enrolled in the school
and class you selected in the
previous dialog boxes.

0

Click Match >> to match the
students and move them to the
Matched Students area on the
right.

If you want to remove a match,
click the student names in the
Matched Students column and
click << Unmatch to separate
the names and move them back
to their respective columns on
the left side.

Click Next > when you have
finished.
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After the progress dialog box disappears, the program will show you how
many students had data successfully imported into Renaissance Place.
Click Finish.

Open your Web browser and go to the server address (URL) where
Renaissance Place is installed.

Log in to Renaissance Place (see page 6-34).

View and/or print KeyWords RP reports in Renaissance Place (see
page 6-39).

About KeyWords Reports

There are several different ways to get reports on student work in KeyWords:

Students can view a Student Progress Report on the NEO that shows their
work on all lessons, or they can choose a Last Lesson Report. See page 6-9.

Teachers can create a Group Progress Report on the NEO that includes
information on each student’s last lesson. See page 6-12.

Teachers can view a Student Detail Report or Group Student Progress
Report within AlphaSmart Manager. See page 6-22.

Teachers can use the templates that come with KeyWords to create a
master class report. This report includes each student’s Last Lesson Report.
See the next section.

Teachers can also view and print reports in KeyWords in Renaissance
Place. See page 6-39.

Creating a Master Class Report

By following the steps below, you can create a master class report that
includes the Last Lesson Reports from each of your students.

When you send a Last Lesson Report to a program on your computer instead
of printing it or sending it to AlphaWord Plus, the column headers aren’t
included so that you can easily create a master classroom report. To create the
master class report, you open the LastLessonreport.xls Microsoft Excel file
included on the AlphaSmart Manager 2 CD; then, you have your students
create a Last Lesson Report and send their reports one at a time into the Excel
file on your computer. Follow the steps on the next page.

)
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1. Copy the LastLessonreport.xls file that is on the AlphaSmart Manager 2
CD in the KeyWords Extras folder. Paste the file onto your computer and
open it. Click on the first cell under the heading as shown ).

=] Lastlessonreport.xls Q@@

A B C D E F G H =

1 |KeyWords Last Lesson Class Report
2

3 |Teacher: Date: 11-Jul07
4

5 |Student Name  Latest Goal Actual Goal Actual Passed
5 Lesson  WPM WPM Errors Errors
7| 0 |

g

9

10
11
12
13
14

15
W 4[» [M}\Sheetl /Sheetz / Sheet3 / |«

2. Have your students create a Last Lesson Report on their devices. (See
page 6-9.) Tell them to wait before choosing to print the report, senditto a
computer, or send it to an AlphaWord Plus file.

3. Have a student connect his or her NEO to your computer using the USB
cable. Then, ask the student to move the cursor next to Send directly to
computer and press enter. After a moment, the student will be asked to
press send. This will send the student’s data into the first row below the
column headings. When the data has been sent, have the student
disconnect the NEO. Click in the first cell in the next row.

Repeat this step for each student.

4. Add any other information you want in the report, such as your name or
the classroom, and then save or print the file for your records.

About the Options for Generating Reports on the NEO

When you create KeyWords reports on the NEO, you can choose one of three
options:

« Print the report from the NEO directly to a printer, either by connecting
the NEO to the printer with a USB cable or by using IR beaming to send the
report wirelessly. (NEO 2 laptops can also send the report to the printer
using radio frequency technology; see the NEO 1 and NEO 2 User Manual.)

» Send the report to an open file on your computer via a USB cable
connection.

« Transfer the report to one of the AlphaWord Plus file spaces (file 1—
file 8).

)
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Printing Reports
If you chose to print the report, follow these steps:
1. Connect the NEO to your printer using a USB cable, or put the NEO

within range of an IR printer. (NEO 2 laptops can also print using radio
frequency technology; see the NEO 1 and NEO 2 User Manual.)

2. Press print. KeyWords will inform you that the NEO is connected to your
printer; then, it will send the report and go back to the report options
screen.

3. Press esc until you return to the KeyWords main screen.

Sending Reports

If you chose to send the report to your computer, follow these steps:

sty Ifyou notice missing
‘@: characters or 1. On your computer, open the program and file that you want to send the
Jumbled text, you report to. Make sure your cursor is in the file so that it is active. For best

might need to slow down the ) ) . . .
transfer speed for NEO. To formatting results, choose a fixed-width or monospace font like Courier;

change the speed for one these fonts make the columns and header information line up correctly.
NEO, press option-3-s. To 2. Using a USB cable, connect the NEO to your computer.
change it for several NEOs,

use AlphaSmart Manager 2. 3. Press send. The text will appear in the file you have open.

Press esc until you return to the KeyWords main screen.

Transferring Reports to AlphaWord Plus

When you transfer a KeyWords report to AlphaWord Plus, you save it to one
of the existing file spaces (file 1—file 8). Any text that is already in the file you
choose will be overwritten.

This is a quick way to see reports right on the NEO. However, because the
NEO screen is not as wide as a computer screen or printer page, the report
will wrap across several lines, making it hard to read onscreen. If you transfer
the file to a computer or printer, the report will return to its proper
formatting if you use a monospace font like Courier.

If you have a SmartOption Mobile Lab with several NEOs connected, saving
reports to an AlphaWord Plus file is also useful because you can use
AlphaSmart Manager to retrieve the files from all connected NEOs at the
same time. Then, you can view, save, or print the reports from your computer.

If you choose to transfer a report to an AlphaWord Plus file, follow these
steps:

1. Type the file number that you want to send the report to.

)
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If the file is not empty, KeyWords will warn you that there is text in the file
that will be deleted. To continue, press Y for yes. (If you don’t want to
continue, press N for no. KeyWords will ask you to choose a different file.)

KeyWords will save the report in that file and open it in AlphaWord Plus.

Using KeyWords RP to View and Print Reports

KeyWords RP is a Renaissance Place program that allows you to generate
reports about your students’ work in KeyWords on NEOs. You do not need to
purchase KeyWords RP separately. You can use it if you have another
Renaissance Place program registered and if you are using KeyWords on
NEOs.

KeyWords RP provides powerful and easy-to-use reports so teachers can see
information for individual students, classes, and entire schools.

How KeyWords RP Works in Your Classroom

s To find the

Z@: Renaissance Place
' Software Manual,

click Manuals in the upper-

right corner of any

Renaissance Place page.

Then, click the manual that

you want to open.

)
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1.

A Renaissance Place administrator activates the schools that will be
using KeyWords. This registers KeyWords RP for those schools. (See
page 6-38.)

The Renaissance Place administrator also adds the KeyWords students
and their teachers, courses, and classes. Teachers must be assigned to
the classes, and students must be enrolled in those classes. You must
also check the KeyWords box for the lead teacher or check KeyWords
when you assign products to the classes in the course. To find out how to
perform these tasks, refer to the Renaissance Place Software Manual.
The student names must exactly match the student names you’ve
added in KeyWords on the NEOs.

Students complete KeyWords lessons on their NEOs. (Each student
should use only one NEO for KeyWords to avoid confusion in reports.)

Teachers use AlphaSmart Manager to synchronize the KeyWords Data
on the NEOs with the data in KeyWords RP. (See page 6-24.)

Teachers, principals, or administrators use a Web browser to go to their
Renaissance Place address. Then, they log in to Renaissance Place.

Users click Reports under KeyWords to choose the report they would like
to generate. See page 6-39.
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Programs You Will Use

KeyWords RP

The KeyWords RP reporting software—accessible from the Renaissance Place
Home page—reports on students’ performance on KeyWords lessons on
NEOs. You'll need this program installed on your Renaissance Place server.

What You'll Use KeyWords RP to Do See Page
Activate schools 6-38
Synchronize data with NEOs via AlphaSmart Manager 6-24
Print reports 6-39
Get tips, manuals, and other documents to help you use 6-32

KeyWords RP in your classroom

rs_ For information on
P ). the Renaissance
Place management
system, see the Renaissance
Place Software Manual or
click Help in the software.

N
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Renaissance Place

Renaissance Place—also accessible from the Renaissance Place Home page—
lets you view and manage district, school, student, teacher, parent, course,
and class information in the Renaissance Place database, which is shared by
all Renaissance Place Edition software used in your district or school. The
tasks you can perform in the management program depend on your user
level. For example, administrators have more management tasks to perform
than teachers. Sample tasks may include:

« Adding, editing, or deleting courses and classes, and assigning teachers and
students to them

« Selecting a different school year to work in

 Viewing student information

KeyWords SmartApplet on the NEO

The KeyWords SmartApplet on the NEO is the program students use to work
through their lessons. KeyWords RP is compatible with KeyWords 3.3 or
higher.

AlphaSmart Manager

AlphaSmart Manager 2 is the link between the KeyWords SmartApplet on the
NEO and KeyWords RP. AlphaSmart Manager helps you retrieve KeyWords
data from NEOs and synchronize it with the data in KeyWords RP. You can
also use AlphaSmart Manager to change KeyWords settings for all connected
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NEOs. KeyWords RP is compatible with AlphaSmart Manager versions 2.6
and higher.

Learning KeyWords RP
You'll find many tools in the software to help you learn to use KeyWords RP:
+ Online manuals and tips
 Online help

« Other resources

Online Manuals and Tips

In the upper-right corner of every page in Renaissance Place and KeyWords
RP, you'll see a Manuals link. Click this link to see a list of the documents
that are available; then, click the document you want to open. For KeyWords
RP, you'll find these documents helpful:

Document What It Gives You

KeyWords User Manual + General information about the program
« Step-by-step instructions for working with the
program

Tips for Getting Started  + Helpful hints to get you started using the

with KeyWords program
Renaissance Place » Procedures for managing all school and district
Software Manual information

)
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Online Help

To access the online help, click Help in the upper-right corner of any page.
The help appears in a separate window as shown below.

s KeyWords - Windows Internet Explorer

@‘7 | = |y httpiJjtRenzissanceserver KW/ Comtrols kWManage. aspx o [#2 [ [ B | conens | ndex | searh
= Back | Other Help | Close Help

File Edt Wiew Fawortes Tooks  Help

T e [“KeyWUrds

— - " »
] I f3 - B - e - [hPage + £ Tods - KeyWnrdsO
ADMINISTRATOR USER, District

Home > KeyWords Manuals | Help | Log Out

KeyWords Tasks Page
KeyWords

Select = task This page lists tasks for Keywords RP,

Return to Homs Activate Schools: Click this link to activate (or register)
additional schools so they can use KeyWords RP reports.
i keyWords Tasks

B Befare you can activate schols, you must have schacls

Reports addsd to RF. Sse Adding Schonls inf R far mors

Activate Schools information.

Resources ) )
Reports: Click this link to view or print KeyWords RP
reports. Reports includs information sbaut your studants,
classes, courses, and keyboarding performance on NEOs,
Yo tan cUstarizs many rsports 10 incuds the studsnts,
classes, time period, or other data you need.

aTop

Resources: Click this link to find resources that will help
you use KeyiWards in your classraorm.

ts rezerved. About Renaizzance Place

See also:

Activating schools

Printing RP reports

KeyWords RP reports

Setting up RP to prepare for Keywords dats

Synchronizing KeyWords data from NEOs with KeyWords RP

Using KeyWords resources

& Local intranet H100% v < >
o The Help link is on every page in the + Click Back to view previously selected
program. Click it to get more information help pages.
about the page currently displayed in the « Click Other Help to see a list of the
program. Renaissance Place programs installed on
@ To navigate the help, use the buttons at the your server and click a program name to
top of the help page. view its help.
« Click Contents to display the table of * Click Close Help to close the help.
contents for the help. © This logo lets you know you're in the
+ Click Index to display an alphabetical list KeyWords RP help. If you go to another
of topics. program’s help, the logo for that program
+ Click Search to find help topics using will appear.

words or phrases.

)
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Other Resources

The KeyWords RP software contains other resources to help you use
KeyWords in your classroom. Click Resources in the KeyWords RP task list
on the Home page to find forms, charts, posters, keyboarding cards,
configuration steps, information to help you get started, research, and best
practices.

Checking System Requirements

To use KeyWords RP, you must have Adobe Reader installed on your
computer so you can view reports. If you want to see if a specific computer
has the necessary software to run KeyWords RP, click Check Software
Requirements on the Renaissance Place Welcome page before you log in.
For details, see page 6-40.

For the most up-to-date hardware requirements for KeyWords RP, visit
www.renlearn.com/requirements.

Logging In to Renaissance Place and Changing Your Password

Use these instructions to log in to Renaissance Place so you can access the
KeyWords RP program. You can also change your password (either by choice
or when the system requires it).

Only personnel who have been added to the program by the administrator
can log in.

1. In your Web browser window, go to the URL for Renaissance Place.
Supported browsers include Internet Explorer, Firefox, and Safari.

On the Welcome page, click Teacher/Administrator.

Enter your user name and password.

To change your password, check the
Change Password box. Teachers /Administrators

Enter user name and password

4. Click Log In. If you're not changing
your password, your Home page
opens.

User Mame

Password

[ change Password

Technical support: support@renlearn.com
Corporate web site: www.renlearn.com
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5. If you are changing your password,
Lr_ If the Change

enter it now, type it again to verify it,
and click Save to open your Home change Password

Enter 3 new password
page.

BN Password page

appears and you
didn’t choose to change
your password when
logging in, one of two things New Password |essssese
has happened. Either your
system administrator wants
ygu to change it for security
reasons or you haven’t
changed it in a year and the
system requires it.

Repeat Mew Password --------l

Switching Roles in Renaissance Place

Some people in your district or school may be assigned more than one role, or
they may be assigned to more than one school. For example, the librarian in
the high school might also teach a class in one of the middle schools.

Renaissance Place keeps track of these multiple roles and school
assignments. You can switch between roles or schools after you log in or any
time while you are using the software. On the Home page, choose a role from
the User Type drop-down list.

i Renaissance Place

Harne

Home

Welcorne Daniel Brown

User Type: | Teacher User hd
School User: Maple Academy

A School User: Martin Middls Schaol

For more information, see the Renaissance Place Software Manual.

Navigating the KeyWords RP Software

The navigation bar at the top of each page shows you where you are in the
software, as shown here.

P4 KeyWords

Heme = Reports

If you need to go back to a previous page, use the links in the navigation bar
rather than the Web browser’s Back button, which can sometimes give you
unexpected results. For example, if you're on the Reports page and want to
display the Home page, click Home in the navigation bar.

N
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Logging Out and Closing the Renaissance Place Software

w1, Automatic logout When you've finished working in KeyWords RP Reports, log out to keep your

Z@: after 20 minutes. If data secure.

you don’t use . . i
KeyWords RP for about 20 1. Click Log Out in the upper-right corner of any page.
minutes, it automatically logs 2. Close the software by closing your Web browser.

you out, and you'll have to log
in again when you return to
the software.

Setting Up the KeyWords RP Software

Much of the preliminary setup for your Renaissance Place programs occurs
before you log in for the first time. For example, KeyWords RP should be
installed by your program administrator, or it may be installed on a server
hosted by Renaissance Learning.

The tasks listed on the next page must be performed after KeyWords RP is
installed and before you synchronize KeyWords data so you can view reports.
You may or may not be the one required to perform these tasks.
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Task

Usually Performed By

District

School

Admin.

Staff

Admin.

Staff

Teacher

Where to Find
Instructions

Enter district information

v

Add school years

Add school information

<\

Add school administrators and district
staff

Register at least one other Renaissance
Place product

Renaissance Place
Software Manual

Activate schools for KeyWords RP
Reports

Page 6-38

Add teachers, school staff, and students
(make sure student names match
exactly what is entered in KeyWords on
your NEOs)

N ERENERNERNENEN

Add school marking periods

<

Add courses and classes, assign
teachers—designate a lead teacher for
each KeyWords class—and enroll
students in classes

Renaissance Place
Software Manual

Make sure teacher and student
computers have the necessary software
installed

Page 6-34
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Activating Schools

. After KeyWords RP has been installed on your server, schools have been
Who Can Do This? . .
added, and at least one other Renaissance Place product has been registered,
a district or program administrator must activate the school that will be using
KeyWords RP. KeyWords RP is automatically registered when you activate a
(L1 School Administrator school; it does not need to be registered separately.
[[] School Staff

[] Teachers

To change capabilities,
see page 6-47.

VI District Administrator
[] District Staff

Note: At least one other Renaissance Place product (such as Accelerated
Reader or STAR Math) must be registered before you activate KeyWords
schools. See the Renaissance Place Software Manual to register those
products.

Follow these steps to activate schools for KeyWords RP:

1. If no schools have been activated yet, click Select schools to use
KeyWords in the list of KeyWords RP tasks on the Home page. If schools
have been activated already, click Activate Schools. (If you don’t see a
list under KeyWords, click Show Details.)

2. Click Activate by the school you want to activate @) on the next page.
You can only activate one school at a time. Repeat this step for each
school you want activated.

xrr_ To deactivate a

A=)~ e
@ school, see
* “Removing Product Home > Activate Schools
Registration” in the fjﬁ‘fff fcm:lfw‘__ e
Renaissance Place Software
Manual.

Product: KeyWords

School Action
East Elementary School Activate
Maple Academy

North Terra Grade School Activate

Roosevelt School Activate
Westfield Elementary Activate
D
uls_ After the schools
- g:‘;i,‘.’eefo";zg:;ed’ O Click Activate to activate that © Atter you click Activate, the
Lead KeyWords RP teacher to school for use with KeyWords. software will enter the
the KeyWords RP classes you Click << Previous or Next >> to necessary codes for you and
create. When assigning move back and forward through the link will change to the word
personnel to the class, check the list of schools if the list goes “Activated.”
the KeyWords box and select to more than one page.
Lead from the role drop-down
list. 3. Click Done when you have finished. The Reports link will now be

available in the list of KeyWords RP tasks on the Home page.

)
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Bringing KeyWords Data into KeyWords RP

To bring your KeyWords data from NEOs into KeyWords RP, you need to use
AlphaSmart Manager to synchronize the KeyWords data from the NEOs with
KeyWords RP. For instructions, see page 6-24.

Viewing KeyWords RP Reports

KeyWords RP reports give you more information about your students’
progress and performance on KeyWords lessons and tests on the NEO.
KeyWords RP reports also provide details about class performance, student
and teacher information (including user names and passwords), and
schoolwide performance in KeyWords.

Renaissance Place Reports vs. KeyWords RP Reports

On your Renaissance Place Home page, you will see a Consolidated Reports
link under Renaissance Place in addition to the Reports link under
KeyWords.

When administrators and teachers click Consolidated Reports @3 under
the Renaissance Place tab, they can generate reports with data from more
than one Renaissance Place product. However, KeyWords data does not
appear on any Renaissance Place consolidated report.

When you click Reports @ under the KeyWords tab, you can generate
reports about your student’s KeyWords lessons.

i Renaissance Place

Horne
Home
welcorne ADMINISTRATOR USER
i Hide Details
Consolidated Repurtso Data Consolidation Status
School Years Last Consolidation: 9/17/2007
District and Schools Mext Consolidation: 9/18/2007
Courses and Classes
Personnel, Students, and Parents
Product Administration
.
ﬁ KeyWords Hide Details
Reports B
Activate Schools
Resources

)
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s If you are an
p " administrator or
teacher, you don’t

need to log out to check
software requirements.
Simply click Product
Administration on the Home
page and click Download
Supporting Software to go to
the Software Requirements
page.

s Adobe Reader
:@: should be installed
: by a user who is
logged in on the computer as

an administrator or as a
member of the Administrators
group with administrative
rights; this will make the
software accessible to all
users of the compulter.

N
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Check for Adobe Reader Before You Generate Reports

KeyWords RP reports are in PDF format. You will need Adobe Reader
installed on your computer to view and print these reports. (On some
Macintosh computers, you can use the Preview program that is already
installed.) Before generating reports, you can check to see if your computer
has Adobe Reader by logging out of the software and clicking Check
Software Requirements on the Welcome page. When the Software
Requirements page opens, click Test Adobe Reader @ to find out if it is
installed on your computer. If the computer tries to download the test file
instead of simply opening it in Adobe Reader, click the install Version link
to go to a Web page that tells you where to download Adobe Reader.

Software Requirements

Supporting Software
Software / Primary Use Acticn
Adobe Flash Player

Student testing and scoring
as well as student practice and quizzing

Used by: 20000000 OFOCOOONOSS
A
EEEE:::ZEES E:::jer Flash Player meets the requirement.
E&%I‘w‘igcﬁ ?nH:;ha:h If "Flash Player meets the requirement.” does not display above,

. install Version 7.0 or later.
Renaissance Home Connect

STAR Early Literacy
STAR Math
STAR Reading

Adobe Reader

Wiewing and printing reports o
as well as assessments and assignments Test Adobe Reader
If Adcbe Reader won't open, install Version 5.0 or later.
Used by:
All Products
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Creating and Printing KeyWords RP Reports

1. Click Reports in the KeyWords RP task list on the Home page.

2. Select your school from the School drop-down list if necessary €.
3. Click the report name on the Reports page @.

Who Can Do This?
I District Administrator
V] District Staff

I School Administrator
V] School Staff
V] Teachers

To change capabilities,
see page 6-47.

N
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B KeyWords

Home = Reports

Reports

ADMINISTRATOR USER, District 2008-2009

Manuals | Help | Log

Click on a repart name to view the report vith default ssttings

School: | Maple Academy

Frequently Used Reports

Report Description
Diagnostic A class progress and summary.
Student Re

Other Reports

A summary of student's progress.

Report Description
Certificate A certificate for recognizing student progress.
A list of classes detailing assigned teachers and
Class
enrolled students.
Enrollment A list of students detailing their enrollment in

Schoolwide Summary

Student Detail

Student Information

Student Legin

Teacher

KeyWords.

A summary of class and grade level
performance.

A list of all students and their personal
identification information.

Lists students and provides user names,
passwords, and personal identification
information.

Lists students and provides gender, date of birth,
grade, information, KeyWords user name, and
password.

A list of teachers detailing their KeyWords class
assignments.

Get
ADOBE® READER®

Out
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4. Select the options you want to customize for this report on the Report

w1, Custom report Options page. (If the report can’t be customized, the report will be
:@: options. Each report generated as described in step 5.) Click View Report when you've
* has its own set of finished @.
options. For more information
about the custom options F-L KeyWords ADMINISTRATOR USER, District 2008-
available for each report, see Home > Reports Manuals | Help | Log Out
page 6-45. Report Options

Select the options for this report.

School: Maple Academy
Report: Diagnostic Report

[ Cancel ] [ View Report

Customization Options

All Classes v
Select Students

Or Select Specific: Students | Classes

All Demographics [Default]
Reporting Parameter Group grap i ! o

Or Create New or Edit Selected

® predefined Date Range: | 2008-2009 +
Reporting Period

© Custom Dates: to |7/31/2009 =
@ Class

Group By
O Do not group

Print Report Options Print the selected report options in the report

[Cancel] [ View Report ]G

© For many reports, you can @ Reporting parameter groups let
choose students by name or you choose students with
class. To choose them by name, common traits. For more
click Students. To choose them information, see page 6-44.

by class, choose a class from
the drop-down list or click
Classes.

G After choosing report options,
click View Report.

)
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s Don’tuse the
P ). browser’s print
function. If the report
opens in a browser window,
don’t try to print it using the
browser’s buttons or menus
because only the top of the
page will print. Use the Adobe
Reader buttons instead.

rs_ On Macintosh
ABJ: computers, the

: report may open in
Preview. If so, click the File
menu and choose Print to
print it.

)
Sma IAPPLET' User Manual

KEYWORDS
Using KeyWords RP to View and Print Reports

KeyWords RP Reports will generate the report. When it's ready, the report
will open in the browser window or a separate window. To save or print it,
use the Adobe Reader buttons (@ and @), not the browser buttons.

] http:/it/RenaissanceServer/JKW/ReportController.rli - Microsoft Internet Explorer

File Edit Wiew Favorites Tools Help 7
@Back » ) - (%] 2] n S search <rFavortes L & -
address | @] http: t/RenaissanceServerKW/ReportContraller.rl v| B ik ? @
.,'-L KeyWords ADMINISTRATOR USER, District 9
Home > Reparts Help | Log Out
select a Different RepurtQustum\ze this Report
BaiEen0beiaia-GEe e[t 2l
o »
§ KeyWords- Diagnostic Report Torz
Los| Printed Monday, September 17, 2007 11:22:31 AM
E School: Maple Academy Reperting Period: 9/10/2007 - 9/17/2007
£ (2007-2008)
E Report Options.
|, Group By: Class
& Class: BK, Nilsen
o ‘Teacher. Nilsen, Michae!
£ Lessons Tested Last Lesson Completed
< Diagnostic  Completed Passed Goal Actual Date Last
=5 Student Codes / Total % /Taken % | Lesson WPM [ Error  WPM/ Emor Submitted
Camacho, Luis aris 20 s 100 | TH 12/12 102/0 08107
| Donne, Benjamin A 1118 7 an 0 | DUF 09¢11/07 |
= [z |b bl © e
&) Dane % Unknawn Zane {Mixed)
@ Click the save button to save @ These options let you customize
the report instead of using the a report or go back to choose a
browser’s save function. different one.
© Click the printer button to print
the report instead of using the
browser’s print function.
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About Reporting Parameter Groups

Reporting parameter groups let you limit reports to students with common
traits. When you choose custom options for some KeyWords RP reports, you

N

can choose a reporting parameter group from a drop-down list. You can also
create or change a group by clicking Create New or Edit Selected.

P4 KeyWords

Heme > Reports

Reporting Parameter Groups
Creste 2 new reporting paramster group or =dit an existing ane

Edit an Existing Reporting Parameter Group: | --Create Nesw Group-- (v

porting

Group ( Field)

Reporting Parameter Group Name™®

Enroll Date
Include students enrolled before this date,

Ethnicity

select ail

dessiect ali [0 asian or Pacific Islander

Gender
select al

[ Female [ male [ mot specified
desetect ali

[ Haitian Creole [ polish

Characteristics
select ait

[ Arnericans with Disabilities (ADA)
desetect all

[ at-Risk students

[ eilingual Education

[ English 25 a Second Language (ESL)
[ Free Lunch

Include students with:

@any 7 Oal

selected characteristics

Grade
select al
desetect alf

[ Early Education

[ Kindergarten

[ Arnerican Indian or Alasks Native [ Black

[ wihite
[ Hispanic [ Mot Specified e

lemguege O arabic [ Hmong [ Portuguese
select ait
deselect alt [ chinese: Cantonese [ Japanese [ Russian
[ chinese: mandarin -~ [ khmer [ serbo-Croatizn
[ chinese: unspecified [] Korsan ] Somali
[ english O taa [ spanish
[ French [ malay [ Tagalog or Filiping
[J German [ Navajo [ urdu
O Gujurati O other O vietnamese

O Grade 4 [ Grade 10
[ pre-kindergarten [ Grade 5 [ Grade 11
[ Grade 6 [J Grade 12

[ Grade 1 [ Grade 7 [ 12+
O Grade 2 O Grade 8 [ none
[ Grade 3 [ Grade 9

ADMINISTRATOR USER, District
Manuals | Help | Log Out

[ Mot Specified

[ cifted/Talented [T physically Disabled

[J Learning Disabled [] reduced-price Lunch Program
[ Limited English Proficiency (LEP) [] Special Education

[ migrant [ itle 1

[J Non-resident Alien [ not specified

Q By entering an enroll date, you
select students enrolled in the
school before the date you specify.

G You can specify each student’s
ethnicity, gender, language, and
grade when you add the student
or edit his or her information. See
the Renaissance Place Software
Manual. Then, you can check the
groups that you want to include in
the report on this page.

Sma IAPPLET' User Manual

© You can assign characteristics to
students separately. You can also
add your own custom
characteristics and assign them to
students. See the Renaissance
Place Software Manual. When you
check characteristics here, be
sure to click an option on the left to
choose whether to include
students with any of the
characteristics or only those with
all checked characteristics.
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Report Descriptions

This table lists the KeyWords RP reports with a description of what is in each
report and the options you can change for the report.

Report Why You Would Use It Things You Can Change
Certificate Recognizes students who have successfully completed their ~ You may select:
goals for number of words per minute (WPM) and errors or  « classes or students to include
those who have completed lessons. Each certificate « date range

includes a title, the student name, the accomplishment, and .+ text included

two signature lines. « signature lines

Class Lists your KeyWords classes, their teachers, and their No custom options.
students.

Things to Note

« Only KeyWords RP classes are included. To make a class
a KeyWords RP class, check the KeyWords box when
you assign a teacher or when you assign products to the
classes in a course.

Diagnostic Helps you monitor student work on keyboarding lessonsin ~ You may select:
KeyWords. It notes progress toward goals and alerts youto « classes or students to include
problems students are having. The report includes the « date range
number of completed lessons and the total number of « grouping used

lessons, the percentage of lessons completed, the number of

passed lessons out of those taken, the percentage of lessons

passed, diagnostic codes, and detailed information about

the lessons completed (including the lesson names, goal for

words per minute and errors, actual words per minute and

errors, and the date the data was imported into RP from

AlphaSmart Manager).

Things to Note

» Diagnostic codes are defined on the report. They help you
see potential problems.

« The report supports a direct discussion with an
individual student’s parents or guardians.

« There is a page break after each group.

 whether to print the selected
options on the report

Enrollment Lists students, their classes, and teachers. No custom options.

)
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Report Why You Would Use It Things You Can Change
Schoolwide Provides details about your students’ most recent You may select:
Summary KeyWords tests. The report includes the number of « date range
students, the average number of lessons they’ve completed  « grouping used
out of the total number, the average percentage completed, . whether to print the selected
the average number of lessons passed out of those options on the report
completed and the percentage passed, the goals for words
per minute (WPM) and errors, and the average words per
minute and errors in the last lesson.
Things to Note
« Use this report to get a good overall picture of your
students’ keyboarding performance while using
KeyWords on the NEO.
Student Detail  Lists your students. Includes each student’s ID, gender, No custom options.
date of birth, grade level, ethnicity, and characteristics.
Things to Note
« To find out how to set this information for each student,
see the Renaissance Place Software Manual.
« If the administrator hasn’t given you the capability to see
ethnicity and characteristics, they won’t appear on the
report.
Student Lists each student’s name, ID, gender, date of birth, grade, = You may select:
Information Renaissance Place user name, and Renaissance Place « classes or students to include
password. « sorting used
Things to Note + grouping used
« This report provides Renaissance Place login « page break after each group (if
information. Your students’ passwords for KeyWords on grouping is used)
the NEO may be different. To get those passwords, use » whether to print the selected
the Student Login Report. options on the report
Student Login  Lists each student’s name, ID, gender, date of birth, grade, = You may select:
KeyWords user name, and KeyWords password. « classes or students to include
Things to Note + date range
» Use this report to give your students their KeyWords + sorting used
passwords before they use KeyWords on the NEO. + grouping used
Students need this information to log in to KeyWords on  « page break after each group (if
NEOs so they can take lessons and tests. grouping is used)
« whether to print the selected
options on the report
N
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Report Why You Would Use It Things You Can Change
Student Provides information about student performance on You may select:
Record keyboarding lessons. Includes the lesson name, whether or  « classes or students to include
not it was passed, the student’s goals and actual . date range
performance for words per minute and errors, and the « page break after each student’s
accuracy and speed builders completed. The report also information

includes the date that data was last brought into KeyWords
RP using AlphaSmart Manager.

Teacher Lists KeyWords RP teachers, their user names, classes, and No custom options.
class position.

Things to Note

« This report can help the administrator see which teachers
are using KeyWords RP.

» When teachers print the report, it includes only their
information. It doesn’t include other teachers.

 Only teachers of KeyWords RP classes are included. To
make a class a KeyWords RP class, check the
KeyWords box when you assign a teacher or when you
assign products to the classes in a course.

Capabilities in Renaissance Place Programs

Capabilities in Renaissance Place programs give users the right to perform
specific tasks in the software. They are preassigned based on:

« the user group you belong to and the position you hold in your district or
school

« the tasks that group usually performs

KeyWords RP has no capabilities that are unique to that program, but you can
find a table of Renaissance Place tasks and the standard set of capabilities in

the Renaissance Place Software Manual. Within Renaissance Place, district

or school administrators can change the capabilities assigned to:

« new users added to a specific group
« groups of current users already in the database
« a specific person

To find out how to change capabilities, see the Renaissance Place Software
Manual. That manual also includes a list of the user groups and the positions
in each group.

)
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KeyWords Resources for Teachers

The resources that are available for KeyWords can help teachers find out how
to use KeyWords to teach their students touch-typing. Resources include:

« reference materials provided with KeyWords and KeyWords RP that you
can use to make handouts and transparencies

+ areview of ergonomic typing posture and body placement

« asample lesson plan for using KeyWords in a classroom with NEOs

Materials for Handouts and Transparencies

You'll find KeyWords Resources in two places:

w1, You need Adobe + Inthe KeyWords Extras folder on the AlphaSmart Manager CD (and in the
:@: Reader to view and AlphaSmart Manager download files), you’ll find a file named KeyWords
print all PDF files. If SmartApplet Master.pdf. This file contains helpful handouts and

you don’t have Adobe Reader,
see page 6-40 or click the Get
Adobe Reader icon on the

transparencies. You’'ll also find this file on the Documentation CD for
NEO 1 and NEO 2 in the SmartApplets folder.

KeyWords RP Resources « In KeyWords RP (Renaissance Place), you can click Resources in the list
page. of KeyWords tasks to see many of the same resources.
The handouts and transparency masters that are available are described in
the following table.
Name of Handout Description of Master Where to Find It

Prepare these masters before using KeyWords on NEOs:

Posture and Wrist This master shows a drawing of a student « In the KeyWords SmartApplet

Placement seated properly with good wrist and hand Master.pdf file on the AlphaSmart
position. Use it to create an overhead Manager CD (in the KeyWords Extras
transparency or a reference handout for folder) and the NEO Documentation
students. CD (in the SmartApplets folder).

« In the KeyWords RP Resources under
Forms and Charts in the Getting
Started Posters.

)
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Name of Handout

Description of Master

Where to Find It

Key Strike This master shows close-up sketches of In the KeyWords SmartApplet
correct finger strike positions. Use it to Master.pdf file on the AlphaSmart
create an overhead transparency or a Manager CD (in the KeyWords Extras
handout for students. folder) and the NEO Documentation

CD (in the SmartApplets folder).
In the KeyWords RP Resources under
Forms and Charts (see the Getting
Started Posters).

Finger Zones This master illustrates the keyboard divided In the KeyWords SmartApplet

into zones. A graphic shows the fingers that
correspond to the zones on the keyboard on
each hand. Use this master as a handout or
a poster.

Master.pdf file on the AlphaSmart
Manager CD (in the KeyWords Extras
folder) and the NEO Documentation
CD (in the SmartApplets folder).

In the KeyWords RP Resources under
Forms and Charts (see the Getting
Started Posters).

Home Row Keys

This master shows Home Row positions for
the left and right hands. Use this master as a
handout or a poster.

In the KeyWords SmartApplet
Master.pdf file on the AlphaSmart
Manager CD (in the KeyWords Extras
folder) and the NEO Documentation
CD (in the SmartApplets folder).

In the KeyWords RP Resources under
Forms and Charts (see the Getting
Started Posters).

Use these masters while working with KeyWords on NEOs:

Finger Placement for
Lesson 1: Start Here!

This master illustrates the right and left
hands with fingers labeled, and shows those
fingers in their home row positions. It also
illustrates the finger reach to the enter key
and the use of the thumb to strike the
space bar. Use it to create handouts or
posters.

In the KeyWords SmartApplet
Master.pdf file on the AlphaSmart
Manager CD (in the KeyWords Extras
folder) and the NEO Documentation
CD (in the SmartApplets folder).

In the KeyWords RP Resources under
Forms and Charts (see the Finger
Placement Charts file).

Finger Placement for
Lessons 2 through 16

These masters illustrate finger placement
and reaches useful for student reference as
they learn each level. Use the masters to
create a handout for each lesson.

In the KeyWords SmartApplet
Master.pdf file on the AlphaSmart
Manager CD (in the KeyWords Extras
folder) and the NEO Documentation
CD (in the SmartApplets folder).

In the KeyWords RP Resources under
Forms and Charts (see the Finger
Placement Charts file).

N
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Name of Handout

Progress Report

Description of Master

Use this master to create hard copy reports
for students to fill in so they can track their
progress or hand in progress reports. This is
the same information kept by the NEO in
the students’ records.

Where to Find It

In the KeyWords SmartApplet
Master.pdf file on the AlphaSmart
Manager CD (in the KeyWords Extras
folder) and the NEO Documentation
CD (in the SmartApplets folder).

Use these masters as supplemental materials to KeyWords lessons on NEOs:

Sustained Practice

These masters contain additional practice
exercises for each lesson. Students can do
the exercises by typing in AlphaWord Plus.
Use these lesson-appropriate practice
sheets as students pass each lesson.

In the KeyWords SmartApplet
Master.pdf file on the AlphaSmart
Manager CD (in the KeyWords Extras
folder) and the NEO Documentation
CD (in the SmartApplets folder).

In the KeyWords RP Resources under
Forms and Charts.

Congratulations Use this master to create certificates to In the KeyWords SmartApplet
Certificate reward students as they pass each Master.pdf file on the AlphaSmart
KeyWords lesson. Manager CD (in the KeyWords Extras

folder) and the NEO Documentation
CD (in the SmartApplets folder).
In the KeyWords RP reports (use the
Certificate Report).

Keyboarding Cards Use the cards in this document to provide In the KeyWords RP Resources under

additional “game-like” activities for
reinforcement, introducing finger zones, or
to provide additional practice.

Forms and Charts.

These other resources will help you use KeyWords in your classroom:

Configure NEO to
Support Students with
Unique Learning Needs

This document explains how to configure
NEOs for students with unique visual needs,
motor control needs, or physical needs.

In the KeyWords RP Resources under
Getting Started in the Classroom.

KeyWords and
Renaissance Place
Integration QuickStart
Guide

This document explains how to add
KeyWords students and get students started
on lessons, change KeyWords settings in
AlphaSmart Manager, generate KeyWords
reports in AlphaSmart Manager, and
synchronize KeyWords data with KeyWords
RP so you can use KeyWords RP reports.

In the KeyWords RP Resources under
Getting Started in the Classroom.

Keyboarding: An
Essential Skill for the 21st
Century

This document summarizes keyboarding
research and outlines best methods for
teaching this skill.

In the KeyWords RP Resources.

AlphaSmart Keyboarding
Best Practices

This document describes ways to implement
KeyWords and UltraKey effectively.

In the KeyWords RP Resources.

N

Sma IAPPLET' User Manual

6-50



KEYWORDS
KeyWords Resources for Teachers

Keyboarding Ergonomics

Teaching students about proper posture and physical setup can help them
prevent health problems caused by typing.

Keep the following tips for wrists and hands in mind:

» Keep wrists aligned, straight, and level. (See the illustrations below.)
« Position chairs so students do not stretch to reach keys.

» Wrists should not rest on anything.

« Take periodic rest breaks.

0 0000 £Ooa oo [0 0Hoa BRon oot

= ] =M
| ]
MY g g

Correct hand and wrist position Incorrect hand and wrist position

Follow these guidelines to properly adjust equipment and posture:

» The keyboard should be just below elbow height so the elbows are bent at a
90° angle.

» The chair should adjust so it can fit the various sizes of your students.

» Forearms and thighs should be parallel to the floor when the student is
seated at the computer.

« Feet should be flat on the floor or placed on a tilted footrest.

« Position devices so that light does not reflect off the screen. Light reflecting
off the screen can cause eye strain and frustration.

N
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Sample Lesson Plan for Getting Started

This sample lesson plan teaches basic keyboarding information. You should
present this lesson to students at the beginning of keyboarding instruction.

Students will learn

+ Correct typing posture

« Correct wrist placement

« Home row keys

» How to strike keys

« How to strike the space bar

« How to strike the enter key

Preparation

Prepare the following overhead transparencies from the masters in the
KeyWords SmartApplet Master.pdf file or in the KeyWords RP Resources:

« Posture and Wrist Placement
+ Key Strike
 Finger Zones

+ Home Row Keys

Teaching the Lesson

Explain to students that there are several basic practices that promote
successful keyboarding. These practices include sitting with the proper
posture, holding the wrists properly, striking the keys correctly, and returning
the fingers to the home row keys. The following steps guide you through the
lesson.

1. Use the Posture and Wrist Placement overhead transparency to show the
correct typing posture and wrist placement. Have students sit at their
desks with their NEOs and demonstrate the correct posture and wrist
placement. Monitor students, helping them make needed adjustments.

2. Use the Key Strike overhead transparency to explain how to strike the
keys. Have students demonstrate and practice striking the keys.
(Students can use AlphaWord Plus on their NEOs to practice striking
keys.) Monitor students, helping them make needed adjustments.

3. Use the Home Row Keys overhead transparency to show the home row
keys. Have students place their fingers on the home row keys and

)
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practice typing a s d f and then j k | ;. Repeat several times until students
can strike the home row keys correctly.

4. Use the Finger Zones overhead transparency to show students the
keyboard zones for each finger. Have students practice striking another
key with one finger and then returning that finger to the home row key.
Practice with several fingers. Monitor students, helping them make
needed adjustments.

5. Show students how to strike the enter key and the space bar. The right
little finger strikes the enter key and then returns to the home row key.
Either thumb is used to strike the space bar. Have students practice
striking the enter key and the space bar and returning to the correct home
row key. Monitor students, helping them make needed adjustments.

6. Explain to students that pressing the enter key moves the cursor to the
beginning of the next line and that pressing the space bar inserts a space
between words.

7. Review the basics of sitting properly, using correct wrist placement,
striking the keys, and always returning to the home row keys.

Lessons in KeyWords

The following tables list the lessons provided in KeyWords. Each table shows
the keys introduced in the lesson, the words and word patterns learned, and
the passing criteria for testing (based on the default goals—see page 6-14).

Lesson 1: Start Here!

Keys introduced none
Words learned none
Patterns none
Passing criteria o WPM 0 errors
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Lesson 2: ASKL

Keys introduced ASKL
Words learned all as ask lass
alas
Patterns sl alk as ask
1
Passing criteria 8 WPM 12 errors

Lesson 3: DJF

Keys introduced DJF
Words learned add dad fall sad
lad salad flask jalls
jad jasks
Patterns fl ad s (plural)
Passing criteria 10 WPM 12 errors
Lesson 4: TH
Keys introduced TH
Words learned sat flat hat slat
that has fast last
ash flash slash dash
hash sash talk stalk
hall tall shall stall
salt half
Patterns th alt ast sh
st at ash
Passing criteria 12 WPM 12 errors
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Lessons in KeyWords

Lesson 5: GO
Keys introduced GO
Words learned dog hog fog log
jog look took hook
shook hag sag shag
lag got shot hot
lot old told gold
sold fold soft aloft
of off stool fool
soot tooth toast toad
oat goat float soak
load ghost good hood
stood flood
Patterns ood old ook oa
og ot ool oat
ost oad ag oast
gh
Passing criteria 14 WPM 10 errors
Lesson 6: El
Keys introduced EI
Words learned eat seal flea eagle
tea eel feel feed
geese goose loose lose
the these did lid
solid tie lake fake
gate skate jade like
kite ashes flashes glide
slide silk jog sigh
high tight light flight
seaside steak fish elfish
shoes headlight
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Lesson 6: El (Continued)

Patterns ee ea es se
ed ake ade id
ie ish ike ite
ide ilk igh ight
oe
Passing criteria 16 WPM 10 errors
Lesson 7: PR
Keys introduced PR
Words learned hop stop shop flop
slop ear hear dear
fear pear eager read
deer free tree see
red fled tire fire
tried tar jar hard
are large ark park
dark lark spark star
ill shrill starfish earth
thrill dope rope hope
girl radishes soap horse
reddish apples roses spider
pillar fairies parrot strolled
prettiest sorriest alligator
refrigerator
Patterns op ear er es
re ee ar ard
ark ope iest or
oll ir thr shr
str
Passing criteria 16 WPM 10 errors
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Lesson 8: QU
Keys introduced QU
Words learned rug hug jug our
hour four pour flour
out shout loud house
soup gush hush just
flush trust judge fudge
pure suds three quit
quiet quake quilt quote
quail quarter quart equip
quip squirt spirit dollar
said heartful stutter sputter
Patterns ug ou out ouse
ush ust udge qu
Passing criteria 16 WPM 8 errors
Lesson 9: WY
Keys introduced WY
Words learned day try way away
play playful stay joyful
why whole where flow
flowers pillow yellow plow
washed yaks owls hoot
write laws you furry
hurry story followed slowly
Patterns ay ow wh ly
ory urry aw wh
wr
Passing criteria 18 WPM 8 errors
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Lesson 10: Z?

Keys introduced Z?

Words learned zip zipper pizazz zeal
zigzag sizzle puzzles Zeus
gazes drizzle Zero lazy

jazz zesty
Patterns azz uz ze izz
77 Zi
Passing criteria 16 WPM 8 errors
Lesson 11: X.
Keys introduced X.
Words learned expert explode extra exit
express relax reflex exhale
apex explore prefix wax
tax ox fox duplex
paradox exasperate
Patterns ex ox ax re
pre
Passing criteria 18 WPM 8 errors
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Lesson 12: C,
Keys introduced C,
Words learned ace face race circus
circles sticky quick pick
chick peck chew juice
cupcake cheetahs duck Chuck
quack call COws careless
could carrot exactly clothes
deck crawls cards choose
chocolate
Patterns ace circ eck ick
uck uice ch cr
Passing criteria 20 WPM 8 errors
Lesson 13: MV
Keys introduced MV
Words learned love dove glove move
grove am my five
give arrive thrive alive
very avoid swerve wave
caramel muddy comics slime
scratch pimples rimful whim
pilgrim shrimp limp mild
might church
Patterns ove ive av ve
im ime
Passing criteria 22 WPM 8 errors
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Lesson 14: NB

Keys introduced NB
Words learned big bit nibble rabbit
job cob hobby blue
wobbles singing dancing bang
beach brown building brave
balloons blossom bouquet barley
subway caution explosion motion
extinction
Patterns ob ub br bl
1d bb bbl by
in ion sion
Passing criteria 22 WPM 8 errors
Lesson 15: " "!
Keys introduced "
Passing criteria 14 WPM 8 errors
Lesson 16: Numbers
Keys introduced 1234567890

Passing criteria

14 WPM 6 errors
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Frequently Asked Questions

Why can’t | use the backspace key when using KeyWords?

Why is there so much

Backspace is disabled because keyboarding research shows that students
need to learn the patterns of keystrokes uninterrupted by immediate
corrections. Disabling backspace benefits students because they can
concentrate on speed, not on correcting errors.

repetition of words in the practice passages?

Research has shown that speed and confidence increase more readily if
simple words are used and are repeated often. KeyWords offsets the
repetition by providing text with humor, poetry, and rhythmic chants.

Why are the passages so easy?

Easy practice material develops speed and typing fluency more effectively,
giving the student a feeling of confidence and a sense of success. Though the
passages are easy, they provide practice in all the needed key patterns.

Why is the sequence of key introduction so different from what | am used to
in other typing programs?

Many other typing programs are based on 1950s typing instruction.
KeyWords designers sensed the need for a more language-based program,
one that reinforces the development of a reading and writing vocabulary as it
teaches typing.

The content of the passages is based on word list analysis. High-frequency
words that help develop reading and writing vocabulary and spelling skills
were chosen for the practice material. KeyWords maximizes kinesthetic and
linguistic patterns, which is why it is the most efficient and enjoyable way to
learn to touch-type.

Why do the students learn the ASKL keys first?

N
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Two design principles distinguish KeyWords from all other keyboarding
programs: the application of kinesthetic (tactile, sensory) patterning and the
application of linguistic (language) patterns in all skill-building activities.

When students are learning the home row keys in the first lesson, they type
as. Students are typing enough on the left side of the home row keys to ensure
that their fingers are where they belong. Students are also using two fingers
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that are next to each other to press two keys that are next to each other in a
left-to-right motion; this is a kinesthetic pattern. The action results in a word,
as, which is also part of many other words, like fast; so as is also a linguistic
pattern. Learning the kinesthetic pattern generates a linguistic pattern.

On the right side of the home row keys, there are no little words to teach.
However, if a student types as on the left side and then adds a k, the student
has typed ask: all flowing left to right—a kinesthetic pattern—and all forming
aword—a linguistic pattern. Similarly, by typing all, the student is introduced
to the second right-side home row letter in a fully patterned manner.

Students learn the ASKL keys first because these letters are part of the home
row and they can be combined to form words. When new letters are added,
they are incorporated within kinesthetic and linguistic patterns. Such
patterning makes learning to touch-type very efficient and enjoyable.

What is the rationale for how the practice passages are sequenced?
Practice passages adhere to two important principles:

« Patterned words are repeated enough times to build up a rhythm and
fluency that then transfers to typing the word within a phrase or sentence
where it is not repeated.

 Passages progress from simpler to more complex phrase and sentence
patterns.

When the phrase and sentence patterning combines with the linguistic
patterning, student typing develops in an almost effortless manner.

Why aren’t my test scores updated when | retake an accuracy and speed
builder test in KeyWords?

After you take an accuracy and speed builder test for the first time, the results
of the test are logged automatically. The only way to replace a logged score is
to get a higher word-per-minute score. Fewer errors do not constitute an
improvement that causes the score to update; an improved words-per-minute
score is required.
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Control Panel is a SmartApplet that lets you define settings for your NEO.
v'»_ Control panel and

3@~ the keyboard You can also define many of these settings using keyboard shortcuts or
*" shortcuts are only through AlphaSmart Manager. (For more information about AlphaSmart
available when the NEO is Manager, see the AlphaSmart Manager 2 User Manual).

not connected to a computer.

How to Change Settings Using Control Panel

1. Press applets.

2. Use the arrow keys to move the cursor next to Control Panel. Then, press
enter.

3. Use the arrow keys to move the cursor next to the setting you want to
view or change; then, press enter.

select a Control Panel optiaon:

- Spel ICheck Settings...

- Alphakard =settings...

+ Chonge default SmartApplet font...

4. If you are changing spell check settings, enabling or disabling file
passwords, or disabling or enabling the calculator, you will be asked to
enter the master password. Type the password and press enter. (This
password is set in AlphaSmart Manager in the System settings; for more
information, see the AlphaSmart Manager 2 User Manual.)

Follow the instructions on the screen to change settings.

Press esc to return to the previous screen. You might need to press esc
several times to return to Control Panel or the SmartApplets menu.

D
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CONTROL PANEL
About the Settings in the Control Panel

You can change the following settings in Control Panel:

Where to Find More
Control Panel Setting What You Can Do Information
Spell Check Settings o Turn Spell Check on and off Page 7-3
« Turn the ability to add words to the user dictionary
on and off
» Delete the user dictionary
» Add a new word to the user dictionary
AlphaWord Settings » Turn show marks on and off in files Page 7-4
« Turn file passwords on and off
« Change a specific file password
» Reset all file passwords
Change Default SmartApplet « Sets the font size for SmartApplets on the NEO Page 7-6
Font
Turn Calculator On/Off « Turns Calculator on and off Page 7-8
Two-Button On Option + Sets whether two buttons are required to turn on Page 7-9
the NEO
Set Screen Contrast « Sets your screen lighter or darker Page 7-9
Keyboard Command « Lists keyboard commands for a variety of actions Page 7-10
Reference List on the NEO
View Keyboard Layout « Displays a representation of the current keyboard Page 7-11
layout
Display Battery Status  Shows how much battery power is left on the NEO Page 7-12
Change Keyboard Settings « Changes keyboard layout (QWERTY, Dvorak, Page 7-13
Right, or Left)
« Changes Slow Keys setting
« Turns Sticky Keys on and off
Search for Networks (NEO 2 » Allows you to find and select a different network (a Page 7-17
only) computer-Renaissance Receiver combination)
About NEO 2 (NEO 2 only)  Shows you NEO 2 information Page 7-18
Wireless Security (NEO 2 « Allows you to enter an encryption key if required Page 7-18
only) for communication

Update Text2Speech device
(NEO 2 only)

Lets you send updates to your Text2Speech device
if you have one within range of the NEO 2 IR port.

See the Text2Speech

User Manual.
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Spell Check Settings

To change Spell Check settings in Control Panel, you need to enter the master
password, which you can set using AlphaSmart Manager.

You can change these spell check settings:

« Turn Spell Check off and on. To change this setting, move the cursor
next to it and press enter. If spell check was on, it will turn off; if it was off,
this will turn it on again. When spell check is off and you attempt to use it
in AlphaWord Plus, the NEO will notify you that spell check is off.

+ Turn add words to user dictionary off and on. By changing this
setting, you are choosing whether users can add words to the user
dictionary while doing a spell check in AlphaWord Plus. If spell check finds
aword that isn’t in its dictionary, but the user knows that word is spelled
correctly, the user can usually press A to add that word to the user
dictionary so it isn’t marked as misspelled again in the future. If you have
turned off this ability, the user cannot add the word to the user dictionary.
To change the setting, simply move the cursor next to it and press enter to
change it from “on” to “off” or from “off” to “on.” Then, press any key to
leave the screen.

« Delete user dictionary. This setting deletes the user dictionary. Use
caution when selecting this setting; you can’t recover a user dictionary
that’s been deleted. (You can, however, send a new user dictionary to NEOs
using AlphaSmart Manager. See the AlphaSmart Manager 2 User Manual
for details.)

« Add new word to user dictionary. This setting lets you add words to
the user dictionary, one word at a time. To use it, move the cursor next to
the setting and press enter. Then, enter one word you want to add and
press enter; the NEO will notify you that the word has been added. Press
any key to leave the setting. Repeat these actions for each word you want to
add.

Note: If you have a big list of words you want to add, it’s more efficient to
create a text file of words and send it to your NEO using AlphaSmart
Manager.
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AlphaWord Settings

You can change the following AlphaWord settings:

Turn Show Marks in Files On or Off

v1»_ When you send text
P ). to your computer
and you have Show
Marks on, the arrows won’t
transfer to your computer, but
the tabs and returns will.

When “Show Marks” is on, as you write in AlphaWord Plus, you will see right
arrows where you insert tabs, and you’ll see return arrows when you press
enter.

Carriage return

FUMD-RAISING EFFORTS.
oz of April 15tha
Jan+ Feb+ Mar+ Apra
185 Tis B3 42

Tab

To change the setting, move the cursor next to the setting and press enter to
switch from “On” to “Off” or from “Off” to “On.”

You can also set Show Marks from within AlphaWord Plus by pressing
option-3-k, pressing 3 when the instruction screen appears, and then
pressing esc to exit the screen.

Turn File Passwords On or Off

N
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When you first receive your NEO, you cannot set a password for each file until
you turn file passwords on. You can do this using the Control Panel setting on
your NEO or using AlphaSmart Manager (see the AlphaSmart Manager 2
User Manual).

To turn file passwords on using the Control Panel AlphaWord settings, you
need the master password. (You can set the master password for NEOs using
AlphaSmart Manager. If you want to use the default master password, contact
Technical Support to get the password.)

If you turn file passwords on, whenever you press one of the file keys or open
a file, you will be asked to enter the file password. (If you don’t know the
individual file’s password, you can enter the master password instead.)
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To turn file passwords on, follow these steps:

1. From Control Panel, select AlphaWord settings, then select Turn File
Passwords On/Off, OR
From AlphaWord Plus, press ctrl-option-38-P.

The following message appears.

File possword protection is OFF
Type master password to turn on:

(Press esc key to exit)

2. Type the master password and press enter.

When you first turn file passwords on, the password for all files is write.

To change individual file passwords on the NEO, open a file and press
option-3-P. Then, type the current password for the file and enter the new
password twice. Press enter. The NEO will tell you that the password has
been changed. Press any key. You can also change file passwords in the
Control panel as described below.

In AlphaWord Plus, you can change the password for all files and set the new
default file password. Simply click the Settings tab in AlphaSmart Manager,
click AlphaWord Plus in the list on the left, and enter the password you
want to use in the File passwords field.

Passwords can be up to six characters long. They aren’t case-sensitive and can
contain letters, numbers, and symbols, but not spaces.

Change a Specific File Password

)
Sma IAPPLET' User Manual

When you have turned file passwords on as described above, you can use this
setting to change the password for an individual file. To start, move the cursor
next to this setting and press enter. Then, follow these steps:

1. Use the arrow keys next to the file that needs its password changed; then,
press enter. Files 1 through 8 are listed as F1, F2, and so on.
2. Type the current password for the file; then, type the new password twice.

Press enter. The NEO will notify you that the password has changed.
Press any key.



Reset All File Passwo

_utr_ You can set the
ABJ: master password for
' NEOsin AlphaSmart
Manager by changing the
system settings on the

Settings tab.

CONTROL PANEL
Change Default SmartApplet Font

rds

When you have turned file passwords on as described on page 7-4, you can
use this setting to reset the password to write for all AlphaWord Plus files (or
to the new default password you set in the “File Passwords” field in
AlphaSmart Manager). To start, move the cursor next to the setting and press
enter. Then, enter the master password. When the NEO notifies you that the
passwords have been reset, press any key.

Change Default SmartApplet Font

About Font Sizes

v1s_ If some font sizes
ABJ: are removed from
' your NEO using
AlphaSmart Manager, the
NEO defaults to the four-line

system font.

-
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You can change the onscreen font size that is used in AlphaWord Plus on your
NEO. (The font change also affects AlphaQuiz if you choose the System,
Small, Medium, or Large font; AlphaQuiz does not support the Very Large
and Extra Large fonts.) Changing the font size changes how text appears
onscreen, letting you work at a screen size that suits your needs. It doesn’t
change font attributes associated with the text, so when you send text to your
computer or printer, the text itself is plain text.

There are six font settings from which to choose:

+ System (four lines per screen using a fixed width font)
« Small (six lines per screen)

« Medium (five lines per screen)

« Large (four lines per screen)

+ Very large (three lines per screen)

 Extra large (two lines per screen)

When you change the font size, that change applies to all files and workspaces
in AlphaWord Plus.



Changing the Font Size

ts_ In AlphaSmart
ABJ: Manager, you can

* reset connected
NEOs to the system font
(four lines per screen). Click
the Settings tab, click
System on the left, and click
On behind Reset system
font to default. Then, send
the change to NEOs.
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Here are examples of the font sizes.

Extra large (two lines)

Very large (three lines)

Large (four lines)

Medium (five lines)

Small (six lines)

Tortoises, Turtles, and
Terrapins

Tortoises, Turtles, and
Terrapins
Do you know the

Tortoises, Turtles, and Terrapins

Do you know the differences hetueen these
three types of animals? Tortoises usually live
on land, turtles live in the sea, and

Tortoises, Turtles, and Terrapins

Do you know the dif ferences between these
three types of animals? Tortoises usually live
on land, turtles live in the seaq, and terropins
live in fresh water. All three types hove tough

Tortoises. Turtles, and Terrapins

Do you know the differences between these three types
of animals? Tortoises usually live on land, turtles live in
the seq, and terrapins live in fresh water. All three
types hawve tough bony shells and can be found in
termperate and tropical lands and oceans.

Follow these steps to change the font size:

1.

Do one of the following:

¢ Press ctrl-option-3-F.

¢ In the Control Panel, move the cursor next to Change default
SmartApplet font and press enter.

Use the arrow keys to move the cursor next to the font size you want to

use; then, press enter.

- System

Select a font, then press enter.

- Large (4 lines)
+ Medium (5 lines)

If you changed the font size with the keyboard command, you're returned to

the file where you were working. If you used Control Panel, you're returned to
the list of settings; press applets, then select AlphaWord Plus to view the
change in font size.
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How the System Font Differs from the Large Font

The four-line System font is slightly different from the Large font, which also
takes four lines per screen. The four-line System font is a “fixed-width” or
“monospace” font, and the four-line large font is a proportional font.

In fixed-width fonts like the system font, every character and space occupies
the exact same width. In proportionally spaced fonts like the large font, each
character occupies only the space it needs to display that particular character.
So, for example, an m character takes up more space than an i character.

This example shows the difference between the two fonts. Note the different
widths of the words “William,” “ill,” and “lollipop” in each illustration.

William licked a lolipop and became ill. His
Large fourine font mother, Priscilla, caled the doctor. The
(proportional) doctor adwised Wiliom o refrain from eating
any more  lolipops.

Williom licked a lollipop and became il1.
System four-line font His mother, Priscilla, called the doctor.
(fixed width) The doctor advised Williom to refrain from
eating any more lollipops.

Turn Calculator Off or On

xtr_ You need to enter

ABJ: the master

' password to turn the
calculator off or on. To set
the master password for
NEOs, in AlphaSmart
Manager, click the Settings
tab and click System on the
left. Enter a new master
password in the field provided
and send it to the NEOs.
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This setting allows you to disable or enable the calculator on NEOs. There
may be times when you don’t want Calculator to be available, such as when
students who have NEOs are doing math work. If you want to turn off
Calculator on just one NEO, follow the instructions below. If you want to turn
off Calculator for a group of NEOs using AlphaSmart Manager, see “Disabling
SmartApplets within AlphaSmart Manager” on page 1-5.

To Turn Calculator Off or On in This Control Panel Setting

1. In the list of Control Panel settings, move the cursor next to Turn
Calculator Off (or On) and press enter.

Enter the master password and press enter.

Press any key.
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To Turn Calculator Off or On in the SmartApplets Menu

1.
2,
3.

Press applets.
Move the cursor down next to Calculator.

Press ctrl-38-L. If the Calculator is on, this turns it off; if the Calculator is
off, this turns it on again. When the Calculator is disabled, you'll see [
next to it in the SmartApplets list.

To Turn Calculator Off or On While Using AlphaWord Plus

1.
2,

Press ctrl-&-C.

Type the master password and press enter.

Two-Button On Setting

+1r_ You can also enable

> the Two-Button On

' Option in

AlphaSmart Manager. To do
this, click the Settings tab,
click System on the left, scroll
down through the list on the
right to find “Two button on
mode,” and click the On
option. Then, send the change
to NEOs.

Normally, NEO turns on when you press the on/off button. If your NEO
often gets turned on accidentally, perhaps because the button is pressed when
you carry the NEO in a bag or backpack, you can enable the two-button on
option to require you to press on/off and enter together to turn NEO on.

Follow these steps to turn this option on or off:

1.

In the list of Control Panel settings, use the arrow keys to move the cursor
next to Two-button On option; then, press enter.

The next screen will tell you if the option is enabled (on) or disabled. If you
want to change the setting, press enter. If not, press esc.

Set Screen Contrast Setting
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The Set Screen Contrast setting lets you control how light and dark both the
screen background and the onscreen characters appear. This lets you
optimize the screen for your current lighting conditions.

To change the screen contrast, follow these steps:

1.

3.

In the list of Control Panel settings, use the arrow keys to move the cursor
next to Set screen contrast; then, press enter.

Use the arrow keys to change the contrast. Pressing the T key increases
the number and darkens the background; pressing the < key decreases
the number and lightens both the background and the text. The setting
ranges from 1 to 16.

Press esc when you're ready to exit the setting.
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Keyboard Command Reference List

N

This Control Panel option is actually a table of the keyboard commands or
shortcuts that you can use to perform actions on the NEO. Most commands
can also be accessed with menus, settings, or keys on the NEO, but the
keyboard commands may help you do the actions more quickly. The table

below lists the commands that you’ll find in this menu.

Keyboard
Action Command
Open help. 3-h or ctrl-H
Print. print or 3#-P

Open Printer Selection menu.

option-print

View clipboard status (number of pages in clipboard and
number available).

option-3-C

View clipboard status (number or characters in clipboard
and number available).

shift-ctrl-option-
#-C

View clipboard contents.

ctrl-option-3-C

Copy selected text to clipboard. #-Cor ctrl-C
Paste text from clipboard. #-Vor ctrl-V
Set the amount of time the NEO must be idle before it option-3-T

automatically shuts down.

Choose a keyboard layout (QWERTY, Dvorak, right one-
handed, or left one-handed). See page 7-11.

option-3-L (then
press 1 for
QWERTY, 2 for
Dvorak, 3 for Right,
or 4 for Left)

Set the cable transfer speed.

option-3-S (then
choose the number
next to the speed
you want)

Set the infrared (IrDA) transfer speed.

ctrl-option-3-S
(then choose 1 for

the fastest speed or 2
for compatibility
speed)

View the NEO system information and language, the option-¥#-V

current file number, the speed setting, the keyboard

layout, and settings for auto repeat, sticky keys, and

passwords.

7-10
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CONTROL PANEL
View Keyboard Layout Settings (Including Special Characters)

Action

Keyboard
Command

Disable or enable spell check. See page 7-3.

option-3-spell
check

View and set the auto repeat and sticky keys settings.

option-3-K

Disable or enable the calculator. See page 7-8.

ctrl-38-C

Disable or enable the slow keys setting.

ctrl-option-3-K

View battery charge/status.

ctrl-3-B

Lock or unlock the selected SmartApplet in the
SmartApplets menu.

ctrl-38-L

In the SmartApplet menu, make the selected SmartApplet
the one that starts when you turn the NEO on.

ctrl-applets

In the SmartApplet menu, view information about the
selected SmartApplet.

option-applets

View Keyboard Layout Settings (Including Special

Characters)

N

This option lets you view the keyboard layout that is currently selected. This
can be useful if you’ve chosen a layout other than the standard QWERTY
layout and you'’re not quite sure where keys are now located.

You can also use this option to view a second screen on how to enter these

commonly used special characters in AlphaWord Plus:

Note: ISO (European) keyboard layouts vary slightly from the following

illustrations, which depict ANSI (US) keyboards.

Sma IAPPLET' User Manual
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s Youcanview a list of
Z@: international
* characters and find

out how to type them by
pressing ctrl-H in AlphaWord
Plus and selecting
International from the help
topic list.

CONTROL PANEL
Display Battery Status Setting

1. In the Control Panel, use the arrow keys to move the cursor next to View

keyboard layout; then, press enter. The layout appears onscreen. (The
example shown is the standard QWERTY layout.)

1234567898 --=
quertyuiop [ ]H

asdfghjkl;’

zzcvbnm, ./

2. To see the characters you can type when the shift key is pressed, press

and hold shift.

3. To view some of the special characters available, press and hold option.

These are the keys you can type by holding the option key. Note their
location on the keyboard. (For example, to type the ™ character in
AlphaWord Plus, hold down option and press 2.)

INESCEERN ] ]
: Bf¥ el
aBffe ||
Dl N~

B

« Uption

4. To view more special characters, hold down both option and shift. (For

example, to enter ¢, in AlphaWord Plus, hold down the option and shift
keys and press ?.)

Display Battery Status Setting

N

SMArtAPPLET User Manual

To check the battery charge, move the cursor next to Display Battery
Status in the Control Panel list; then, press enter. The NEO will show you
the battery charge as a graphic and a percentage. Press any key to leave this
screen.

You can also press ctrl-38-B at any time to display the current battery charge.
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Change Keybhoar

_y.s_ Youcan also change
A@J: these settings in
AlphaSmart
Manager. When you click the

CONTROL PANEL
Change Keyboard Settings

d Settings

To choose the keyboard settings in the Control Panel, move the cursor next to
Change keyboard settings and press enter. Then, move the cursor next
to the option you want to change and press enter. You can change the
following:

Settings tab and click
System on the left, the
available settings that you can
change on the right will

include Sticky Keys, Keyboard
Layout and Slow Keys. It also
includes Auto Repeat.

Option Does This
Keyboard layouts Sets alternate keyboard layouts (see below)
Slow Keys Sets a time delay for holding down a key before the

character appears onscreen

Sticky Keys Sets whether you must hold keys down for keyboard
commands or whether you can press them sequentially

Change Keyboard Layout

)
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When you choose this setting, NEO gives you a choice of four different
keyboard layouts to provide for special needs or preferences:

+ QWERTY, the standard default layout of most keyboards and typewriters

» Dvorak, a scientifically-designed keyboard layout that requires much less
finger reaching and stretching for the most commonly used keys, and
results in faster and easier typing

« Right hand only, a layout that lets people with special needs type faster
« Left hand only, a layout that lets people with special needs type faster

When you switch keyboard layouts, all dialog boxes and keyboard commands
conform to the new layout. The command keys (ctrl, option, 38, for
example) remain in the same location, but letter keys are derived from the
new layout. For instance, to access the Speed menu, you still press option-
8-S, but the S key is in a different location.

Important: When you send text to your computer from your NEO using a
USB cable and send, the computer must use a QWERTY layout.

To change the keyboard layout, follow these steps:

1. Do one of the following:

* From the Control Panel, select Change Keyboard Settings, then
select Change Keyboard layout.

e From within a SmartApplet, press option-38-L.

7-13



_ The illustrations
P " shown in these
steps show ANSI
(US) keyboards. ISO
(European) keyboard layouts
vary slightly. If you have an
ISO keyboard and you want to
check key locations for
different specialized layouts,
use the Control Panel’s View
Keyboard Layout option (see
page 7-11).

N
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CONTROL PANEL
Change Keyboard Settings

2. Select a keyboard layout from the following choices:

Press 1 to select the QWERTY layout.

The standard QWERTY keyboard layout

Press 2 to select the Dvorak layout.

EECLE T EC R
-‘ml a i[l a3 l" mfy
=[]

-—

;
g

The Dvorak keyboard layout
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CONTROL PANEL
Change Keyboard Settings

Press 3 to select the right hand only layout.

The right one-handed keyboard layout

Press 4 to select the left hand only layout.

= TT] T nmm
aaaama

WH II

shift

The left one-handed keyboard layout

3. When the NEO notifies you that the keyboard layout has been changed,
press any key to continue. If you chose a layout other than QWERTY, the
next time you start the NEO, the startup screen will include the keyboard
layout you've chosen.

N
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CONTROL PANEL
Change Keyboard Settings

Change Slow Keys Setting

The Slow Keys setting lets you decide how long you must hold down a key
before the character appears onscreen. This setting is useful for someone who
has unsteady hands or difficulty targeting specific keys.

For example, if you set the Slow Keys option to one second, you would have to
press and hold down a character key for one entire second before that
character would appear. One second is probably too long a delay for many
users, but some fraction of a second might help alleviate inadvertent typing
for certain users.

To set the Slow Keys delay, follow these steps:

1. Do one of the following:

¢ From the Control Panel, select Change keyboard settings, then
select Change slow keys setting.

¢ From within a SmartApplet, press ctrl-option-3-K.

2. Toincrease the delay, press 7 to increase the amount of time you need to
hold down keys in increments of a tenth of a second. Press { to decrease
the delay.

3. Press enter to accept the change or press esc to exit the screen.

If the Slow Keys delay is greater than one second, the delay before keystrokes
is repeated (normally about one second) increases to match it. For example, if
the Slow Keys delay is set to 1.5 seconds, the delay before keys are repeated
increases to 1.5 seconds as well. This means that after pressing and holding a
key down, 1.5 seconds pass before the character appears, and after an
additional 1.5 seconds, the character begins to repeat.

Turn Sticky Keys On or Off

For some keyboard commands on NEO, you need to hold down several keys
at the same time. This may be difficult for some users. For those users, NEO
has a Sticky Keys setting that lets you type key combinations one key at a time
without holding down all the keys at once. So you could, for instance, press
option, then 3§, then S individually to get to the Send Speed menu, rather
than pressing all three keys as a group.

Sticky Keys affects these four keys: shift, option, 3, and ctrl. When Sticky
Keys is on, pressing one of these keys effectively keeps that key pressed down
for the next normal key press.

To turn the Sticky Keys option on or off in the Control Panel, select Change
keyboard settings, then select Turn sticky keys ON or Turn sticky
keys OFF and press enter.

)
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CONTROL PANEL
Search for Networks Setting (NEO 2 Only)

You can also set Sticky Keys from within AlphaWord Plus by following these
steps:

1. Press option-38-K.

2. Press 2 to turn Sticky Keys on or off.

3. Press esc to exit the screen and return to your work.

Auto Repeat and the Slow Keys Setting

s Youcanalso change

AR the Auto Repeat
' setting in

AlphaSmart Manager. When
you click the Settings tab and
click System on the left, the
available settings that you can
change on the right will
include Auto Repeat. Click On
or Off. Then, send the change
to NEOs.

Auto Repeat lets you set whether keys repeat when held down. Usually if you
press and hold a character key for an extended period of time, the letter
continually repeats itself across the screen. You can change this behavior so
that keys won’t repeat. This is helpful for beginning typists or for users who
have difficulty typing. For example, if you're administering an activity to a
group of users whose typing skills are at a beginning level, you can turn off
Auto Repeat so they aren’t penalized for holding down a key longer than
normal.

When Auto Repeat is on (the default setting), a character repeats when a key
is held down; when it’s off, only one character appears per keystroke.

Though the Auto Repeat setting is related to the Slow Keys setting, this
setting is not in the Control Panel. To turn Auto Repeat on or off while using
AlphaWord Plus, follow these steps:

1. Press option-38-K.

2. Press 1 to turn auto repeat on or off.

3. Press esc to exit the screen and return to your work.

Search for Networks Setting (NEO 2 Only)

)
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On NEO 2 models, when you use NEO 2 with a Renaissance Receiver, the first
network that you choose with NEO 2 is the one that is used by default the next
time you use the Responder SmartApplet or the Accelerated Reader
SmartApplet.

If you want to search for a different computer/Receiver combination
(network), move the cursor next to this setting in the Control Panel and press
enter. NEO 2 will find the Renaissance Receivers that are within range and
show you their names. Use the up and down arrow keys to highlight the new
Receiver you want to use. Then, press enter to connect to it.

717



CONTROL PANEL
About NEO 2 (NEO 2 Only)

About NEO 2 (NEO 2 Only)

On NEO 2 models, you can select this Control Panel setting to view
information about your laptop, including the system version and the version
of other items that are unique to NEO 2.

Wireless Security Setting (NEO 2 Only)

Use this setting to enter the encryption key if it is required for NEO 2 to
communicate with Renaissance Receivers. For more information, contact
Renaissance Learning.

)
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BEAMER

N
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Beamer is a SmartApplet that lets NEO send text wirelessly to and from
another NEO, a Dana, or a Palm OS device. Beamer uses IrDA technology to
transfer information in seconds, without the use of cables, cords, or networks.

ﬂm))))))))‘

Beaming between NEOs

>>))>>>>>>>-

Beaming from a NEO to a Palm OS device

‘m))))))))‘

Beaming from a Dana to a NEO

The Beamer SmartApplet is installed on your NEO when you receive it.



BEAMER
Beaming AlphaWord Plus Files between NEOs

Beaming AlphaWord Plus Files between NEOs

If you have the Beamer SmartApplet, you can follow the steps below to beam
AlphaWord Plus files from one NEO to another. You don’t have to be in the
Beamer SmartApplet itself; sending files right from AlphaWord Plus is the
fastest method.

Follow these steps to beam a file to another NEO within AlphaWord Plus:

1.

On the sending NEO, start AlphaWord Plus and go to the file you want to
send.

On the receiving NEO, start AlphaWord Plus and go to the file # that will
receive the data.

Place the NEOs within three feet of each other and aim their infrared ports
at each other as shown on the previous page.

On the sending NEO, press ctrl-send.
On the receiving NEO, press ctrl-B.

If the file that the receiving NEO chose was empty, the new file will be
received into it. If it contained text, choose whether to overwrite the text or
append the new data to the end of it.

Starting the Beamer SmartApplet

_uLs_ If Beamer is not
Z@: installed on your

NEO, see page 1-3 to 1.

install it.

2,

)
Sma IAPPLET' User Manual

To see the send and receive options within the SmartApplet, or to change the
settings, you can start the Beamer SmartApplet. Follow these steps:

Press onl/off to start your NEO, then press applets. The SmartApplets
menu appears.

Use the arrow keys to move your cursor next to Beamer. Then, press
enter.



BEAMER
Beaming from One NEO to Another from Within the Beamer SmartApplet

Beaming from One NEO to Another from Within the
Beamer SmartApplet

You can also beam files using commands within the Beamer SmartApplet as
uLs_ Make sure you have

-@.. used AlphaWord described below. However, since this procedure requires more steps, it’s
" Plus at least once on much easier to beam files from within AlphaWord Plus as described on
the device that will be page 8-2.

receiving the beam. This . .
initializes the program. You can send the files from NEO to NEO, from a NEO to an AS3000 with

System 3 software, or from an AS3000 to a NEO. Both devices must have
infrared ports and must be within three feet of each other.

Steps to Follow on the Sending Device

1. Make sure you know which AlphaWord or AlphaWord Plus file contains
the data you want to send.

2. Turn on the NEO by pressing on/off.
3. Press applets to view the SmartApplets menu.

4. Use the arrow keys to move the cursor next to Beamer in the list; then,
press enter. The Beamer screen appears.

Select a Beaming function:
- Send
- Receive

- Settings

5. On the NEO from which you want to beam, move the cursor next to Send
and press enter. (If Send is not available, the Beamer settings have been
changed so that beaming is not allowed; see page 8-10.)

After you choose Send, files that contain data appear in a list.

Select the file you want to send:
_w1s_ If you choose a file - File 1 (274 bytes)
3 ). thatis protected by - File 2 (992 bytes)
an individual .
password, you will be asked V File 6 (1433 bytes)

to enter that password before
you can send the file. You can 6. Select the file you want to send by doing one of the following:
enter the file password or the
master password. For more
on password protection, see
page 7-4. e Press the appropriate file # key along the top of the keyboard on the
device.

¢ Using the arrow keys, scroll through the list of files to move the cursor
next to the one you want; then, press enter.

)
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BEAMER
Beaming from One NEO to Another from Within the Beamer SmartApplet

7. Make sure the receiving device is turned on, that it is within three feet of
the beaming device, that it is ready to receive, and that both devices have
their infrared ports pointing at each other.

8. Press send on the sending NEO to start beaming the file.

Steps to Follow on the Receiving Device (If It Is a NEO):
1. Turn on the NEO by pressing on/off.
2. Press applets to view the SmartApplets menu.

3. Use the arrow keys to move the cursor next to Beamer in the list; then,
press enter. The Beamer screen appears.

Select a Beaming function:
- Send

- Receive

- Settings

Move the cursor next to Receive and press enter.

5. If there is data on the clipboard, the following screen appears:

There is data currently on the
clipboard. Press the enter key to
overwrite the data.

(Press esc key to cancel)

If there’s no data on the clipboard, or if NEO hasn’t been set to warn
about overwriting the clipboard (see “Beamer and the NEO Clipboard” on
page 8-6), the following screen appears:

Ready to receive a file.

(Press esc key to cancel)

)
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_Ls_ If you choose a file
ABJ: thatis protected by
" an individual

password, you will be asked
to enter that password before
you can receive text into the
file. You can enter the
password for the file or the
master password. For more
on password protection, see
page 7-4.

BEAMER
Beaming from One NEO to Another from Within the Beamer SmartApplet

Do one of the following to receive the file:

e Press enter if your NEO displayed the clipboard warning and you
want to overwrite the data.

* Press esc to cancel receiving the beam.

* If your NEO didn’t display a clipboard warning, go on to step 7.

Select a file where you want to store the beamed file, either by scrolling

the list and pressing enter, or by pressing one of the file # keys along the

top of the keyboard.

If you're in AlphaWord Plus, you can save to named files that aren’t in files

1-8, or save to a new file. If you choose either of these options, when you

start AlphaWord Plus, you'll have to open the file yourself. (AlphaWord

Plus automatically opens a beamed file if it's stored in files 1-8.)

Select a file to store the data to:
- File 1 (27 bytes)

- File 2 (667 bytes)

! File 3 (empty)

If the file you selected was empty, Beamer places the beamed file in the
empty file.

If the file wasn’t empty, choose whether to overwrite the existing file or to
append the new file to it.

File x is not empty. Choose one:
- Overwrite the file?
- Append to the file?

(Press esc key to exit)

The beamed data should now be in the file you specified on the NEO that
received the file. To view it, press applets and select AlphaWord Plus.
AlphaWord Plus automatically opens the file it received.

)
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BEAMER
Finding the Infrared Ports

Finding the Infrared Ports

Beamer can be used with devices that have infrared capabilities. Before you
begin, locate the infrared port on each device you’ll be using. On NEO, the
port is in the middle of the back of the device ).

You'll need to know where the port is on each device you're using so that you
can point the ports at each other when you beam.

On Palm OS devices such as the Dana, the port may be located along the side
or top. Consult the documentation that accompanied your product for more
information.

Beamer and the NEO Clipboard

Beamer uses the clipboard to receive data before placing it into a SmartApplet
such as AlphaWord Plus. If you already have data in the clipboard, Beamer
will warn you before receiving a beam. This gives you a chance to save the
data on the clipboard in another file before you agree to receive the beam.

For example, text that you have copied from AlphaWord Plus may be in the
clipboard, and you may not have copied it into another file yet. The warning
gives you the chance to do this before overwriting the clipboard with the
beamed information.

If you're beaming frequently, you might not want to be warned about
clipboard data each time. In this case, you would turn this setting off in the
Beamer settings (see page 8-10).

Beaming from a NEO to a Palm OS Device

You can beam AlphaWord Plus files to Palm OS devices, such as Dana or
Dana Wireless or typical hand-held Palm OS devices.

You can beam to AlphaWord on Dana or Dana Wireless, or you can beam
AlphaWord files to the Memo Pad program. Before following the step
below, use the Beamer settings to set whether the file will be sent
as an AlphaWord file or a Memo Pad file. See page 8-10.

)
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BEAMER
Beaming from a NEO to a Palm OS Device

To beam between a NEO and a Palm OS device, both devices must have
infrared ports and be within three feet of each other.

Follow the steps below to beam an AlphaWord file to a Palm OS device.

Steps to Follow on the NEO (the Sending Device)
1. Turn on both the NEO and the Palm OS device.
2. On the NEO, open the AlphaWord Plus file that you want to send.

3. Make sure the Palm OS device is within three feet of the NEO, and that
both devices have their infrared ports pointing at each other.

4. Press ctrl-send on the NEO. Beamer begins beaming the file to the Palm
OS device.

Steps to Follow on the Palm OS Device (Dana, Dana
Wireless, or a Handheld Device)

To receive the beamed file on your Palm OS device:

1. Make sure your Palm OS device is turned on and is within three feet of
the NEO, with its infrared port pointing at the NEO’s port.

2. On your Palm OS device, tap Yes in the Beam Status dialog box that

appears.

Do you want to accept Do you want to accept

“File 27 “File 27

into Applications ¥ into Memo Pad #

Category: ¥ Unfiled

This message appears when This message appears when
you beam an AlphaWord file to you beam a Memo Pad file to
a Palm OS device a Palm OS device

)
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BEAMER
Beaming from a Palm OS Device to a NEO

3. To view the transferred file, do one of the following, depending on the file
format:

* For AlphaWord, tap the Applications Launcher icon, then tap
AlphaWord. Tap the menu icon, then tap to select File, then Open. A
list of files appears. Tap the beamed file to open it in AlphaWord.

Eirds of Prey

Eald Eagles

Bald eagles are one of the most striking birds of prey. They have a wingspan of over seven feet, and
heir nests are the largest of all birds. Their appearance is considered powerful and majestic, so rmuch
o that many native American peoples considerad bald eagles to be sacred. Bald eagles are found
nly in MNorth America. Generally, they inhabit areas near water, such as seaceasts, large rivers, and
akes so that they can find feod Fish is the primary food of bald eagles, although they sometimes 2at

imals such as rabbits or sauimrels
i) Flain >

* For Memo Pad, beaming automatically launches Memo Pad and
displays the transferred file on the screen.

Memo 3073

Birds of Pre;

ald Eagles

ald egales ore one of the mest siriking birds of prey, They have g wingzpan of sver seven feet, and their nests are the largestof all

irds, Thelr appearance is congsidered power ful and rajestic, o much o that many native American peoples considered bald eagles to
B i thy habit 1 h 1z, | i

Beaming from a Palm OS Device to a NEO

You can beam particular text-based items from Palm OS devices to
AlphaWord Plus on a NEO. The types of items you can beam are based on
industry file formats. If the Palm OS application you want to beam from uses
one of the following file formats, you’ll be able to beam an item from it over to
AlphaWord Plus.

« Note or memo-like items (vNote format), including AlphaWord for Palm
OS devices

« Contact or address items (vCard 3.0)

« Event or date information (vCal 1.0 or iCalendar format)

D
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BEAMER

Beaming from a Palm OS Device to a NEO

Tlemo 2 of 2

STAFF MEETING 04 Mar 31

Aaenda;

- Welcome new hire Maya Blaine

STAFF MEETING 04 Mar 31

oo Budget report

o= Report on action items from last staff meeting

oo Status on review cycle

Unﬂled‘
Agenda:

oo Mew business?

-- Welcome new hire Maya Blaine

-- Budget report

-- Report on action items from last
staff meeting

A memo item from a Palm OS device
(Dana) beamed to a NEO

-- Status on review cycle
-- New business?

Maya Blaine
Research specialist
AlphaSmart, Inc. Maya Blaine
Work: 208-555-1234 Research specialist
E-mail:  maya@mayablaine.com AlphaSmart, Inc.
Work: 408-555-1234
Email: maya@mayablaine.com

An address item from a Palm OS
device beamed to a NEO

A [T WM

- EEEE

An event item from a Palm OS device
beamed to a NEO

Event: Lunch w/ team at Salads &
Spuds

Start Date and Time: April 2, 2004 at
12:00:00PM

End Date and Time:
1:00:00PM

Note: Bring conference photos to
share

April 2, 2004 at

Important: You should be familiar with how to beam items from your Palm
OS device and its applications. Consult the documentation that came with
your Palm OS device for complete information.
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BEAMER
Cancelling a Beam

Follow these steps to beam from a Palm OS device to a NEO:

1. Turn on the Palm OS device and from the Applications Launcher, start the
application that contains the item you want to send.

2. Turn on the NEO and open the file that you want to receive text into.
3. Make sure both devices are within three feet of each other and that the
infrared ports are facing each other.

4. On the Palm OS device, locate the item you want to send, tap the
appropriate area on the screen to activate the menus, and choose the
beaming option you want. The Palm OS device starts beaming the item
you specified.

On the NEO, press ctrl-B.

If the file you selected is empty, Beamer places the beamed file in the
empty file.

If the file isn’t empty, choose whether to overwrite the existing file or to
append the new file to it.

File x is not empty. Choose one:
- Overwrite the file?
- Append to the file?

(Press esc key to exit)

The beamed data should now be in the file you specified on the NEO.

Cancelling a Beam

At any time, from any device, you can press esc to cancel either beaming or
receiving a file.

Changing Beamer Settings
The Beamer settings allow you to customize how the program works. You can
change these settings:
+ Choose whether to permit the NEO to send

» Choose whether NEO warns you if receiving data will overwrite what’s on
the clipboard

)
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s Youcanalso change
ARJ: Beamer settings
using AlphaSmart

Manager. Click the Settings
tab and click Beamer in the
list on the left; then, make your
setting changes. Be sure to
send them from the Send List
tab. This is the most efficient
way to change Beamer
settings for several NEOs
connected to your computer in
a SmartOption Mobile Lab.

N

BEAMER
Changing Beamer Settings

+ Choose whether to send to Palm OS devices in AlphaWord or Memo Pad
file format

« Choose whether to require a master password to change Beamer settings
on this NEO

If you're an individual user using Beamer, you probably won’t need to change
your settings very often. If you're using several NEOs and Palm OS devices in
a group setting such as a classroom, you might want more control over who
can beam data and how.

Follow these steps to change Beamer settings:

1. On your NEO, press applets.

2. Use the arrow keys to move the cursor next to Beamer in the list; then,
press enter. The Beamer screen appears.

Select a Beaming function:
- Send

- Receive

- Settings

3. Move the cursor next to Settings and press enter.

Move the cursor next to the setting you want to change and press enter.
Since each setting has only two options, pressing enter automatically
chooses the option that isn’t currently selected.

For example, if you move the cursor next to “Permit Send: YES” and
press enter, the setting will change to “Permit Send: NO.”

There are four Beamer settings:

¢ Permit Send determines whether this NEO is allowed to beam to
other devices. You can choose “Yes” or “No.” If you choose “No,” the
Send option is not available on the Beamer screen. This setting is
useful if you don’t want students to beam files to each other.

e Warn if overwriting clipboard affects what happens when you are
receiving a file beamed from another device and you already have
something in your NEO clipboard. If this is set to “Yes,” NEO will ask if
you want to overwrite the clipboard before receiving the file.

* Send to Palm device as ALPHAWORD file or MEMO file
determines the format in which AlphaWord Plus files are sent to Palm
devices (such as Dana). You can send files in AlphaWord format or
Memo Pad format. Most Palm OS devices have the Memo Pad
program; AlphaWord is included on Dana and Dana Wireless devices.
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st The master
“ABJ: password can be set
' using AlphaSmart
Manager. With your NEO(s)
connected, simply click the
Settings tab, click System on
the left, and scroll down to find
the master password setting.
Then, enter a new password.

Troubleshooting

BEAMER
Troubleshooting

* Require master password determines whether the NEO user must
enter a master password after choosing “Settings” in Beamer. If this is
set to No, a password is not required to change the settings. If it is set
to Yes, you must enter the master password after you choose
“Settings.” It is a good idea to require the master password if you have
set Permit Send to “No” so that students can’t beam files to each
other.

This section contains solutions for some issues you may encounter while
using Beamer.

| want to change a setting, but | don’t know the master password.

See the AlphaSmart Manager User Manual for information about changing

the master password, or call Technical Support to get the default password.

| don’t see the Send option on my Beamer screen.

If the device has been set to prohibit beaming (see page 8-10), the Send
option won’t appear on the beaming screen.

My NEO says it can’t find a receiving device.

N
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Bring the receiving device closer, make sure the infrared ports are pointing
toward each other, and make sure the receiving device is in the proper mode
to accept a beam. For Palm OS devices, you usually don’t have to do anything.
For NEOs, you have to set up the NEO so that it’s ready to receive the beam by
pressing a keyboard command or selecting an option as described earlier in
this chapter.
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I received an error when | tried to beam or receive a file.

You might receive an error if the transfer process was interrupted. There are a
few reasons why this might happen. For example, the person receiving the
beam might have cancelled the transfer before the beam was complete. Or,
users might have moved the devices being used, causing the infrared ports to
move out of alignment before the beam was complete. Try beaming the file
again.

| have data on the clipboard that | don’t want to lose. What should | do?

If you're about to receive a beam, press esc to cancel receiving it. Then paste
the data in the clipboard into an AlphaWord Plus file. When you're ready to
receive the beam, press enter to overwrite the data on the clipboard. Be sure
that you don’t select the AlphaWord Plus file where you pasted the data as the
file to receive the beam. You can also choose to append the data rather than
overwrite it. (Appending adds the data to the end of the file.)

| keep getting an invalid password message.

If the file you are sending is password-protected, you need to know the exact
password associated with that file in order to beam it. If you are receiving a
file, and your NEO’s files are password-protected, you must know the exact
password for the receiving file to receive it.

If you don’t know the file password(s), you can enter the master password
instead. You can find out more about file passwords (including disabling
them for a NEO) and master passwords on page 7-4 or in the AlphaSmart
Manager User Manual.

| beamed a file with a password, but now that file doesn’t have a password
on the receiving device.

If the sending device uses file passwords, but the receiving device doesn’t, the
password associated with the file being beamed isn’t sent.

What does the message “could not find a sending device” mean?

It means that Beamer on the NEO is ready to receive a beam from another
device, but it is not sensing any device that is sending anything.

)
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What do | do if the file I'm receiving is too big?

The device receiving the beam will accept as much data as it can and truncate
the file at the point where it can’t receive any more. To work around this, the
person beaming the file should break up the file into separate files and beam
them separately.

My friend beamed an AlphaWord Plus file to me, but Beamer didn’t let me

choose a file to put it
happened?

)
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in. It automatically put it in a new file. What

What likely happened is that AlphaWord Plus on your NEO hadn’t been
“initialized,” meaning it hadn’t set itself up yet to receive beamed files. This
can happen if you have a brand new NEO, or if you have a new installation of
AlphaWord Plus on a NEO, and you started Beamer before ever starting up
AlphaWord Plus.

All you need to do to initialize AlphaWord Plus is to start it. Do this before
you use Beamer again, and Beamer should give you the opportunity to choose
a file the next time it’s receiving a file.



ALPHAQUIZ

The AlphaQuiz SmartApplet allows students to take quizzes on their NEOs.
You can use the QuizDesigner program on your computer to create the quiz;
then, you can use the QuizManager program to send quizzes to NEOs and
receive and score their answers for automatic grading and reporting.

Quizzes can include true/false, multiple-choice, short answer, and essay
questions. They can also include assessment module questions if you
purchase an AlphaQuiz Curriculum Assessment Module.

AlphaQuiz is preinstalled on NEO 1 laptops, but not NEO 2 laptops. For
NEO 2, you can install AlphaQuiz from AlphaSmart Manager, and you can
download the QuizManager and QuizDesigner programs as part of the
AlphaQuiz suite from our Web site.

How AlphaQuiz Works

)
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1. The teacher uses QuizDesigner to create a quiz on his or her computer.
2. The teacher connects the computer to NEOs using one of these methods:

¢ Connect the computer to a SmartOption Mobile Lab so you can send
the quiz to several NEOs at the same time.

* Connect the computer to individual NEOs one by one using a USB
cable.

3. The teacher sends the quiz to the student NEOs using QuizManager.
Students take the quiz on their NEOs in the AlphaQuiz SmartApplet.

5. Students connect their NEOs to the SmartOption Mobile Lab, or they
connect them to the computer one by one using a USB cable.

6. The teacher retrieves quiz responses into his or her computer using
QuizManager, which automatically grades true/false, multiple-choice, and
short answer questions. (Short Answer questions may not be graded
automatically if you didn’t enter answers when you created the quiz.)

7. The teacher grades any questions that were not graded automatically and
enters scores for those questions in QuizManager.

8. The teacher prints a Corrected Quiz Report for each student. The teacher
can also print a Quiz Summary and Statistics Report for his or her own
records.
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Programs You’ll Use with AlphaQuiz

When you use AlphaQuiz, you actually use three programs:

Program Purpose

AlphaQuiz SmartApplet Students use this SmartApplet on the NEO to take the
quizzes that you have created and sent to NEOs.

QuizDesigner Teachers use this program on a computer to create
quizzes that their students can take in AlphaQuiz. You
must install this program on your computer; see the
next section.

QuizManager Teachers use this program on a computer to send
quizzes to NEOs and to receive student responses for
grading. You must install this program on your
computer; see the next section.

Installing QuizDesigner and QuizManager

. The AlphaQuiz SmartApplet comes installed on your NEO, but to create and
s If AlphaQuiz is not . . . . .
N . send quizzes and retrieve answers, you must install the QuizDesigner and
ARJ: installed on your

* NEO, it may have QuizManager on your computer. Follow the steps for your operating system.

been removed by another
user. To install it again, see
page 1-3.

System Requirements for QuizManager and QuizDesigner

Before you download and install these programs, make sure your computer
meets the NEO system requirements on www.renlearn.com/requirements,/.

Windows Instructions for Installing QuizDesigner and QuizManager

1. If you have an AlphaSmart Manager CD, insert it into your computer,
open the AlphaQuiz folder on the CD, and double-click QuizDesigner
Setup.exe.

If you downloaded the AlphaQuiz SmartApplet system from our Web site,
extract the files. Then, double-click QuizDesigner Setup.exe.

After the setup has been prepared, the QuizDesigner installation Wizard
will appear.

2. Click Next > in the Welcome panel of the Wizard.

)
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Installing QuizDesigner and QuizManager

3. Read the license agreement. (If you prefer to read a printed copy, click
Print to print it.) Then, click | accept the terms of the license
agreement and click Next >.

4. Atfter reviewing the installation location, click Next >.

Click Install. The program will be installed.
6. The computer needs to be restarted after installation. Decide whether to

restart your computer now or later and click the corresponding option;
then, click Finish.

QuizDesigner - InstallShield Wizard

InstallShield Wizard Complete

The InztallShield Wizard has successfully installed
QuizDesigner. Before you can uge the program, you must
restart wour computer,

() Yes, | want to restart my computer now.
(O No, | will restart my computer later.

Remove any disks from their drives, and then click Finish to
complete setup.

7. Now that QuizDesigner is installed, you need to install QuizManager.
Back in the AlphaQuiz folder or the folder where you extracted the files,
double-click QuizManager Setup.exe.

8. When the installation Wizard appears, click Next > in the Welcome panel.

9. Read the license. (If you prefer a printed copy, click Print.) Then, click |
accept the terms of the license agreement and click Next >.

10. Click Install. The program will be installed.
11. Click one of the restart options. Then, click Finish.

)
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Macintosh Instructions for Installing QuizDesigner and QuizManager

i - stall 1. If you have an AlphaSmart Manager CD, insert it into your computer,
G- QL{;‘;ZZ;M, first open the AlphaQuiz folder on the CD, and double-click QuizManager

the installer will notify Installer first.

you that QuizManager is not If you downloaded the AlphaQuiz SmartApplet system from our Web site,

Installed. You can stil install extract the files. Then, double-click QuizManager Installer.
QuizDesigner, but to avoid

this message, install 2. Click Continue in the QuizManager Installer screen.
QuizManager first.

d

Read the QuizManager license agreement. (If you prefer to print or save a
copy, click Print or Save As.) Then, click Accept. The program will be
installed.

Click Quit when the installation is finished.
Double-click QuizDesigner Installer.
Click Continue in the QuizDesigner Installer screen.

N o o M

Read the license agreement. (If you prefer to print or save a copy, click
Print or Save As.) Then, click Accept. The program will be installed.

8. Click Quit when the installation is finished.

Starting QuizDesigner

Once you've installed QuizDesigner, you can start the program so that you
can begin creating quizzes.

On Windows Computers:

Click Start » Programs » AlphaSmart » QuizDesigner »
QuizDesigner.

On Macintosh Computers:

Open the Applications folder, then the QuizDesigner folder. Double-click
QuizDesigner.

)
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About the Options in QuizDesigner

QuizDesigner is the program you use to create the quizzes that students will
take in AlphaQuiz on the NEO. Once you’ve installed QuizDesigner, you can
use it to create or change quizzes and print them as needed.

You can create quizzes on almost any subject, and your quizzes can be short
or long, simple or complex, for students at any level. You can reuse the
quizzes you create for multiple classes, revise them, and share them with
other teachers.

In QuizDesigner, you can create quizzes with these question types:
+ True/false

+ Multiple-choice

« Short answer (up to 18 characters)

+ Essay (with the maximum number of words you set)

+ Assessment module (if you have purchased and installed an AlphaQuiz
Curriculum Assessment Module)

You can also place these restrictions on how students use their NEOs during a
quiz:

 Prevent students from using the Calculator SmartApplet.
 Prevent students from using the NEO’s spell check feature.

+ Require the use of an access password and student passwords to maintain
test security and to make sure that only assigned students take the quiz.

Creating Quizzes in QuizDesigner

Follow these steps to create a quiz in QuizDesigner:

1. Start QuizDesigner (see page 9-4). The Quiz Options window will appear
with the Basic tab selected.

Note: If you are already in QuizDesigner and you want to start a new quiz,
click [ (Windows), or click the File menu and choose New (Windows)
or New Quiz (Macintosh).

)
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{2 Quiz Options El
E%IAdvamed] F’rompts]

Quiz Mame |Ciw| et Quiz

Quiz Author |T F

AdminPassword  |owga2

Authar Comments

Based on textback chapter reading.

(n] 4 | Cancel ‘ Help ‘

2. On the Basic tab @), enter a name for the quiz, the author’s name, a

7 The Admin password for making changes to the quiz (1-6 characters), and any

E@: Password for the

quiz helps make the comments that may be helpful to you. Be sure to choose a quiz name that
quiz more secure by will make the quiz easy for students to identify.
ensuring that only you can 3. Click the Advanced tab and make changes as needed (see the

change the quiz or see the
answers. It also prevents
unauthorized removal of a
quiz froma NEO. You can also
substitute this password
during student login.

information on the next page).
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o

e

G Quiz Options
Basic Advanced l Prompts]

AlphaSmart Options

ALPHAQUIZ

Creating Quizzes in QuizDesigner

Iv Require students to mark quiz as finishede
I¥ Block access to all other SmartApplets during quiz 0
™ Block access to Calculator Smarkspplet during quiz o
™ Block access to Spell Check in Alphatw/ord during quiz G

G Iv Require students to enter quiz access password hella

0 ™ Require students to create a student passward for their quiz answers
0 Iv Require students to enter a class number for their quiz answers
o v Allow students to export their quiz answers to an Alphavword file

o v Allow students to print their quiz answers from the AlphaSmart

=]

Cancel | Help |

This requires students to mark
the quiz finished. It also prevents
students from changing their
answers after they finish a quiz.
The three boxes below this one
are available only if you check
this box.

This prevents students from
using anything other than
AlphaQuiz on the NEO during a
quiz.

This prevents students from
using the Calculator on NEO
during a quiz.

This prevents students from
using NEO'’s spell check feature
during a quiz.

This requires students to enter
the password that you specify at
the beginning of a quiz. This

ensures that only authorized
students can take the quiz and
see the questions. The default
password is “hello,” but you
should use a unique password
for each quiz.

This requires students to create
their own passwords so that
other students can’t see their
quiz answers.

This requires students to enter a
class number so that
QuizManager can group student
responses by class.

This lets students send the quiz
to a read-only AlphaWord Plus
file.

This lets students print the quiz
questions and answers.



sty On Windows

3@: computers, you can
* click the button for

the question type (TF, M, SA,

or E) on the toolbar instead of

clicking Add Question and

then choosing the question

type.

)
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Creating Quizzes in QuizDesigner

ALPHAQUIZ

4. Click the Prompts tab and make changes to the instructions that appear
on the quiz. You can change the prompt for each type of question, or click
Defaults to go back to the default prompts shown here.

€2 Quiz Options
Basic I Advarced Prompts ]

True/false prompt (31 characters max)

[T ar F

Multiple choice, one answer prompt (21 characters max]

|Se\ect 1

Multiple choice, multiple answers (23 characters max)

|Se\ect all that apply

Shart anewer prompt [13 characters max]

|Shu|| Angwer.

Essay prompt (31 characters max)

|Essay, press tab to answer:

Defaults

3

Ok Cancel

Help

5. Click OK to save the quiz options. (If you decide to change them later, just

click Quiz Options to see the options again.)

6. Next, you'll see an empty window that has the name of your quiz in the

title bar. Click Add Question @.

5 Civil War Quiz

Quiz Questions

Mumber Tvpe Question Text

OQuiz Options ‘ "B dd fueston

Help

Ruiz Capacity




sLr_ Remarks aren’t
AR visible to students
during the quiz. You

can use them for reminders,
comments, or references that
pertain to the question, and
you can include them on
students’ Corrected Quiz
Reports ifthe information may
be useful to students (see
page 9-44).

N
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Click the type of question you want to add and click OK.

Enter the required information for the question:

True/False: Enter the statement, click True or False, and enter any

remarks.

Multiple Choice: Enter the question and each possible answer, and
check the box next to the correct answer(s). You can also enter

remarks.

Short Answer: Enter the
question text. If you wish,
you can also enter the
correct answer or answers
so that the computer can
check the student’s answer
against yours @. If there is
more than one correct
answer, separate them with
commas. Each answer can
be up to 18 characters long.
If you enter the correct
answer, be sure to click one
of the options to choose
whether the answers are
case sensitive or whether
you would like to accept
only numbers and a hyphen
in student answers . (If

(2 Short Answer Question

Question Text

X

Answer

Only supply an answer if you want the computer to automatically
check the student's answer.

Separate multiple corect answers with commas.

Each anzwer is limited ta 18 characters in length,

0

" Case sensitive [George is not qual to george)
' Case insensitive [George it equal ko george] m
 Only rurmbers For student input [0-9, ™ and .

Question Remarks

o]

Cancel | Help

you choose “Case sensitive,” student answers must match the case
you used in order to be considered correct.) You can also enter

remarks as needed.

Essay: Enter the question text, the maximum number of words

allowed, and any remarks.




9.

10.

xts_ When you save a
Z@: quiz you’ve saved

before, the program
may remind you that ifthe quiz
has already been loaded on
student NEOs, you should use
Save As and use a new file
name if you still want to
retrieve students’ answers to
the original quiz. If you want to
continue saving anyway, click
Save. Then, click OK to verify
that you want to overwrite the
old quiz.

Click OK to finish adding the
question. As you add questions,
watch the Quiz Capacity bar at the
bottom of the window ). Since the
file size of each quiz is limited, this
shows how much of the size is still
available based on the questions
you've entered so far.

When you've finished creating the
quiz, click [§g in the toolbar
(Windows) or click the File menu
and choose Save (Windows or
Macintosh). Then, do one of the
following:

* If you haven’t saved the quiz
before, in the dialog box that
appears, choose where to save
the quiz and click Save.

E Civil War Quiz.qzz

Quiz Questions

ALPHAQUIZ
Opening and Changing Quizzes in QuizDesigner

EIBIX

Humber

1 True/False

2 Multiple Choice
3 Short Answer
4

Type

Eszap

Question Text

The: first battle of the Civil \War...
“when did Abraham Lincoln is...
“what was the name of the wo...
w'hy did the southemn states ...

Guiz Dptions | i Add Question

Help

Duiz Capacity [T m

¢ If you have saved the quiz before, click Save to save the new version.

* If you want to save the quiz under a new name (as a new version),

click Save As, choose where to save the quiz, and click Save.

Opening and Changing Quizzes in QuizDesigner

Once you've created and saved a quiz, you can change it at any time. This is
useful when you want to adapt quizzes for different classes.

Opening an Existing Quiz

Follow these steps to open a quiz that you have saved and closed.

Opening Quizzes on Windows Computers

Click 2 in the toolbar or click the File menu and choose Open. Then, go to
the folder where you saved the quiz, click the quiz name, and click Open.

Opening Quizzes on Macintosh Computers

Click the File menu and choose Open Quiz. Then, go to the folder where you
saved the quiz, click the quiz name, and click Open.

)
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Changing an Existing Quiz’s Questions

1. Open the quiz (see page 9-10).
2. Do one of the following:
» Double-click the quiz question in the list €).

| Civil War Quiz.qzz

Quiz Questions

Mumber Type Question Text
1 True/False The first battle of the Civil War...
2 Multiple Choice ‘When did Abraham Lincoln is...
3 Short Answeer ‘what was the name of the wo...
4 Essay ‘Why did the southem states ..

Quiz Options | | Add uestion Help
Quiz Capacity [N

¢ Click the question once in the list 0 Then, click the Question menu
and choose Edit Question.

9] OGN Window  Help
Add TruefFalse... Chrl+T

Add Multiple Choice, .. Chrl+HM
Add Short Answer... Chri+B
Add Essay. .. Chri+E

Remove Questiunt!

Shuffle Question Order

Show Alphasmart Yiew,

3. Make changes to the question as needed. When you've finished, click
OK.

4. Save the quiz.
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Changing Quiz Options for an Existing Quiz

1. Open the quiz (see page 9-10).
2. Click Quiz Options @) toward the bottom of the quiz window.

B Civil War Quiz.qzz

Quiz Questions

Mumber Type Question Text
1 TiueFalse The first battle: of the Civil War
2 Multiple Choice “When did Abraharn Lincoln is.
3 Shart Answwer ‘wéhat was the name of the wo.
4 Essay “Why did the southemn states |

(]

Quiz Options | {"Add leshion Heln

Quiz Capacity [N

3. Click the tab where you want to make changes @ (Basic, Advanced, or
Prompts) and make changes as needed. Click OK when you’ve finished
your changes.

€ Quiz QOptions El

Basic ] Advanced ] Frompts ,G

Guiz Name ‘Cwil “wiar Quiz

Quiz Author ‘T P

Admin Passward cugd2

Author Comments

Based on textbook chapter reading.

oK Cancel Help

4. Save the quiz.
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Rearranging Quiz Questions in QuizDesigner

1.

Open the quiz (see page 9-10).

2. Do one of the following:

* If you want to rearrange questions into a specific sequence, drag the
questions one by one to the new position in the list. All questions will

automatically be renumbered.

e If you want QuizDesigner to randomly
rearrange the questions, click the
Question menu and choose Shuffle
Question Order. If you change your
mind after shuffling the questions, you
can click the Edit menu and Undo,
but this only undoes the change if you
do it right after shuffling the order.

3. Save the quiz.

Deleting Quiz Questions
1.

Open the quiz (see page 9-10).

Window Help
Add TruefFalse. .. Chrl+T
Add Multiple Choice. .. ChrHM
Add Short Answer. ., Chr+B
Add Essay... ChrHE

Show AlphaSmart Wiew...

2. Click the question that you want to delete so that it is highlighted €)).

)
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B Weather Quiz

Quiz Questions

Number Type Question Text

1 True/False
2 True/False

3 True/False

4 Multiple Choice
5 Multiple Choice
B Multiple Choice
7 Short Arewer
g Short Arewer

High puffy white clouds are called cumul...
Clouds are made up of bilions of air dropl...

The world's coldest climates can be foun...

Wwhich of the following is NOT a seasonc...
Rain is a form of:

Wwhen sunlight shines on raindrops inthe ..

what type of clouds tend to spread out in...
In the Pacific Dcean, powerful stoms are..

Quiz Capacity I

| ue/False
13 True/False Precipitation is caused by warm, moist air ...
14 Essay Describe the different types of clouds,
Quiz Dptiohs Add Question Help




-

v1s_ If you accidentally
P 2. delete a question,
press ctrl-Z
(Windows) or #-Z
(Macintosh) immediately to
restore it.

Copying Questio

ALPHAQUIZ
Copying Questions in QuizDesigner

3. Do one of the following:

* Press the Delete key on your computer keyboard, or

¢ Click the Question menu and choose Remove Question.
4. Save the quiz.

ns in QuizDesigner

Copying Questions within a Quiz

To copy a question within a quiz, click the question in the Quedion window A
quiz window. Then, click the Edit menu and choose
Duplicate. This creates an exact copy of the question just
below the original question. This command can help you
save time if you have questions with similar wording—you Bty
can just edit the text of the copy to quickly create a new question.

Chrl+

Chrl4+C

Copying Questions from One Quiz to Another

)
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By following these steps, you can copy a question from one quiz into another.
This can save you time if you use similar questions in different quizzes.

1. Open the two quizzes so that they are side by side in Quiz Designer. (On
Windows computers only, you can click the Window menu and choose
Tile Quiz Windows to line them up quickly.)
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2. Drag the question from one quiz window to the other. The question will be
copied into the new quiz, and it will remain in the original quiz.

l'.—i QuizDesigner, - Review Quiz.qzz
File Edit Question ‘Window Help

ODeEE|TF MSsE

(] @ | Review Quiz.qzz

Quiz Questions HQuiz Questions

Mumber Type Question Text Mumber Type Question Text
True/False High puify white clouds are called cumula... 1 Multiple Choice How long does it take for the Earth o ot
True/False Clouds are made wp of bilionz of air dropl... 2 True/False D ay and night are caused by the Earth's ..
True/False The world's coldest climates can be foun... E: )
Multiple Choice ‘Which of the following is HOT a seasonc...
Multiple Choice Rain iz a form of:
Multiple Choice ‘When sunlight shines on raindiops in the ...
Short Answer ‘What type of clouds tend to spread out in...
Short Answer In the Pacific Dcean, powerful stomms are...
Essay Explain the states of the water cycle.
Essay The Earth has six main types of climates. ...
Essay ‘Why do big cilies often have a climate th...
True/False The world's warmest climate can be foun...
True/False Precipitation is caused by warm, moist air ...
Essay Describe the different types of clouds.,

Ouiz Options Add Question Quiz Options Ldd Question

Quiz Capacity I Quiz Capacity I

3. Be sure to save the quiz that now has a new question when you have
finished working on that quiz.

N
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Password Requirements for Quizzes

In the Quiz Options for any quiz, on the Advanced tab, you can choose to
require students to enter a quiz access password. You can also require them to
create their own student password for quiz answers. The table below explains
how each of these passwords is used.

When the Student Enters Protection It How to Require This
Password Type or Creates the Password Offers Password
Quiz Access When a student first opens  Only those In the Advanced Quiz
Password the quiz, the student must students who Options, check the box
enter this password. have the quiz labeled Require students
access password to enter quiz access
can open that password and type the
quiz. password you want students
to use.
Student Password  After the student types in This password In the Advanced Quiz
his or her first and last prevents other Options, check the box
name, the student must students from labeled Require students
create a password. seeing a student’s  to create a student
quiz responses. password for their quiz
answers.

KeyBoard Shortcuts in QuizDesigner

The following keyboard shortcuts give you a quick way to perform many of
the tasks in QuizDesigner. The table below also includes the equivalent menu

commands.
Action Keyboard Shortcut Equivalent Menu ltem
Start a new quiz. Ctrl-N (Windows) File » New (Windows)*
88-N (Macintosh) File » New Quiz (Macintosh)
*On Windows computers, you can
also click [ in the toolbar.
Open a saved quiz. Ctrl-O (Windows) File » Open (Windows)*
$8-0 (Macintosh) File » Open Quiz (Macintosh)
*0On Windows computers, you can
also click & in the toolbar.
Close a quiz. None (Windows) File » Close (both Windows and

38-W (Macintosh) Macintosh)

)
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KeyBoard Shortcuts in QuizDesigner

Action

Save a file.

Keyboard Shortcut

Ctrl-S (Windows)
38-S (Macintosh)

Equivalent Menu ltem

File » Save (both Windows and

Macintosh)

On Windows computers, you can

also click [§g in the toolbar.

Save As.

None

File » Save As (both Windows

and Macintosh)

Macintosh also has a Save As

Quiz Library item in this menu.
On Windows computers, you can

choose the quiz library file type

after you choose Save As.

Open/edit Quiz Options.

Ctrl-I (Windows)
-1 (Macintosh)

File » Quiz Options (both

Windows and Macintosh)

Export a quiz in text None File » Export (both Windows
format. and Macintosh)
Set print or page setup. None File » Print Setup (Windows)

File » Page Setup (Macintosh)

Print a quiz.

Ctrl-P (Windows)
$-P (Macintosh)

File » Print (both Windows and

Macintosh)

Close QuizDesigner.

None (Windows)
$8-Q (Macintosh)

File » Exit (Windows)

QuizDesigner » Quit

QuizDesigner (Macintosh OS 10)

Undo last action.

Ctrl-Z (Windows)
38-Z (Macintosh)

Edit » Undo (both Windows and

Macintosh). The menu item

includes a description of what you

can undo.
Cut selected text. Ctrl-X (Windows) Edit » Cut (both Windows and
38-X (Macintosh) Macintosh)
Copy selected text. Ctrl-C (Windows) Edit » Copy (both Windows and
38-C (Macintosh) Macintosh)
Paste text that you have Ctrl-V (Windows) Edit » Paste (both Windows and

cut or copied.

8-V (Macintosh)

Macintosh)

Clear all text in the field
your cursor is in
(Macintosh computers
only).

None

Edit » Clear (Macintosh
computers only)

)
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KeyBoard Shortcuts in QuizDesigner

Action Keyboard Shortcut Equivalent Menu ltem

Select all text in the field None (Windows) Edit » Select All (Macintosh
your cursor is in $-A (Macintosh) computers only)

(Macintosh computers

only)

Duplicate a selected Ctrl-D (Windows) Edit » Duplicate (both Windows
question. $-D (Macintosh) and Macintosh)

Add a true/false question ~ Ctrl-T (Windows) Question » Add True/False

to a quiz. -t (Macintosh) (both Windows and Macintosh)

On Windows computers, you can
also click T in the toolbar.

Add a multiple choice Ctrl-M (Windows) Question » Add Multiple
question. $8-m (Macintosh) Cho.ice (both Windows and
Macintosh)

On Windows computers, you can
also click M in the toolbar.

Add a short answer Ctrl-B (Windows) Question » Add Short Answer
question. $%-B (Macintosh) (both Windows and Macintosh)

On Windows computers, you can
also click 54 in the toolbar.

Add an essay question. Ctrl-E (Windows) Question » Add Essay (both
$-E (Macintosh) Windows and Macintosh)

On Windows computers, you can
also click E in the toolbar.

Edit a question. None Question » Edit Question
(both Windows and Macintosh)

Remove a question. delete key (with the question Question » Remove Question

highlighted) (both Windows and Macintosh)

Shuffle the question order None Question » Shuffle Question

in a quiz. Order (both Windows and
Macintosh)

Show a preview of a None Question » AlphaSmart View

question as it will appear (both Windows and Macintosh)

on a NEO.

D
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Previewing Questions in QuizDesigner (Seeing Questions as They Appear on NEO)

Previewing Questions in QuizDesigner (Seeing

Questions as They Appear on NEO)

As you work on a quiz, it can be helpful to see how a question will look to

students on the NEO. By following the steps below, you can preview the

questions as they will look on a NEO. This shows you whether your questions

flow well and scroll easily.

1. Open the quiz you want to preview (see page 9-10).

2. In the quiz window, click the first question or another question that you

want to preview @).

& Weather Quiz.qzz

Quiz Questions
Nurmber
P .
True/False The world's coldest chimates c..
4 Multiple Choice Wwhich of the following iz MOT..
) Multiple Choice Rain iz a form of:
E Multiple Choice ‘when sunlight =hines on raind...
T Short Angwer Wwhat type of clouds tend to =...
) Short Angwer Wwhat type of clouds tend to =...
) Short Angwer In the Pacific Dcean, powerfu..
10 Essap Ewxplain the states of the water...
1 Essap The Earth hasg six main types ...
12 Essap ‘why do big cities often have ...
13 True/False The world's warmest climate c..
14 True/False Precipitation is caused by war...
15 Essap Deszcribe the different tppes of..
Quiz Optians Add Question Help
Quiz Capacity I

3. Click the Question menu and choose
Show AlphaSmart View. A window will
appear that shows a simulation of the
NEO screen with the question displayed

just as your students will see it.

)
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(SRS Window  Help
Add TruefFalse. ..
Add Multiple Choice. ..
Add Short Answer. .,
Add Essay...

Shuffle Question Order

Show Alphasmart Yiews

Chr+T
Chrl+M
Ctr+B
Chr+E
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Printing a Quiz from QuizDesigner

4. In this window, you can use the key commands listed in the table below to
move through your question.

Press These Keys... ...To Do This:

T (up arrow) Scroll up in the question text.

1 (down arrow) Scroll down in the question text.
enter Go to the next question.

OR

Ctrl-! (Windows)
38-1 (Macintosh)

Ctrl-T (Windows) Go to the previous question.
38-T (Macintosh)

5. Click Done to finish previewing the quiz.

Printing a Quiz from QuizDesigner

Follow these steps to print a quiz you've created in QuizDesigner. Printing a
quiz can be helpful if you want to review it before sending it to NEOs or if you
want to administer a paper quiz.

1. Open the quiz that you want to print (see page 9-10).

2. With the quiz open, click the File menu and choose Print, or press Ctrl-P

(Windows) or 3-P (Macintosh). The Quiz Printing Options window will
_uls_ The blanks for open.

P J. student name and

3. Check each item that you want to be

class number are ) X ) Quiz Printing Options X
useful if you are administering included on the printed quiz. If you are
a paper quiz. printing the quiz for students to take on i
s ¥ Piint author/teacher name
paper, make sure that you don’t check the % it blank for studert name
correct answers box. Click OK after ¥ Piint blank for class number

choosing the items to print.

For each question print:
4. In your computer’s print dialog box, click ¥ Question
OK (Windows) or Print (Macintosh). The L] Bareat ansuers
. . . [ Question remark.
quiz will be printed.

oK | Cancel Help

)
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Exporting a Quiz from QuizDesigner to a Word
Processing Program

By following the steps below, you can export a quiz in a format that you can
use outside of AlphaQuiz, QuizDesigner, or QuizManager. The exported file
will be a text (.txt) file that you can bring into word processing programs.

1. Open the quiz that you want to export (see page 9-10).

2. With the quiz open, click the File menu and choose [ quesson wrdow 1]
- The export options Export. The Quiz Export Options window will open. e Qi ce
,@: are similar to the P h include in th pen QU - i
ones you have when . eck the items that you want to include in the Close
) N . f Save Chrl+3
you print a quiz. The blanks exported file. Then, click OK. Save fis...
for the student name and - - X Quiz Options .. Ctri+]
class number are useful if you {uiz Export Options fud
plan to use this file to develop o Bl g Print Setup...
B . ik, |
a paper quiz. For paper quiz = BomarmiEmn o
files, be sure to leave out the ¥ Expait blank for student name -
1 Weather Quiz.gzz
correct answers. Iv Export blank for class number 2 Ciwil War Quiz.gzz
3 Review Quiz.gzz
For each question export: 4 Hamlet Quiz.qzz
v Question Exit
™ Correct answers
[~ Question remarks
oK | Cancel | Help |
4. In the dialog box that opens, enter a name for the exported file € and
choose a location. (On Macintosh computers, you may need to click the
down arrow @ to see the full dialog box that lets you choose any
location.) Then, click Save.
Windows
Save As @@
Savein: |D My Documents ﬂ I‘j‘ '
(hAdobe [hFilelib [ChMy Templates .
() AdobeStockPhotos )My Captivate Prajects v viewets || Macintosh

) Alphasmart USB

() Arbortext Import éMy Music
([)Demo Builder Movies ﬁMy Pictures
|JePublisher Pra Projects LMy Projects

<

My HelpandManual Projects  [C2)My Webs

[C3)Updater Save: QuizDesigner

E1 AMReadMein

[E] rReadme.txt Save As: Exported Quizru

b4 Where: | |7 Documents

File name: "_0

Save

Save as ype | Tent Files [~ tst]

ﬂ Cancel

( Cancel ) @

N
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Spell Checking a Quiz

Spell Checking a Quiz

QuizDesigner does not have a built-in spell check feature. However, you can
export a file and use a word processing program to check a quiz. Follow these
steps.

1. Export the quiz as described on page 9-21.

2. Start your word processing program and open the file that you just
exported. When you choose the file in Windows, you may need to use a
drop-down list to choose to view “All Files” instead of just files of a certain
type.

3. Use the spell check feature in your word processing program to find each
spelling error. You may also be able to check grammar. Note any
changes that need to be made.

4. Return to QuizDesigner and type in the corrections where they are
needed.

Deleting Quizzes

To delete a quiz that you have created, simply delete the file from the location
where you've saved it. Before deleting a quiz, you should be sure that you will
not use the quiz again.

Creating a Question Library in QuizDesigner

In QuizDesigner, you can create a question library for storing large numbers
of questions. Unlike quizzes, a quiz library can include any number of
questions. It has no capacity limit because a library is not intended to be sent
to NEOs—the library is simply a place to store questions that you expect to
use in quizzes.

)
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Windows Instructions for Creating Question Libraries

To create a question library, follow the same steps that you perform when you
create a quiz. However, before you add the questions, click the File menu and
choose Save, and choose QuizDesigner Library Files (*.qzl) in the Save
As drop-down list in the dialog box. Once you do this, the Quiz Capacity bar
will disappear since there is no capacity limit for libraries, and you can add as
many questions as you'd like.

Save As EJE|
Save in: | (L) My Documents - =5 B~
I—1Adobe I filelib [CMy Template
|2 AdobeStackPhotas |[)My Capivate Projects My Viewlets
|Z1alphasmart USB |[2)My HelpAndranual Projects  [C2)My Webs
|Z)arbortext Import dMy Music [Updater
|Z)Dema Builder Movies (ﬂMv Pictures @ American Hisl
|Z)ePublisher Pra Projects )My Projects m Civil War Qui
4 *
File: name: |F\ead\ng Quiz Library.qzz
Cancel |

Macintosh Instructions for Creating Question Libraries

To create a question library, follow the same steps Edit Question Help
that you perform when you create a quiz. However, New Quiz BN
before you add the questions, click the File menu and | " - i
choose Save As Quiz Library instead of choosing = -

Save or Save As. Once you do this, the Quiz Capacity Save As. .
bar will disappear since there is no capacity limit for

libraries, and you can add as many questions as you’d Quiz Options... %
like. EXpontE:

Page Setup...

Print... P

Using Quiz Library Questions in a Quiz

To bring questions from a quiz library into a quiz, follow the instructions for
copying a question from one quiz to another on page 9-14.

Starting QuizManager

QuizManager is the program you use to send quizzes to student NEOs,
retrieve their responses, assign points to questions, grade quizzes, generate
and print reports, compile statistics, and export scores.

)
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About the QuizManager Control Bar

To start QuizManager, follow the instructions for your type of computer.

On Windows Computers

Click Start » Programs » AlphaSmart » QuizManager » Launch
QuizManager.

On Macintosh Computers

Open the Applications folder, then the QuizManager folder. Double-click
QuizManager.

About the QuizManager Control Bar

When you have started QuizManager, a status message across the top of the
control bar lets you know how many NEOs are connected to your computer (if
any), either through a SmartOption Mobile Lab or by a direct USB cable
connection.

s If you've closed the
ABJ: Control Baron a
4
Windows COI‘npUtel’ QuizManager Control

and you want to open it One AlphaSmart is currently connected
aga’n’youcanCIIthhe L I 3 N BB I I I B N BN N N N N NN NN N N N NN N [ ]
Window menu and choose |1 2345678 37011121214151677 181920 21 2223 24 25 26 27 28 2330 Direct USE
View Control Bar. You

cannot close the Control Bar Send Delete Rietrieve Delete Power Off
separately on Macintosh Quiz Quiz Responses | Responses AlphaSmarts
computers.

The numbered circles show you NEOs connected through a SmartOption

Mobile Lab. The Direct USB circle shows you NEOs connected directly to the

computer with a USB cable. The color of each circle shows you the status of

each NEO:

e Green means a NEO is connected at this location, and the NEO has
AlphaQuiz installed.

« Black means no NEO is connected in this location (or it is an older device
with older software). If you have a NEO connected at this location and the
circle is still black, disconnect the NEO and turn it on; then, reconnect it.

» Yellow means a NEO is connected, but it does not have the AlphaQuiz
SmartApplet installed. To install the SmartApplet on that NEO, see
page 1-3.

+ Red means a NEO is connected but is not communicating properly.

D
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Sending Quizzes to NEOs Using QuizManager

The buttons in the control bar perform these functions:

Control Bar Button What It Does
Send Quiz Sends a quiz to the connected NEOs.
Delete Quiz Removes a quiz from connected NEOs, including all

questions and student responses.

Retrieve Responses Retrieves student responses to a quiz from NEOs
without removing either the quiz or the responses from
the NEOs.

Delete Responses Removes all student responses for a quiz from NEOs.

Power On Turns on all connected NEOs if they were shut down

AlphaSmarts using QuizManager.

Power Off Turns off all connected NEOs.

AlphaSmarts

Sending Quizzes to NEOs Using QuizManager

By following the steps below, you can use QuizManager to send a quiz to
NEOs. (The quiz itself must be created in QuizDesigner before you can send
it; see page 9-5 to create quizzes.)

s NEOs have space for
3@: up to four quizzes. 1. Connect your NEOs to the computer through a SmartOption Mobile Lab
You may need to and/or directly with a USB cable. In QuizManager, make sure your NEOs

delete a quiz before sending a L
new one. See page 9-27 to are connected as shown by the indicators (see page 9-24).

find out how to delete quizzes 2. Click Send Quiz o on the control bar, or click the Communication menu
from NEOs. and choose Send Quiz. On Windows computers, you can also click L&
in the toolbar in the QuizManager window.

QuizManager Control

One AlphaSmart iz currently connected

(AR R AR RN R NE RSN RN ENNERENERENNESENNENRN ] @
12345678 31011121314151617 18132021 2223 24 25 26 27 28 23 30 Direct USB

Send
Quiz

Power Off
AlphaSmarts

Delete
Responses

Retrieve
Responses

Delete
Quiz

)
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3. Find the quiz that you want to send and click the quiz file to highlight it.

w1, If you created the Then, click Select. QuizManager will make sure there is enough space on
A E quiz on a Macintosh the connected NEO(s) for this quiz.
' computer and you i
are sending it from a Windows

Windows computer, make ol i T 3]

‘Eure ihe quiz name ends with Lok in: ‘_} Quizzes for NEOs j {% & ER-
.qzz” so that the -

QuizManager program shows B ol tar Quiiz 2
it in the list. B pavid and saul. gz

m Harlet Quiz.qzz
m Review Quiz.gzz
m Weather Quiz.gzz

Filename: | Select |
Files of tppe: |QuizDasigner Files [*.q22) j Cancel
Macintosh
Select Quiz Document

[«]»] [ElE ' | Documents F

% Network |7 Alphasmart USB

= main Exported Quiz

= =

.\ secondary n History Quiz 3.qzz L—
4 Engineering @ Reading Quiz 5.qzz

3 Public

3 TechWrit

QuIZ

g Desktop t A
A tspaul Kind: Document
/A Applications Size: 4 KB

. Documents Created: 5/18/07

) Modified: 5/18/07

[y Movies

& Music

[ Pictures A .

4. If any connected NEOs do not have space for another quiz, the program
will notify you. Click Close (Windows) or OK (Macintosh). You may need
to delete quizzes from NEOs; see page 9-27.

5. Inthe Send Quiz dialog box, you can decide whether to use a quiz access
password and which password to use:

¢ Ifyou chose to require a quiz access password when you created
the quiz, the access password is filled in. You can leave it as is or
change it, or you can remove the password and leave the field blank if
you don’t want students to have to enter it. Changing the password
here will not change it in the original quiz file.

)
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ALPHAQUIZ

Deleting Quizzes from NEOs

* If you did NOT choose to require a quiz access password when
you created a quiz, you can enter one now that students must enter
before taking the quiz, or you can leave the field blank so that
students don’t need to enter a quiz access password. Setting a
password here will not change the options selected in the original quiz

file.

Quiz Name: ‘Weather Quiz
Quiz Author: T
Questions: 15

Mod Date:  7/2/2007

Access Password: w33

Mote: thiz will not change the access
paszword stored in the original quiz document,

Send | Cancel | Help |

show you messages as the quiz downloads.

Click Send to send the quiz to the connected NEOs. The program will

7. Click Close (Windows) or OK (Macintosh) when the program notifies you
that the quiz has been sent.

8. Disconnect your NEOs (or have your students disconnect them). Your
students can now take the quiz.

By following these steps, you can delete quizzes from connected NEOs. It’s a
good idea to delete older quizzes from NEOs before you send new ones since a
NEO can only store up to four quizzes.

Be sure to retrieve student responses for a quiz before you delete it
unless you do not want a record of the responses. To retrieve responses, see

page 9-35.

You may also want to delete quizzes if you have a different quiz you want
students to take instead. In that situation, you may not need to retrieve
responses before deleting an old quiz.

1. Connect your NEOs to the computer through a SmartOption Mobile Lab
and/or directly with a USB cable. In QuizManager, make sure your NEOs
are connected as shown by the indicators (see page 9-24).
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xLtr_ If the connected

P ). NEOs have different
quizzes on them,

you may see more than four

quizzes listed even though

individual NEOs can only

store four quizzes.

N
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2. Click Delete Quiz @) in the QuizManager control bar, or click the

Communication menu and choose Delete Quiz. On Windows
computers, you can also click xﬂ in the toolbar in the QuizManager
window.

QuizManager Control

One AlphaSmart is currently connected

se 0SSOSR SSERBRRSERRSRSEBRRRRERSEORRSERRRERES L]
1234567 8 371011121314151617 18132027 2223 24 25 26 27 28 29 30 Direct USB

s PDEEQE Faspinees | Respanies oo
In the Delete Quizzes dialog e elires X
box, check each quiz that you I
want to delete from the Name Retiieved  Password
NEO(S) e ::::j;”;z 10;2 o’l:
The list shows you how many ()
results were retrieved @. For
example, if the Results /
Retrieved column shows 2/1,
then two students have
completed the quiz, but Select Al
results have only been Select ore | 0k [[ Coresl | Hep |

retrieved for one student so

far. You may want to retrieve the other student’s results before deleting
the quiz from the NEOs.

If the quiz has an administrative password @), you must enter it before
you can delete the quiz. (This is the password you enter on the Basic tab
in the Quiz Options in QuizDesigner. It is different from the access
password.)

Click OK to delete the checked quizzes from the NEOs.

If the quizzes have any unretrieved student responses, the program will
notify you. If you want to continue anyway, click Yes (Windows) or OK
(Macintosh).

Click Close (Windows) or OK (Macintosh) when the program notifies you
that the quizzes have been deleted.

9-28



ALPHAQUIZ
How Students Take a Quiz Using the AlphaQuiz SmartApplet

How Students Take a Quiz Using the AlphaQuiz

SmartApplet

s If students see
Z@: letters next to the
* quiz, some

SmartApplets or functions are
blocked because a student did
not finish the quiz. S means
spell check is blocked. C
means Calculator is blocked.
L means all SmartApplets are
blocked. The blocks are
based on what you chose in
the Advanced Quiz Options
when you created the quiz in
QuizDesigner.

L The Advanced Quiz
1@: Options determine
' whether the quiz

access password, a student
password, and the class
number are required. You
set these options when you
create a quiz. See page 9-6
for details. You can also set a
quiz access password

when you send a quiz; see
page 9-26.

N
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Students follow the steps below to take a quiz that you have sent to their
NEOs. (To send a quiz using QuizManager, see page 9-25. To create a quiz
using QuizDesigner, see page 9-5.) Students use the AlphaQuiz SmartApplet
on their NEOs to take the quiz.

1.

If students are not already seeing the AlphaQuiz menu on their NEOs,
they must do the following:

a. Start the NEO.

b. Press applets.

c. Use the arrow keys to move the cursor next to AlphaQuiz.
d. Press enter to select AlphaQuiz.

In the Select a Quiz menu, students use the arrow keys to move the
cursor next to the quiz they want to take; then, they press enter.

Select a quiz:

- Multiplication Quiz

- American History Quiz 3
! Weather Quiz

SCL

Next, students may be asked to enter a quiz access password. If so, they
type the password and press enter.

Next, each student must enter his or her first and last name. The student
must type the first name, presses tab or enter, type the last name, and
press enter.

Enter your first and last name:
First Name:
Last Name:

Press Enter after typing the names.

Next, students may be asked to create a password to remember. This
password is used to prevent other students from seeing this student’s
answers; the next time the student selects this quiz, the student must
enter his or her password.

The student types a unique password, presses enter, types it again, and
presses enter again.
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6. Next students may be asked to enter their class number (two characters
or less—letters and/or numbers). Each student types the number and
presses enter.

Next, students press any key to start the quiz.

Students enter an answer for each question in the quiz and press enter.
After they answer each question, the next one appears until the quiz is
done. Students can also use these keys to move through the quiz or to
find unanswered questions:

Press these keys... ...to do this:

esc Exit the quiz (if marking the quiz “finished” is not
required).

T Scroll up within this question.

l Scroll down within this question.

-l Go to the next question.

%-T Go to the previous question.

enter Go to the next question, except in the answers to essay

questions. In those answers, enter inserts a line break
so students can begin a new paragraph.

¥-enter Go to the next question from the essay question
answer.
tab In essay questions, switch between the question and

the answer. If you go to the answer, the cursor returns
to the student’s last location in the answer.

8-J Go to any question in the quiz. After you press this key
combination, the NEO will ask you to enter the
question number. Type the number and press enter.

#-B Check for unanswered questions. After you press these
keys, the NEO will show you which questions you have
not answered. Type the question number that you want
to go to and press enter.

Students may also be allowed to print their answers (see page 9-31) or
save their quiz to an AlphaWord file (see page 9-32).

)
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How Students Print Quizzes

9. Atfter students answer the last question, they see a screen like the one
below. They can then use the keys listed go back to the quiz or a specific
question, find unanswered questions, or mark the quiz finished.

End of the quiz. Esc to return to the quiz.
Cmd-J to jump to any question.
Cmd-B to find any unanswered questions.

Cmd-F if you are finished.

If students are within the quiz and have answered all questions, they can
w1, When a quiz is then press esc to finish the quiz. If you did not choose to require students
A@): marked finished, to mark the quiz finished, they will exit the quiz. If you did require this,

students can select students will see the screen shown below. The student has these choices:
the quiz and see their
answers, but they are not

¢ Pressing R takes the student back to the last question he or she saw.

allowed to change their ¢ Pressing E allows the student to go back to the list of available
answers. You can choose quizzes. The student can select the quiz again later and see or
whether students are required change his or her answers until the quiz is marked finished. The

to mark a quiz finished in the letters “S C L” may appear to the right of the quiz name in the list of
Advanced Quiz Options when available quizzes to show that some options are not available until the

you create a quiz (see

page 9-5). quiz is finished (see page 9-34).

* Pressing F marks the quiz as finished, meaning the student cannot
change his or her quiz answers.

The quiz has not been marked finished.
Press F if you are finished.
Press E to exit the quiz.

Press R to return to the quiz.

10. If the student chooses to finish a quiz, the program will remind the student
that he or she cannot change responses once the quiz has been marked
finished. If any questions were not answered, the program notifies the
student of that as well. Students press Y for yes to continue.

How Students Print Quizzes

When you create a quiz, in the Advanced Quiz Options, you can choose
whether to allow students to print their quiz answers. If you allow this,
students can press print on their NEOs before exiting the quiz to print their
answers.

)
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On NEOs, you can print using a cable connection to a printer or using
infrared beaming. (On NEO 2 laptops you can also use radio frequency
technology to print.) For more information, see the NEO 1 or NEO 2 User
Manual.

How Students Save Quizzes to an AlphaWord File

When you create a quiz, in the Advanced Quiz Options, you can choose
whether to allow students to save their quiz to an AlphaWord file. If you allow
this, students can follow these steps to save the quiz:

1. Before exiting the quiz, the student must press send.

2. The NEO asks the student to choose a file. The student presses the file
number he or she wants to save the quiz in; then, the student presses
enter.

3. If the file isn't empty, the NEO warns the student that the quiz will delete
any text that is in the file now. If the student wants to continue, he or she
presses Y for yes. If not, the student presses N for no and then presses a
different file number. The NEO will automatically exit AlphaQuiz and open
the AlphaWord file (unless the quiz needs to be marked finished).

Teacher Options for Quizzes in AlphaQuiz

For most teacher tasks, you’ll use QuizDesigner and QuizManager on your
computer to create quizzes, send them, and retrieve responses. However, the
AlphaQuiz SmartApplet also includes a few teacher options that you can use
right on the NEO. These options let you do the following:

 Check a student’s password so you can give it to a student who has
forgotten the password and needs it to finish a quiz.

« Delete a student’s answers.

« Change the finished status of a quiz. For example, if a student leaves a class
without marking a quiz finished, and you want to use the NEO for other
functions, you may want to mark it finished yourself.

 Viewing a student’s responses before they are sent to QuizManager.
Follow these steps to use the teacher options:

1. Start the NEO and press applets.

)
Sma IAPPLET' User Manual 9-32



e If you don’t
P ). remember the quiz
admin password,
open the quiz in
QuizDesigner, click Quiz
Options, and view the
password on the Basic tab.
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ALPHAQUIZ

Teacher Options for Quizzes in AlphaQuiz

Use the arrow keys to move the cursor next to AlphaQuiz. Then, press

enter to select AlphaQuiz.

In the Select a Quiz menu, use the arrow keys to move the cursor next to

a specific quiz that you want to work with; then, press enter.

Select a quiz:

- Multiplication Quiz

- American History Quiz 3
! Weather Quiz

If an access password is required for this quiz, NEO will ask for that

password. Enter the password and press enter.

When the NEO asks you to enter your name, enter teacher for the first

name and options for the last name. Then, press enter. This tells

AlphaQuiz that you are a teacher who wants to access the teacher

options.

Enter your first and last name:
First Name: teacher

Last Name: options

Press Enter after typing the names.

Next, you must enter the admin password that you set when you created

the quiz. If you did not enter an administrative password when you

created the quiz, you can enter the NEO’s master password. (For more
about the master password and how to set it, refer to the AlphaSmart

Manager 2 User Manual.)

Next, the teachers who have started the quiz on this NEO will be listed.

Student Response List:

- Johanna Espinosa AF
- Jessica Knutson AF
- Anna Martin UN
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ALe_ If you see U and F
ABJ: together, the student

' may have run out of
time. The student may have
had to mark the quiz finished
even though he or she did not
answer all the questions. If
you see neither F nor N,
students aren’t required to
mark the quiz finished.

ALPHAQUIZ
Teacher Options for Quizzes in AlphaQuiz

The letters to the right of each student’'s name tell you whether the
student has answered all questions and whether the student has marked
the quiz as finished. This is what each letter means:

Letter What It Means

A Student has answered all questions.

U Student has not answered all questions.
F Student has marked test finished.

N Student has not marked test finished.

From this screen, you can do the following:

What You Can Do

View a student’s
responses

How to Do It

Use the arrow keys to move the cursor next to a student’s
name. Then, press enter. You can now move through the
questions as the student does (see the table that starts on
page 9-30), viewing the student’s answer to each
question. When you have finished, press esc to exit the
quiz.

te If a student’s quiz is
P J. not marked finished,

access to some
SmartApplets may be blocked
on the NEO until the quiz is
finished. The blocks are
based on the Advanced Quiz
Options you chose when you
created the quiz in
QuizDesigner. They will
remain in place until the
student finishes the quiz or
until you delete the student’s
responses.

View a student’s

Use the arrow keys to move the cursor next to the

password student’s name. Then, press 38-P to see the student’s
password. (If nothing happens, no student password was
required for this quiz.) To leave the screen, press any key.
Mark a student’s This is only necessary if you require students to mark a
test finished quiz finished and a student has not marked a quiz

finished (perhaps because the student became ill or had
to leave the room). To mark the student’s quiz finished,
use the arrow keys to move the cursor next to the
student’s name. Then, press -F. You will see the second
letter behind the student’s name change from N (not
finished) to F (finished). (If nothing happens, students
weren’t required to mark this quiz finished.) You can
press $-F again to change the status back.

N

Delete a student’s
responses to all
questions

When you delete a student’s responses, they
cannot be recovered. To do this, use the arrow keys to
move the cursor next to the student’s name. Then, press
#-D. When NEO warns you that all quiz responses for
this student will be deleted, press Y for yes if you want to
continue. The student’s responses will be deleted, and the
student’s name will no longer be in the student response
list.

View the quiz access
password (if one
was set for the quiz)

While viewing the student response list, press #8-A. The
screen will show the access password. To leave the screen,
press any key.

Sma IAPPLET' User Manual
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Retrieving Students’ Responses from NEOs Using QuizManager

8. To leave the teacher options, press esc in the Student Response List.
You'll return to the quiz list.

nts’ Responses from NEOs Using

QuizManager makes it easy for you to retrieve students’ responses to quizzes
from the NEOs they used to take the quizzes. You can then grade the quiz
responses in QuizManager.

You can retrieve quiz responses more than once for the same quiz if
necessary. This is helpful if some students did not complete a quiz before the
end of class and they need to continue it another time.

1. Connect your NEOs to the computer through a SmartOption Mobile Lab
and/or directly with a USB cable. In QuizManager, make sure your NEOs
are connected as shown by the indicators (see page 9-24).

2. Click Retrieve Responses @) in the QuizManager control bar, or click the
Communication menu and choose Retrieve Responses. On Windows
computers, you can also click ¥ in the toolbar in the QuizManager
window.

QuizManager Control

One AlphaSmart iz currently connected

se 0SSOSR SSERBRRSERRSRSEBRRRRERSEORRSERRRERES L]
123245678 97011121314151677 18192021 2223 24 25 26 27 28 29 30 Direct USB

Retrieve Delete
Responses | Responses

Send
(uiz

Power Off
AlphaSmarts

Delste
Quiz
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3. Find the quiz that you want to retrieve responses for and click the quiz file
to highlight it. Then, click Select. You need to select the quiz file because
QuizManager uses some information in this file to organize the data from
the NEOs. The Retrieve Responses window will appear.

Select quiz document EWE\ Select Quiz Document
. e =

Lock ir: |_) Quizzes for NEOs ﬂ % cf B~ =|m | Documents .
[53] & Network |7 Alphasmart UsB P

;!1 main = Exported Quiz L
& David and Saul.qzz 2 secondary ¢ History Quiz 3.qzz
[ Harvlet Quiz.qzz @ Engineering ¢ Reading Quiz 5.9zz
@Revlew Quiz.qzz @ Public
@Waather Quiz.qzz @ TechWrit

= QuIZ

[F Desktop =
Fil | Seloct 4 tspaul Kind: Document

Il narne: .
\i‘ A Applications SCIZE 4dKB o

reated: 5/18/
Files of type: |E!u|zDeslgner Files [*.gzz] j Caneel ) Documents Modified: 5/18/07

i Movies

& Music

Pletures w S T
New Folder Cancel Select

4. Check the box next to each student whose responses you want to retrieve
G. You can click them one by one, click Select All, or click Select None
and then check the boxes for the students whose responses you want. As
you select students, note the status for each one @; R means you've
already retrieved the responses. F means the student’s quiz has been
marked finished (if you required students to mark it finished).

(x]

Retrieve Responses

Quiz Name:  Civil War Quiz
Quiz Author: T

Questions: 4

5 Student Responses Found

Status Name Class
FG Camacha, Luis a2
F Espinoza, Johanna 32
F Khang, Bao 32
F Krutson, Jessica 2
F Martin, Anna 32

o

R = previously retieved
F = marked finished

Date Quiz \Was Administered

#5007 l:i -

Student Responge Document

Select All Select Mone

+ Create a new document

" Merge into an existing document

.

Cancel Help

N
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5. Choose the date the quiz was administered:
«  Windows computers: Choose the date from the drop-down list @.

¢ Macintosh computers: Click each portion of the date and click the
arrows to increase or decrease the number.

6. Click one of the Student Response Options @:
¢ Create a new document: Choose this if you have never retrieved
responses for this quiz before of if you are starting over.

¢ Merge into an existing document: Choose this if you have retrieved
and saved some students’ responses from this quiz, but you have
more student responses to merge in to that document. Be sure that
you save the document before merging responses into it.
7. Click OK. Student responses will be retrieved. If you chose to merge
responses into an existing document, you'll be asked to select that
document and click Open.

When the process is done, the students will be listed under the class in
the QuizManager window (if you required the class number).

[ QuizManager - [untitled 1] g@@
g x

@File Communication  Window  Help -
I NI

Quiz: Civil War Quiz Help
Author: T
Admin Date: 7/5/2007
Quiz Points: 4
= Q iClass 32|
(o] Camacho, Luis
o] Espinosa, Johanna
o] Fhang, Bac
o] Frutson, Jessica
o] Martin, dnna

Grade Points Reports Expart

To grade the responses, see page 9-41.

To save the responses, click the File menu, choose Save, and choose a
name and location for the saved responses. Then, click Save. (On
Windows computers, you also can click E in the QuizManager toolbar.)

To delete the responses from NEOs after you have saved them in
QuizManager, see the next section of this manual.

)
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Deleting Students’ Responses to Quizzes Using

QuizManager

Once you have retrieved and saved students’ responses to a quiz, you can use
QuizManager to remove them from NEOs by following the steps below. The
quiz itself will remain on the NEO until you delete it so that other students
can take the quiz, but the responses of students who have already taken the
quiz will be deleted.

1.

vir_ You can use Select
- All to quickly check
" all boxes. Click
Select None if you want to
remove all check marks
before checking the quizzes
you want.

)
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Connect your NEOs to the computer through a SmartOption Mobile Lab
and/or directly with a USB cable. In QuizManager, make sure your NEOs
are connected as shown by the indicators (see page 9-24).

Click Delete Responses @) in the QuizManager control bar, or click the
Communication menu and choose Delete Responses. On Windows
computers, you can also click x—‘? in the toolbar in the QuizManager
window.

One AlphaSmart is currently connected

|.............................. [ ]

12346678 91011121314151617 181920 21 2223 24 26 26 27 28 2330 Direct USE

Delete
Responges

Check the quizzes for which you want to delete responses on the NEO(s)
0. As you select quizzes, note the information in the Results/Retrieved
column @. The first number (Results) shows how many students have
taken the quiz. The second (Retrieved) shows how many students you've
retrieved responses for. Make sure you've retrieved student responses for
the quiz before you delete those responses unless you want students to
start over or you want to discard student work on this quiz.

Power OIf
AlphaSmarts

Retrieve
Responses

Delete:
Quiz

Send
Quiz

Delete Responses E|

Results / Admin

Name Retrieved Password

Hamlet Quiz 240 0’—

Chilwfar Quiz 5/5 [
American History Quiz 3 1/0 n’a

Select Al
Select None ‘ ok | Cancel | Help
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4. If an administrative password was set for the quiz, you must enter it in the

_sts_ The administrative blank field after the quiz.

PR password can be set 5. Click OK. The student responses for the quiz will be deleted from the
when you create a

quiz. To find it for an existing connected NEO(s).

quiz, open the quiz in 6. Click Close (Windows) or OK (Macintosh) when the program notifies you

QuizDesigner, click Quiz that the responses have been deleted.
Options, and look in the

Admin Password field.

Turning NEOs On or Off Using QuizManager

When you exit QuizManager with NEOs connected, the NEOs are
automatically turned off. If you want to turn off all NEOs while QuizManager
is still open, do one of the following:

« Click Power Off AlphaSmarts on the Control Bar ().
« Click the Communication menu and choose Power Off AlphaSmarts.

« On Windows computers only, click off in the toolbar in the QuizManager
window.

QuizManager Control

One AlphaSmart is currently connected

L I B R I B R N N @
12346678 91011121314151617 181920 21 2223 24 26 26 27 28 2330 Direct USE

Power OIf
AlphaSmarts

To turn the NEOs on again through QuizManager, do one of the following:

Send
Quiz

Delete
Responges

Retrieve
Responses

Delete:
Quiz

s You can only use

AP these czmmands if « Click Power On AlphaSmarts on the Control Bar.
you use
QuizManager to turn the « Click the Communication menu and choose Power On AlphaSmarts.
NEOs off.

« On Windows computers only, click on in the toolbar in the QuizManager
window.

)
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Assigning Points (Weights) to Quiz Questions in
QuizManager

By default, each question in a quiz is worth one point. In QuizManager, you
can assign different points (weights) to each question by following the steps
below. You can either change points after grading based on how difficult the
questions seemed for students, or you can change them before grading the
quiz. However, you must retrieve student responses before you can assign
points to questions.

1. Make sure you have retrieved student responses from the quiz (see
page 9-35) and that you are viewing the student response document. If

sty On Windows

‘,@: computers, you can you closed the document, click the File menu, click Open, and select and
" click [ on the open the document.
QuizManager toolbar to

2. Click Points @) at the bottom of the window.
open a student response

document instead of choosing

ﬁ QuizManager - [WeatherQuizGrad... Q@@
S =a.

open from the Flle menu. File Communication MWindow Help

T IERE PRIk

Quiz: Wweather Quiz Help
Author: T

Admin Date: 7/5/2007

Quiz Points: 15

= O {Clasz 32/
[} Camacha, Luis
o} Espinosa, Johanna
o] Hhang, Eao
(o] Enutson, Jessica
[o] Martin, Anna

Grade Points Reports Export ‘
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In the Question Points
window, you can change
the points for each
question by clicking in the
field and changing the
number @. The
percentage next to each
question will adjust
automatically.

If you want to enter
fractional points, use a
decimal point. You can
enter one digit after the
decimal point.

If you decide to throw out a

ALPHAQUIZ
Grading Quizzes in QuizManager

Question Points

Number

1

2

3

5

B

Tiue
False

Tiue
False

Tiue
False

Multiple
Chaice

Multiple:
Choice

Multiple

Chine

Question Paoints

High puffy white clouds are called cumulus 1 05 -4

clouds.

Clouds are made up of bilions of air droplets 1 6%

The world's coldest climates can be found 1 6%
alang the equatar

‘Wwhich of the following is MOT a season 1 L3

cauged by the earth's rotation around the sun?

Fiain is & farm of: 1 [3:4

‘when sunlight shines on raindiops in the ai it |4 6%
creates &

Total Quiz Points:  15.0

Iy

v

Ok | Cancel | Help |

question so it does not count for any student, enter “0” for that question.

You can press the tab key to move from the points for one question to the

next question.

4. Click OK to save your changes to points.

Some questions can be graded automatically by QuizManager, such as
multiple choice questions, true/false questions, and short answer questions
for which you've entered an answer that QuizManager can match to student
answers.

Select the students whose quizzes you want to grade:

After you've retrieved student responses for a quiz (see page 9-35), you can
grade the quiz by following the steps below. You may also want to assign
different points to questions (see page 9-40) before grading the quiz.

* To select all students in a class (if classes are listed), click the class

name.

* To select one student, click the student’s name to highlight it.

¢ To select more than one, hold down the Ctrl key (Windows) or the 38
key (Macintosh) as you click student names. To select a group of
students, click the first name in the group, hold down the Shift key,
and click the last name in the group. You can select students from

more than one class.
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xts_ Youcan’tchange the
3@: correct answer or

* " the remarks in
QuizManager. Those were
set when you created or
edited the quiz in
QuizDesigner.
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Click — to collapse a class so you don’t see its students, or click + to

see the students in a class again.

If the circle next to a name is filled in, that student’s quiz has already
been graded. (See the circle next to Luis Camacho in the example
below.) The student’s score is shown after the circle.

2. Click Grade @) at the bottom of the window.

ﬂ QuizManager - [WeatherQuizGrad... Q@E|
File  Communication ‘Window Help -8 x

Foints

= & oo | 7
Quiz: ‘Weather Quiz Help
Author: T
Admin Date: 7/5/2007
Quiz Points: 32
= Q Class 32
® =0 Camacho, Luis
o] Espinosa, Johanna
=& Class 34
[} Fuller, Heisha

Reports

Export ‘

In the grading window, adjust the student’s points for each question as
needed. For essay questions and short answer questions, QuizManager
does not award points automatically, so you must award them yourself.
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] Grading for “Weather Quiz*

- Q Class 32

Score:

(o] Espinosa, Jo

Date:

True
False

Trug
False

_ O Camacho, Luis 9

1 High pufy white clouds are called cumulus clouds o s

Response:
Correct:

Paints:
Comments:

Remarks:

2 Clauds are made up of bilians of air droplets.

Response:
Correct:

Points:

Show Questions: | all questions = 0

Help

1 Class: 32
Jul 05, 2007

TRUE
TRUE

’T—G out of 1
'@
< nohe e

TRUE

TRUE %
1 aut of 1 2

© The name of the student
whose quiz you’re grading.

© The gray bar includes the
question number, the question,
and the question type.

@ The Response is the student’s
answer. The correct answer is
shown below it.

@ Change the points earned as
needed. For true/false,
multiple-choice, and some
short answer questions,
QuizManager awards points
automatically. For essay
questions and some short
answer questions, you must
award points yourself. You
can’t enter more points than
the question is worth. To set
points, see page 9-40.

@ Comments may help explain to
the student why he or she did
not receive full credit. They

may also provide extra
information or encouragement.
You can include comments in
the Corrected Quiz Report.

© Remarks were entered when
you created the quiz. They
may include references to the
textbook or other information
that will help students. You can
include remarks in the
Corrected Quiz Report.

0 You can view all questions,
just those that weren’t
automatically graded, or just
those that need grading
because no points have been
awarded.

@ 7 you selected multiple
students, after you finish
grading one student’s quiz,
you can click the next
student’s name to grade his or
her quiz.
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4. When you've finished grading this quiz for this student, you can click the
next student’s name @ if you chose more than one student.

5. Click Done Grading when you've finished grading the quiz for all the
students you selected. If necessary, select other students and click Grade
to grade their quizzes.

Printing Reports in QuizManager

About the Reports in QuizManager

In QuizManager, you can print reports that provide more information about
your students’ work on a quiz. You can print four reports, which are described
in the table below. The table also shows which information you can choose to
include when you print the report. In addition to these options, you can
choose whether to use tabs in the report so it’s easy to export to a spreadsheet.

Report When to Use It Information You Can Choose to Include
Grading Sheet A printed grading sheet for a quiz.  + Quiz name

This can be helpful if your quiz « Class number

contains questions that can’t be « Date the quiz was taken

automatically scored, such as essay
questions. The printout lets you
grade the quiz away from the
computer and enter the points into

The questions and answer choices

« Student responses (answers)

« Blanks for scores for each question

« Blanks for comments for each question

QuizManager later. A
« All questions or only those that weren’t
automatically graded
Corrected Quiz A graded quiz report that you can » Quiz name
Report hand back to students to show « Student name
them how they did on the quiz. « Class number
Each student’s report prints on a - Date quiz was taken

separate page.  Score

» The questions and answer choices

« Student responses (answers)

 The correct answers

« Teacher comments from grading

« The question remarks you added when
creating the quiz

)
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Report When to Use It Information You Can Choose to Include
Quiz Summary A tab-delimited list of student * Quiz name
Report names and grades for a quiz. This ~ « Class number

report is intended for teachers « Date the quiz was taken

only. « Student names

« Student scores

Statistical Report A report that provides statistics « Average score
such as class averages, medians, « Median score
and score distributions as well as « High and low scores

the frequency of missed questions. , gcore distribution

« Missed question summary

How to Print Reports
To print reports in QuizManager, follow these steps:

1. Make sure you have retrieved student responses from the quiz (see
page 9-35) and that you are viewing the student response document. If
you closed the document, click the File menu, click Open, and select and
open the document.

2. Click Reports @ at the bottom of the window.

l!'.‘ QuizManager - [WeatherQuizGrad... Q@@|
g X

File Communication  Window  Help E
| on o |

Quiz: ‘Weather Quiz Help
Author: T
Admin Date: 7/5/2007
Quiz Points: 32
= Q Class 32
® =0 Camacho, Luis
Q Espinosa, Johanna
= ©Q Class 24
[o] Fuller, Keisha

Grade Pairts

Reparts Export ‘
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sLs_ On Macintosh
3@: computers only, you
' can also choose
whether to view the report
for all selected students or
just one student. Click the
drop-down list at the bottom of
the window to choose a
student name or All
Students.
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3. On the left side of

print @.

Reports

Report

Gira

o

Cornected Quiz
Quiz Summary
Statistics

¥ Use tabs in report test

ALPHAQUIZ
Printing Reports in QuizManager

the window, click the name of the report you want to

x|
Help

Types
t Report Options
I the: header show
¥ Quiz name
[V Class number

¥ Date quiz was taken

For each question show
¥ Question and answer choices
¥ Student response [answer)
¥ £ blank to wite the score
[¥ & blank ta wite a comment

[ Show only non-autograded questions

Create Report | Close ‘

recommended for exporting
to spreadsheets

want to include @

shown below.

Use the buttons in

On the right side of the window, check the boxes for the information you

. If you want tabs in the report text, check that box @).

Click Create Report. The report will appear in a window like the one

the window to print or save the report:

To print the report, click Print. In the print dialog box, click OK

(Windows) or Print (Macintosh).

To save the report as a text file, click Save. Choose a location for the

report file and enter a name; then, click Save.

€ Grading Sheet Report @

Weather Quiz
Classes:

Guestion l:
Response:
soore:
Comments:

Ouestion Z:
Response:
soore:
Comment.s:

Quastion 3:
=quanor.

Help

Date aduwinistered:

Responses from:

~
3z, 34
TSEFZ007, 7SESZO0T
Camacho, Luis
High puffy white clouds are called mmulus clouds
TRUE
of 1
Clowds are made wp of billions of air droplets.
TRUE
of 1
The world's coldest climates can be found along the
W
Fririt Save ‘ Dare
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7. Click Done to close the report.

8. Click Close to close the Reports window.

Exporting Student Quiz Scores
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By following the steps below, you can export student quiz scores so that you
can bring them into a computerized gradebook program. If you want
QuizManager to match the students’ quiz scores to their names in the
gradebook program, the gradebook program must be able to 1) export a text
file roster of student names, and 2) import a text file of names and scores.

1.

In your gradebook program, export a student roster and save it as a text
file if you'd like QuizManager to match the student scores to these names.
Make sure you enter the last name, a comma and space, and then the

first name (as in Smith, John).

Make sure you are viewing the student response document. If you closed
the document, click the File menu, click Open, and select and open the

document.

3. Click Export @) at the bottom of the window.

2 QuizManager - [CivilWarQuiz.gzm] Q@@|

File Communication  Window Help

Grade

== %

Quiz: Civil War Quiz Help
Author: T

Admin Date: 7/5/2007

Quiz Points: 4

=@ Class 32!
® = Camacho, Luis
& Espinosa, Johanna
[ I Hhang, Bao
& Hnutson, Jessica
® = Martin, Anna

Points Reports

Export
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4. If you exported a text file of student names from your gradebook program,
click Browse @) to select the file. In the dialog box that opens find the file,
click it once, and click Select (Windows) or Choose (Macintosh). The
path to the file will be shown.

Export Scores §|

Quiz Name:  Civil War Quiz
Students: &

Grade Book Roster
C:\Huizzes for NEDs5Class32R oster. txt

(1@
e Erport | Cancel | Help

Click Export @.
6. If you are using a roster file, QuizManager compares the students who
v1,_ QuizManager can’t responded to the quiz to those in the text file you exported from your
A@): match names if gradebook program.

they’re notin the last
name, first name format.
Different formats will cause

If QuizManager can’t match a name, you'll see the Export Name Conflict
window. If the correct name is in the list, click it and click OK. If not, click

the Export Name Confiict Skip (or Skip All to skip all non-matching names). Skipped students
window to appear. won't be in the exported file.
Name from quiz: Help

Camacho, Luis

Select the corresponding name
from the grade book roster:

Arina Martin

Bao Khang
Jessica Knutson
Johanna Espinosa
Luis Camacho

) ‘ SklpAII‘ | Teres)

7. Inthe Save As dialog box, choose a location for the exported file and
enter a name. Then, click Save.

8. In your gradebook program, import the file that you exported.

)
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KeyBoard ShortCuts in QuizManager

The following keyboard shortcuts give you a quick way to perform many of
the tasks in QuizManager. The table below also includes the equivalent menu
commands.

Action

Open a file of retrieved
(and possibly graded)
quiz responses.

Keyboard Shortcut

Ctrl-O (Windows)
-0 (Macintosh)

Equivalent Menu ltem

File » Open (both Windows and

Macintosh)*

*On Windows computers, you can

also click E-q' in the toolbar.

Close a student response
file for a quiz.

None (Windows)
3$8-W (Macintosh)

File » Close (both Windows and

Macintosh)

Save a file. Ctrl-S (Windows) File » Save (both Windows and
38-S (Macintosh) Macm'tosh)
On Windows computers, you can
also click [§g in the toolbar.
Save As. None File » Save As (both Windows
and Macintosh)
Set print or page setup None File » Page Setup (Macintosh
(Macintosh only). only)
Print the student None File » Print (Macintosh only)
response set you're
viewing (Macintosh only).
Close QuizManager. None (Windows) File » Exit (Windows)

3-Q (Macintosh)

QuizManager » Quit

QuizManager (Macintosh OS 10)

Undo last action.

Ctrl-Z (Windows)
38-Z (Macintosh)

Edit » Undo (Macintosh only)

Cut selected text. Ctrl-X (Windows) Edit » Cut (Macintosh only)
8-X (Macintosh)

Copy selected text. Ctrl-C (Windows) Edit » Copy (Macintosh only)
38-C (Macintosh)

Paste text that you have Ctrl-V (Windows) Edit » Paste (Macintosh only)

cut or copied.

$8-V (Macintosh)

Clear all text in the field
your cursor is in
(Macintosh computers
only).

None

Edit » Clear (Macintosh only)
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Action

Select all text in the field
your cursor is in
(Macintosh computers
only)

Keyboard Shortcut

Ctrl-A (Windows)
38-A (Macintosh)

Equivalent Menu ltem

Edit » Select All (Macintosh
only)

Go to the next student’s
responses.

Ctrl-] (Windows)
38-] (Macintosh)

Edit » Next Student (Macintosh
only)

Go to the previous
student’s responses.

Ctrl-[ (Windows)
#-[ (Macintosh)

Edit » Previous Student
(Macintosh only)

Send a quiz to NEOs.

None

Communication » Send Quiz
(Windows)

Communications » Send Quiz
(Macintosh)

On Windows computers, you can
also click _El in the toolbar.

Delete a quiz from NEOs.

None

Communication » Delete Quiz
(Windows)

Communications » Delete
Quiz (Macintosh)

On Windows computers, you can
also click , & in the toolbar.

Retrieve student
responses to quizzes from
NEOs.

None

Communication » Retrieve
Responses (Windows)

Communications » Retrieve
Responses (Macintosh)

On Windows computers, you can
also click & in the toolbar.

Delete student quiz
responses from NEOs.

None

Communication » Delete
Responses (Windows)

Communications » Delete
Responses (Macintosh)

On Windows computers, you can
also click L in the toolbar.

Turn connected NEOs on
(after having turned them
off through
QuizManager).

None

Communication » Power On
AlphaSmarts (Windows)

Communications » Power On
AlphaSmarts (Macintosh)

On Windows computers, you can
also click on in the toolbar.
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Action Keyboard Shortcut Equivalent Menu ltem
Turn connected NEOs off. None Communication » Power Off
AlphaSmarts (Windows)

Communications » Power Off
AlphaSmarts (Macintosh)

On Windows computers, you can
also click off in the toolbar.

View or turn off the None Window » View Toolbar
toolbar in the (Windows only)
QuizManager student

response window

(Windows only). The
toolbar is visible when the
menu item is checked.

View or close the Control  None Window » View Control Bar
Bar (Windows only). The (Windows only)

Control Bar is visible

when the menu item is

checked.
Tile windows for open None Window » Tile Windows
student response files. (Windows only)

This allows you to arrange
the windows so you can
view both at the same
time.

Frequently Asked Questions

How many students can take a quiz on one NEO?

The AlphaQuiz SmartApplet can hold responses for up to eight students for
all quizzes combined. For example, if two quizzes have been sent to
AlphaQuiz on the NEO, and two students have taken one of the quizzes, six
can take the other quiz.

How many different quizzes can be loaded onto a NEO?

Up to four different quizzes can be on the NEO at the same time.

)
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Does the student response to a short answer question have to be spelled
correctly? Is it case-sensitive?

If you have entered answers for short answer questions when you created the
quiz in QuizDesigner, QuizManager can only match student responses that
use the exact same spelling. To help QuizManager match student answers,
you can enter more than one correct answer in QuizDesigner with variations
in spelling, or you can enter multiple forms of the word (such as “rain” and
“raindrops”). When you create the quiz in QuizDesigner, you can turn on case
sensitivity. You can also restrict answers to numbers only.

What happens if a student skips a question?

AlphaQuiz allows students to answer questions in any order they like. They
can skip any question and return to it later. At the end of the quiz, students
can choose to view a list of questions with blank answers by pressing 3-B;
then, they can jump directly to one of those questions by pressing -J and
entering the question number. When you create the quiz in QuizDesigner,
you can choose whether students can exit the quiz and enter it later to update
responses, or whether students must mark the quiz finished so they can no
longer change their responses.

If I’'m using an AlphaHub (SmartOption Mobile Lab), and | also have an open
USB port on my computer, can | use both methods of communication
between QuizManager and NEOs at the same time?

Yes. QuizManager supports AlphaHub communication and a direct USB
connection simultaneously. This allows you to work with up to 31 NEOs at
once with QuizManager.

Can a student spell check an essay question?

Spell check can’t be used directly within AlphaQuiz, although it can be used in
other SmartApplets, such as AlphaWord Plus. In QuizDesigner, the author of
a quiz can choose whether to allow use of spell check during the quiz. When
use of spell check is allowed, the student can copy text from an essay answer,
switch to AlphaWord on the NEO, and spell check the text there. When spell
check is disabled, the student cannot spell check the text in any SmartApplet.
By default, spell check is enabled unless you do the following on the Advanced
tab in the Quiz Options in QuizDesigner:

+ Check Require students to mark quiz as finished.
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« Do not check Enable AlphaSmart Spell Checker when taking the
quiz.

« Do not check Enable other AlphaSmart SmartApplets when taking
the quiz so that students can’t use spell check in other SmartApplets.

Can a student take a quiz twice?

Yes. This can be done in one of two ways:

« Delete the responses for the quiz from the NEO (see page 9-38) and have
the student take the quiz again.

« When the student enters his or her name at the beginning of the quiz, have
the student use a different form of his or her name (such as Olivia Smith-2).
If the student tries to use the same name used for the first quiz, AlphaQuiz
will simply open the students’ first set of responses again.

Is it possible to print a quiz from the teacher’s computer?

The QuizManager reports let you choose to print elements of a quiz. The
Grading Sheet and Corrected Quiz Reports allow you to include the questions
on the quiz and the students’ answers, and the Corrected Quiz Report also
allows you to include the correct answers and teacher comments. All
QuizManager reports can be printed directly or saved to text files. To print
reports, see page 9-44.

You can also print the original quiz (without any student responses) in
QuizDesigner (see page 9-20).

Once an essay question is graded, what capabilities are there to make
notes on the student response in QuizManager?

When you grade the quiz in QuizManager, you can enter comments for each
of the student’s responses, and you can include these comments when you
print the student’s Corrected Quiz Report.

How and when do | assign the point values for each question?
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You can assign point values to each question any time after you retrieve the
student responses for a quiz. For instructions, see page 9-40.

When you first write a quiz in QuizDesigner, all questions have the same
weight/point value—one point. You can click Points in QuizManager to
change the point values for each question. QuizManager will calculate the
weight (in %) for each question based on the point values you enter.
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Can the grades from quizzes be saved as a spreadsheet file or be copied
and pasted directly into a tab-delimited grading program?

Yes, When you export the student quiz scores from QuizManager (see

page 9-47), you are creating a tab-delimited file that you can open with a
spreadsheet program or import into a gradebook program. QuizManager can
also match student scores to a student roster exported from a gradebook
program, and it allows you to manually match names that QuizManager could
not match.

In essay responses, will AlphaQuiz or QuizManager highlight or underline
key words that were defined when creating the question?

No, this feature is not available.

What happens if the NEO is turned off before a quiz is completed? What
appears on the screen when the NEO is turned back on? How does a student

continue the quiz?

N
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All the student’s responses are saved when the NEO is turned off. When it is
turned back on, the NEO starts its default SmartApplet, which is usually
AlphaWord Plus. The student can press applets, select AlphaQuiz, and
then select the quiz again. All responses are preserved and displayed as if the
student had never exited the quiz.

If you chose to require students to mark the quiz as finished, and if you chose
to block access to other SmartApplets during the quiz, when the NEO starts,
you will see this message: “The other applets, including AlphaWord, cannot
be used because a quiz has not been marked as finished. Press any key to
continue.” After the student presses a key, the student can log in to the quiz
again.
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Troubleshooting

The QuizManager control bar shows a yellow indicator.

A yellow indicator means that this connected NEO does not have the
AlphaQuiz SmartApplet installed. Send any files that you want to save from
the NEO to your computer, and use AlphaSmart Manager to install
AlphaQuiz on that NEO (see page 1-3).

The QuizManager control bar shows a black indicator, but a NEO is
connected to that location on the Cart or to the USB port on the computer.

There are a few reasons why this might happen:
« That NEO may be off. Make sure it is on.

» Make sure that QuizManager was properly installed. When installed
correctly, the installer loads drivers (required software) for AlphaHub and
USB communications. On the Macintosh, you can use the System Profiler
to check whether the system software detects the AlphaHub.

| have a quiz installed on some NEOs, and | have student responses that |
have not yet retrieved, but I’ve accidentally erased the quiz document from
my computer. Now | can’t retrieve, or even remove, the responses.

To recover the responses, press send on the NEOs from within the quiz to
create a copy of the quiz and responses in an AlphaWord file, or directly print
the responses. Once you have recovered all responses, use QuizManager’s
Delete Quiz function to clear the quiz from the NEOs (see page 9-27). You can
then create a new version of the quiz for future use.

| have a quiz installed on some NEOs, but | have accidentally erased the
quiz document from my computer and | don’t remember the Admin
Password. Now | am unable to remove the quiz from the NEOs.

If there are any responses for other quizzes stored on the NEOs, use
QuizManager to retrieve them. Then, print any response sets for the “lost”
quiz on each NEO (see page 9-31), or save each one as an AlphaWord file and
transfer it to your computer for archival (see page 9-32). You can now delete
and reinstall AlphaQuiz using AlphaSmart Manager; this will remove all
quizzes, including the “lost” one.
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Follow these steps:

1. On the SmartApplets tab in AlphaSmart Manager, select all the
SmartApplets you want to keep on the NEOs except for AlphaQuiz and
click Add. Check the Delete SmartApplets that are not in the Install
List box. Click the Send List tab and click Send.

2. When AlphaSmart Manager finishes sending the SmartApplets to the
NEOs, open a new send list by choosing File » New Send List. On the
SmartApplets tab, select AlphaQuiz and click Add, and uncheck the
Delete SmartApplets box. Click the Send List tab and click Send.
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NEO includes a basic calculator that can perform addition, subtraction,
multiplication, division, exponentiation, and scientific notation.

How to Use Calculator

1. Turn on your NEO and press applets.

2. Use the arrow keys to move the cursor next to Calculator. Then, press
enter.

Note: The first time you use Calculator, a help screen may appear. Press
esc to exit from it. You can press -H to view it again when you want to
see it.

3. Enter the formula you want to calculate. The table below shows you which
characters to use for each type of calculation; it also provides examples of
formulas.

Use these operators... ...to perform these tasks
+ Add

Example: 89+91
Example: 15+16+17

- Subtract

Example: 9—2
Example: 100—50—-25

or x Multiply
Example: 2*5
Example: 45x2x8

/ Divide
Example: 18/2
Example: 100/2/10

Exponentiate (raise the first
number to the power of the
second)

Example: 3”2
Example: 272”2
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Use these operators... ...to perform these tasks
e Calculate scientific notation

Example: 10e6
Example: 1.2e15

@) Construct more complex formulas

Example: (15 *2) + 10 / 4
Example: (25*3) — (45/5)

i 4. Press = or enter to calculate the result.
s If you begin the next

P & formu:a vu;ith e;,n wialid kegs:
operator (such as + e

or *), Calculator uses the =¥/ { }E

result from your previous '( 15*2} +18/4 = 2.5

calculation as the first number esc to oexit

in the next formula. (This
doesn'’t apply to the e

5. Press esc when you've finished.
operator.)

The next time you use Calculator, your previous calculations appear. Press
clear file to remove them.

Pasting Calculations into AlphaWord Plus (Paper Tape)

Calculator can record up to fourteen lines of calculations. Each new
calculation is added to the bottom of the list, and when you reach the
maximum number, older calculations are removed from the top of the list.
This is called the paper tape feature.

If you would like to copy a series of calculations into AlphaWord Plus, follow
these steps:

1. Press applets, move the cursor down to the Calculator in the list, and
press enter.

Enter a series of calculations.

Press shift-38-C to copy all calculations in the list. You should see the
calculations selected momentarily as they are copied. (If this does not
happen, your caps lock may be selected. Press the caps lock and try

again.)

4. Press applets and select the SmartApplet that you want to paste the

~en- [fyou prefer to copy calculations into

P J_ just the result of the

last calculation, 5. Place the cursor in the SmartApplet where you want to paste the
press ctrl-C or #-C instead. calculations.
P

Sma IAPPLET' User Manual 10-2



CALCULATOR
Turning Off Calculator

6. Press ctrl-V or $-V.

You can also type a formula in AlphaWord Plus, copy it, then paste it into
Calculator to obtain the result.

Turning Off Calculator

There may be times when you don’t want Calculator to be available, such as
when students who have NEOs are doing math work. If you want to turn off
Calculator on a single NEO, follow the instructions below. If you want to turn
off Calculator for a group of NEOs using AlphaSmart Manager, see “Disabling
SmartApplets within AlphaSmart Manager” on page 1-5. You can also turn off
the Calculator on a NEO in the Control Panel (see page 7-8).

To Turn Off Calculator while Using AlphaWord Plus
1. Press ctrl-3-C.

2. Type the master password and press enter. (For more about the master
password and how to set it, see the AlphaSmart Manager 2 User Manual.)

To Turn Off Calculator from the SmartApplets Menu
1. Press applets.

Move the cursor down next to Calculator.

Press ctrl-38-L. If the Calculator is on, this turns it off; if it is off, this turns it
on again. When the Calculator is disabled, [ " appears next to it in the
SmartApplets list.
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